New methods for rendering of anaglyph stereoscopic images on CRT displays and photo-quality ink-jet printers

Vu M. Tran

Ottawa-Carleton Institute for Electrical & Computer Engineering
School of Information Technology & Engineering (SITE)
University of Ottawa
Ottawa, Canada

December 2005

A thesis submitted to University of Ottawa in partial fulfilment of the requirements for the M.A.Sc. degree.

© 2005 Vu M. Tran
Abstract

Anaglyph is considered as an inexpensive approach to display to the observer a true 3D view of a real world scene. Moreover, it is the only way of providing a 3D stereoscopic effect on ordinary paper. There are not many techniques used to render anaglyph images, and most of them are very empirical and are used exclusively for additive display devices. The mathematical Linear Projection method was proved to be the best existing method for rendering anaglyph images with high color stability and color fidelity. However, its limitation is that it can exhibit strong ghosting in the rendered anaglyph images.

This study describes two separate anaglyph algorithms; one is targeted for CRT additive display devices and the other one is aimed for printer subtractive display devices. Both of these two algorithms are based on the Linear Projection method, in which they attempt to reduce the ghosting effect introduced by the Linear Projection method while maintaining the strength of the Linear Projection method. The study also characterizes the spectral forward characterization functions of a CRT monitor and a printer which are used to test the algorithms developed. The study first mathematically formulates the anaglyph phenomenon. Next, it gives a new ghosting definition which is used to derive objective functions that are used in the proposed algorithms. Besides those two algorithms, the study also introduces a test that checks the compatibility between a colored-filter glass pair and a color display device in term of the ghosting effect. The resulting rendered anaglyph images show that the ghosting effect is significantly reduced.
Acknowledgments

I WOULD LIKE to express my deepest gratitude to my supervisor Dr. Eric Dubois who was very generous with his support, advice, and time. His suggestions were essential to the coming about of this thesis. I also want to thank Xiaoyong Sun and Yednek Asfaw for their valuable help. Finally, I am very grateful to my family and friends for their untiring support.
CONTENTS

List of Figures xi
List of Tables xii
Acronyms xiii
Notations xiv

1 Introduction 1
1.1 Problem area ......................................................... 1
1.2 Objectives of the thesis .............................................. 3
1.3 Thesis outline ....................................................... 3

2 Background on Color 5
2.1 Color overview ....................................................... 5
2.1.1 Color and visual perceptual attributes .......................... 5
2.1.2 Color distance ..................................................... 6
2.1.3 Colorimetric model ............................................... 7
  2.1.3.1 Color matching functions ................................ 8
  2.1.3.2 Transformation of primaries ................................. 9
  2.1.3.3 Luminance and chromaticity of colorimetry model ....... 10
  2.1.3.4 CIE 1931 XYZ color space ................................. 11
2.1.4 Color appearance model ......................................... 12
  2.1.4.1 Color appearance phenomena and chromatic adaptation models 13
  2.1.4.2 CIELAB color space model ................................ 14
2.2 Color output devices ................................................ 15
  2.2.1 Generic output device modeling ................................ 15
2.2.2 Multidimensional data fitting and interpolation .......................... 17
2.2.3 Spectral white-point normalization ........................................... 18
2.2.4 Device gamut, gamut mapping, and device profile ....................... 18
2.2.5 CRT displays ........................................................................... 19
  2.2.5.1 CRT Calibration .................................................................. 20
    2.2.5.1.1 Simple gamma-correction model ................................... 20
    2.2.5.1.2 GOG gamma-correction model .................................... 21
    2.2.5.1.3 ITU-R 709 gamma-correction recommendation .......... 21
  2.2.5.2 Model-based CRT SFCF ..................................................... 21
  2.2.5.3 sRGB color space ............................................................ 23
2.2.6 Halftone printers ...................................................................... 24

2.3 Colored-filter glasses ................................................................. 25
  2.3.1 The effect of the colored-filter glass on CRT device ................. 25

2.4 Summary ................................................................................... 27

3 Mathematical formulation for anaglyph stereoscopic rendering .......... 28

3.1 Binocular Vision ......................................................................... 28
  3.1.1 Correspondent points ......................................................... 28
  3.1.2 Dichoptic color mixture ....................................................... 29

3.2 Anaglyph framework .................................................................. 29
  3.2.1 Anaglyph problem formulation ............................................ 30
    3.2.1.1 Conditions for the colored-filtered glasses to perceive 3D perception ........................................... 31
    3.2.1.2 Generic anaglyph algorithm .......................................... 33
    3.2.1.3 Anaglyph quality factors .............................................. 33
  3.2.2 Anaglyph design problems .................................................. 34

3.3 Test stereo image pairs ............................................................... 34

3.4 Overview of common colored-filter glasses ................................ 34

3.5 Overview of existing ghosting effect measurements .................... 35

3.6 Overview of existing anaglyph algorithms .................................... 35
  3.6.1 Photoshop algorithm ......................................................... 36
  3.6.2 Midpoint algorithm ............................................................ 37
  3.6.3 Linear Projection algorithm ................................................ 38
  3.6.4 ColorCode algorithm .......................................................... 41

3.7 Summary ................................................................................... 42
4 Implementation of the CRT monitor and printer SFCF

4.1 Apparatus ......................................................... 43
4.2 CRT monitor ..................................................... 43
  4.2.1 Implementation of the EIZO CRT monitor SFCF .......... 44
  4.2.2 Model accuracy test for the EIZO CRT monitor ............ 46
  4.2.3 The effect of the colored-filter glasses on the EIZO CRT monitor ... 47
4.3 RGB Printer .................................................... 47
  4.3.1 EPSON printer characterization implementation .......... 47
     4.3.1.1 The EPSON printing process ......................... 48
     4.3.1.2 Determination of the EPSON printer SFCF ............ 49
  4.3.2 Model accuracy test ........................................ 52
  4.3.3 The effect of the colored-filter glass .................... 53
4.4 Summary ....................................................... 53

5 Development of an anaglyph algorithm for additive displays

5.1 Search for a better anaglyph algorithm ........................ 54
  5.1.1 Extension of the LP method in the color-appearance space ...... 54
  5.1.2 Luminance matching algorithm ................................ 55
5.2 Anaglyph dichoptic color mixture experiment .................... 57
5.3 A new way of defining the anaglyph ghosting effect ............... 58
  5.3.1 New anaglyph ghosting effect formulation .................... 59
  5.3.2 Example of applying the new ghosting calculation for a CRT display 61
5.4 Reduction of the ghosting component .......................... 63
  5.4.1 LRM ghosting reduction method for a CRT .................. 64
     5.4.1.1 LRM-1 ghosting reduction method .................... 64
     5.4.1.2 LRM-2 ghosting reduction method .................... 65
  5.4.2 Test results and discussion ................................ 66
5.5 Preprocessing module ........................................... 68
  5.5.1 Luminance adjusted preprocessing module ................... 69
  5.5.2 Test results ............................................... 73
  5.5.3 Observations on other additive display devices ............. 74
5.6 Summary ....................................................... 74

6 Development of anaglyph algorithm for printers

6.1 Strong ghosting effect problem in printer ....................... 76
6.2 Test for compatibility between colored-filter glasses and color output devices 78
6.3 Evaluation of MATLAB nonlinear optimization routines .......... 79
6.4 Search for a better anaglyph algorithm ........................................ 81
6.5 A new anaglyph method for printer media ...................................... 82
  6.5.1 Gamut Mapping module ...................................................... 82
  6.5.2 Preprocessing module ...................................................... 84
  6.5.3 LRM module ................................................................. 84
  6.5.4 Test results ................................................................. 85
  6.5.5 Observations on the effect of different illuminant lights and different
        photo-quality papers ..................................................... 85
6.6 Summary ............................................................................. 86

7 Conclusions ............................................................................. 87
  7.1 Overview of findings ............................................................. 87
  7.2 Contributions of the thesis ..................................................... 89
  7.3 Future work ........................................................................ 90

References .................................................................................. 91

A Ocean Optics USB2000 ................................................................ 95
  A.1 Introduction ....................................................................... 95
  A.2 Settings ............................................................................ 96
  A.3 Steps for measuring colored-filter glass’s absorption curve .......... 96
  A.4 Steps for measuring emitting light PDS from a monitor ............... 98
  A.5 Step for measuring reflecting light PDS from a paper .................. 100

B Test stereo image pairs ................................................................ 103
  B.1 Test stereo image pairs ....................................................... 103
  B.2 Interesting regions ............................................................ 105

C Electronic Appendix .................................................................... 107
  C.1 “Test stereo image pairs” folder .......................................... 107
  C.2 “EIZO CRT Spectra” folder ................................................. 107
  C.3 “EPSON Printer Spectra” folder .......................................... 107
  C.4 “Glass Transmission Absorption Curves” folder ....................... 107
  C.5 “Photoshop Anaglyph Images” folder .................................... 108
  C.6 “Midpoint Anaglyph Images” folder ...................................... 108
  C.7 “LP Anaglyph Images” folder .............................................. 108
  C.8 “LRM-1 Anaglyph Images” folder ...................................... 108
  C.9 “LRM-2 Anaglyph Images” folder ...................................... 108
C.10 “Preprocessing Anaglyph Images” folder ........................................ 108

D  Anaglyph images rendered on the EPSON printer .......................... 109
LIST OF FIGURES

2.1 PDSs emitted from 17” Samsung Syncmaster LCD monitor. The power unit of the y-axis is not important in many applications. .............................. 6
2.2 CIE 1931 XYZ Standard Colorimetric Observer’s color matching functions. . 9
2.3 Relative luminous efficiency $V(\lambda)$. .................................................. 10
2.4 Output device forward characterization block diagram. (Reproduced from [1, pg.284]) ............................................................... 16
2.5 The measured absorption curves of the red and cyan filters by using the Ocean Optics USB2000 spectrometer. This colored-filter glass pair is used in this thesis. 26
2.6 The large triangle is the gamut of the EIZO CRT monitor. The small triangle at the bottom right is the gamut when seen through the red filter. The small upper left triangle is the gamut when seen through the cyan filter. (Background chromaticity diagram generated using software of from [2]) ... 27
3.1 (a) The Pinhole model and (b) depth perception reproduction. ............... 29
3.2 Linear Projection algorithm. ................................................................. 39
3.3 The measured Color-Code absorption curves by using the Ocean Optics USB2000 spectrometer. ......................................................... 41
4.1 The measured PDSs of the red, green, blue lights at the maximum intensity and the white color. The data was collected by using the Ocean Optics USB2000 spectrometer. .................................................. 44
4.2 The white point normalized PDSs of the red, green, blue lights at the maximum intensity. ................................................................. 45
4.3 The measured PDSs and associated estimated PDSs from order-5 polynomial, trilinear, and sequential for two different inputs (a) RGB= (0.4863, 0.7725, 0.4824) and (b) RGB= (0.6274, 0.1961, 0.8745). ........................................... 50
4.4 The magnitude of X, Y, and Z stimulus with different inputs R and G when B is kept constant for the order-5 polynomial model. ........................................... 51

5.1 The ghosting reduction component is used after the anaglyph algorithm to reduce the ghosting level without sacrificing the color stability and fidelity. . 63

5.2 At the point $x_6$, LRM can't reduce the ghosting level in the left eye. Because in the lower figure, the PDS of the color $I_{RAL,XYZ}(x_6)$ (dotted line) is much stronger than the useful PDS of the color $I_{LAL,XYZ}(x_6)$ (solid line). In the upper figure, the leaking signal is not shown since it is very small. . . 68

5.3 The Preprocessing component is used after the LP algorithm to further reduce the ghosting effect. ................................................................. 69

5.4 The first stage of the Preprocessing module. Increase the luminance of dark colors and decrease the luminance of light colors in the right anaglyph intended image. ................................................................. 70

5.5 Luminance adjusted conversion function for the second stage of the Preprocessing module. ................................................................. 71

5.6 The third stage of the Preprocessing module. Increase the luminance of dark colors and decrease the luminance of light colors in the left anaglyph intended image. ................................................................. 72

6.1 The PDSs produced by the EPSON printer when the inputs are (0, 0.3, 0), (0, 0.6, 0), and (0, 1, 0). ................................................................. 77

6.2 Graph of the typical specified objective function when the CIE XYZ tristimulus values of the left and right desired colors are (0.0220, 0.0095, 0.0001) and (0.0064, 0.0188, 0.0186) respectively and the coefficient $B$ in the input to the EPSON printer is set to 0.2451. The optimal result is (0.2633, 0.2910, 0.2451). 81

6.3 Anaglyph algorithm for a given printer block diagram. ................. 82

A.1 The set up for measuring colored-filter glass’s absorption curve. ........ 97

A.2 The set up for measuring emitting light PDS from a monitor............. 98

A.3 The set up for measuring reflecting light PDS from a paper.............. 100

B.1 REDCAR stereo image pair (electronic versions in Appendix C.1). ....... 104

B.2 ICIP stereo image pair (electronic versions in Appendix C.1). ........... 104

B.3 BEAR stereo image pair (electronic versions in Appendix C.1). ......... 105

B.4 REDCAR interesting regions. ..................................................... 106

B.5 (a) The ICIP1 interesting region and (b) the BEAR1 interesting region. . 106
LIST OF TABLES

2.1 The xy chromaticity coordinates of three primaries and the CIE XYZ tristimulus of the reference white used in sRGB color space. Note that these values are the same as those used in the ITU-R 709 RGB color space. .......................... 23

4.1 The xy chromaticities of three primaries of the EIZO CRT monitor. .................. 44
4.2 The normalization values of the EIZO CRT monitor, where i is R, G, or B. ..... 45
4.3 The gain and gamma values in the Simple gamma-correction and the GOG
    gamma-correction model for the EIZO CRT monitor. .............................. 46
4.4 The performance of three different gamma-correction models applied for the
    EIZO CRT monitor. ................................................................. 46
4.5 The input values in the target chart that has a total of 10×12×7 = 840
    training samples. ................................................................. 49
4.6 Performance of four different interpolation techniques applied for characterizing
    the EPSON printer using the spectral RMS error metric and ΔE04. ........ 52
4.7 Performance of the polynomial technique with different order values based on
    the spectral RMS error metric...................................................... 53

5.1 The ghosting levels at four different points in the REDCAR stereo image pair
    and two different points in the ICIP stereo image pair for the red-cyan filters
    and the EIZO CRT monitor for the Photoshop and LP algorithms using the
    new definition. ................................................................. 62
5.2 The ghosting levels at four different points in the REDCAR stereo image pair
    and two different points in the ICIP stereo image pair for the red-cyan filters
    and the EIZO CRT monitor for the LRM-1 and LRM-2 algorithms based on
    the LP method. ................................................................. 67
5.3 The ghosting levels at four different points in the REDCAR stereo image pair and two different points in the ICIP stereo image pair for the red-cyan filters and the EIZO CRT monitor for the Preprocessing algorithm prior to the LRM-1 algorithm based on the LP method. ............................................. 73

6.1 The minimum percentage luminances with respect to the maximum luminance. 79
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D65</td>
<td>CIE XYZ tristimulus values of Daylight white, [0.9501 1 1.0889]</td>
</tr>
<tr>
<td>CRT</td>
<td>Cathode-ray tube</td>
</tr>
<tr>
<td>CIE XYZ</td>
<td>CIE 1931 XYZ color space</td>
</tr>
<tr>
<td>CIELAB</td>
<td>CIE LAB color space</td>
</tr>
<tr>
<td>CIE-94</td>
<td>CIE 94 color distance in the CIE LAB color space</td>
</tr>
<tr>
<td>CMF</td>
<td>Color matching function</td>
</tr>
<tr>
<td>GOG</td>
<td>Gain-offset-gain</td>
</tr>
<tr>
<td>FCF</td>
<td>Forward characterization function</td>
</tr>
<tr>
<td>HVS</td>
<td>Human visual system</td>
</tr>
<tr>
<td>ICC</td>
<td>International Color Consortium</td>
</tr>
<tr>
<td>LCD</td>
<td>Liquid crystal display</td>
</tr>
<tr>
<td>LP</td>
<td>Linear projection algorithm</td>
</tr>
<tr>
<td>LRM</td>
<td>Left-Right Matching</td>
</tr>
<tr>
<td>LRM-1</td>
<td>Proposed left-right matching version 1 algorithm</td>
</tr>
<tr>
<td>LRM-2</td>
<td>Proposed left-right matching version 2 algorithm</td>
</tr>
<tr>
<td>LuM</td>
<td>Luminance Matching algorithm</td>
</tr>
<tr>
<td>PDS</td>
<td>Power density spectrum</td>
</tr>
<tr>
<td>RMS</td>
<td>Root-mean-square</td>
</tr>
<tr>
<td>SFCF</td>
<td>Spectral forward characterization function</td>
</tr>
</tbody>
</table>
NOTATIONS

ΔE_{XYZ} \quad \text{Euclidean Color distance in the CIE XYZ color space}

ΔE_{94} \quad \text{CIE-94 color distance in the CIELAB color space}

A \quad 3 \times 3 \text{ transformation matrix between the RGB digital input and the CIE XYZ tristimulus values}

A_L \quad 3 \times 3 \text{ transformation matrix between the RGB digital input and the CIE XYZ tristimulus values through the left filter}

A_R \quad 3 \times 3 \text{ transformation matrix between the RGB digital input and the CIE XYZ tristimulus values through the right filter}

B_L \quad \text{The non-overlap band of the left colored-filter glass}

B_R \quad \text{The non-overlap band of the right colored-filter glass}

f_L(\lambda) \quad \text{Absorption curve of the left colored-filter glass}

f_R(\lambda) \quad \text{Absorption curve of the right colored-filter glass}

I_{A,B_L}(\lambda, x) \quad \text{PDS in the band } B_L

I_{A,B_R}(\lambda, x) \quad \text{PDS in the band } B_R

I_{A,RGB}(x) \quad \text{Anaglyph image in the RGB color space}

I_{A,XYZ}(x), [I_A(\lambda, x)] \quad \text{Color perceived by both eyes without glasses in the CIE XYZ color space and the spectral domain respectively when the anaglyph image is displayed by a color display device}

I_{AL,XYZ}(x), [I_{AL}(\lambda, x)] \quad \text{Color perceived by the left eye wearing the left colored-filter glass in the CIE XYZ color space and the spectral domain respectively when the anaglyph image is displayed by a color display device}
\(I_{AR,XYZ}(x), [I_{AR}(\lambda, x)]\) Color perceived by the right eye wearing the right colored-filter glass in the CIE XYZ color space and the spectral domain respectively when the anaglyph image is displayed by a color display device

\(I_{L,RGB}(x)\) Left-perspective (original) image in the stereo image pair

\(I_{L,XYZ}(x), [I_L(\lambda, x)]\) Color perceived by both eyes without glasses in the CIE XYZ color space and the spectral domain respectively when the left-perspective image is displayed by a color display device

\(I_{LA,RGB}(x)\) Left anaglyph intended image

\(I_{LAL,XYZ}(x), [I_{LAL}(\lambda, x)]\) Color perceived by the left eye wearing the left colored-filter glass in the CIE XYZ color space and the spectral domain respectively when the left anaglyph intended image is displayed by a color display device

\(I_{RAR,XYZ}(x), [I_{RAR}(\lambda, x)]\) Color perceived by the right eye wearing the right colored-filter glass in the CIE XYZ color space and the spectral domain when the left anaglyph intended image is displayed by a color display device

\(I_{R,RGB}(x)\) Right-perspective (original) image in the stereo image pair

\(I_{R,XYZ}(x), [I_R(\lambda, x)]\) Color perceived by both eyes without glasses in the CIE XYZ color space and the spectral domain respectively when the right-perspective image is displayed by a color display device

\(I_{RA,RGB}(x)\) Right anaglyph intended image

\(I_{RAL,XYZ}(x), [I_{RAL}(\lambda, x)]\) Color perceived by the left eye wearing the left colored-filter glass in the CIE XYZ color space and the spectral domain respectively when the right anaglyph intended image is displayed by a color display device

\(I_{RAR,XYZ}(x), [I_{RAR}(\lambda, x)]\) Color perceived by the right eye wearing the right colored-filter glass in the CIE XYZ color space and the spectral domain respectively when the right anaglyph intended image is displayed by a color display device

\(\gamma_{\text{Ana}}(\cdot)\) Function that generates an anaglyph image from stereoscopic image pair using a particular anaglyph algorithm

\(\gamma_{\text{SFCF,CRT}}(\cdot)\) Spectral forward characterization function of CRT monitors

\(\gamma_{\text{SFCF,Printer}}(\cdot)\) Spectral forward characterization function of printers
CHAPTER

ONE

Introduction

1.1 Problem area

This thesis relates to the topic of anaglyph stereoscopic display, and specifically to the development of anaglyph algorithms used to render anaglyph images best displayed on popular color media, namely CRT displays and ink-jet printers.

The human visual system (HVS) is extremely complex. It enables us to obtain important information about our surrounding environment such as the positions of objects, characteristic of objects (e.g. color, shape), as well as their relationships. The HVS’s mechanism is based on the so-called binocular vision mechanism, in which, when looking at a real scene, the left eye sees the scene as an image (referred to as left-perspective view) that is slightly different from the image (referred to as right-perspective view) received by the right eye of the same scene. Based on these two images, the human brain calculates the depth information of the scene. In contrast with binocular vision, monocular vision has two eyes that see the same image and hence all the observed objects are in a 2D plane (e.g. the screen plane of TV). Therefore, with monocular vision, we cannot have true depth perception. However, depth perception can still be perceived through some other psychological mechanisms as summarized by Lipton [3, pg.3]. Note that the word “3D” throughout the entire thesis refers to binocular stereoscopic views.

If the left and right perspective views are captured using cameras, then a stereoscopic display system can be used on these two images to give viewers a strong sense of true depth perception, similar to observing the real scene. All of the stereoscopic display systems, in fact, exploit the fundamental principle of binocular vision, in which they need to indepen-
dently present the left and right perspective images to the corresponding eyes. In a number of experiments, it has been shown that 3D images would send information more sufficient to the observer than 2D images, since human beings react more strongly to 3D images [4]. Therefore, it is reasonable to believe that human beings want imaging systems that produces pictures that are as natural and real as the things we see and experience all the time.

The anaglyph stereoscopic display system is one of the techniques for delivering the left and right perspective images to the corresponding eyes. It exploits the color-multiplexing technique in which one perspective image, say the left image, will be encoded in one set of colors and the other perspective image is encoded in another set of colors. Then those two color encoded views are superimposed into one unique image which contains both views. A color display device, such as a CRT display (e.g. TV) or a color printer, then reproduces this color encoded image. The light waves from this anaglyph image propagate to the left eye through a colored-filter glass and to the right eye through another colored-filter glass. The purpose of these two glasses is only to allow the appropriate color encoded image to reach the appropriate eye. Other more complicated stereoscopic systems, such as the shutter stereoscope, give better 3D quality if compared to anaglyph, due to the minimal degradation in the image color. However, an interesting result from the experiment of Volbracht *et al.* [5] showed that the information conveyed by the anaglyph mode is as good as that by the shutter mode. Therefore, anaglyph is still a good way of reproducing the depth perception.

The biggest advantage of the anaglyph method is that it doesn’t require any special hardware besides a very cheap pair of colored-filter glasses. An anaglyph image can be broadcast on TV or shown in theaters without any modification. Unlike polaroid stereoscope or lenticular sheet, the anaglyph method can be used to print an image that gives a good 3D impression on ordinary paper without using any special ink or special printer. This obviously provides a new efficient way of conveying information to the reader through the paper medium, especially for science text books. The most recent Hollywood movie that applied the anaglyph technique is “3D Spy Kids”. It used red and cyan colored-filter glasses for image separation and gave a very pleasant 3D appearance. The limitations of the anaglyph method are the color distortion effect (in which the 3D perception does not have the same color as the original real 3D scene), the color rivalry effect (in which the left eye sees one color and right eye sees a different color, and those two colors cannot be fused as a stable perceived color by the HVS), and the ghosting effect (in which a small amount of information of the left-perspective image leaks into the right eye and vice-versa).
1.2 Objectives of the thesis

There is a very limited number of stereo anaglyph algorithms that have been developed. Moreover, all of them were designed to be optimized for CRT displays. None of these existing algorithms was designed for printers. Many existing programs for rendering anaglyph images are often based on the so-called “Photoshop method”, where one perspective image is encoded in one channel, say the red channel of CRT displays, and the other perspective image is encoded in the other two channels, the green and blue channels. The Photoshop method is simple, fast and doesn’t require the information of the display medium nor the information of colored-filter glasses. Unfortunately, its resulting rendered anaglyph images give strong unstable perceived colors, and hence it is often very uncomfortable to view these anaglyph images.

A recent anaglyph algorithm, the Linear Projection method, renders anaglyph images that have high color fidelity and color stability. However, it has the drawback of a strong ghosting effect. Therefore, the objectives of the thesis are to develop two algorithms to render anaglyph images from stereo image pairs to give a good 3D appearance. One anaglyph algorithm is optimized for CRT displays and the other anaglyph algorithm is optimized for printers. Both of the developed algorithms are based on the Linear Projection method, in which they reduce the ghosting effect caused by the Linear Projection method without sacrificing too much the strengths of the Linear Projection method.

1.3 Thesis outline

The work of this study is a combination of three different aspects: color theory, characterization of color devices, and the human stereo vision mechanism. Therefore, Chapter 2 serves as background to give an overview first on theories and aspects of colors such as color distances, colorimetric color model, and color appearance model; second, an overview on color reproduction devices (monitor and printer) and methods used to obtain their calibration and characterization functions. Both the empirical method and model-based method are discussed in this chapter.

Chapter 3 gives the mathematical framework of the anaglyph technique, what it is, how it can be formulated, and a literature review of the few existing algorithms done for this purpose. Chapter 4 uses the methods for color device modeling described in Chapter 2 to model the specific color devices used in this study: EIZO CRT monitor and EPSON printer. Chapter 5 presents a new anaglyph method for CRT displays. And Chapter 6 presents a
new anaglyph method for printers. Finally, Chapter 7 summarizes the findings of this study and avenues on how the work can be extended in the future.
CHAPTER TWO

Background on Color

The purpose of this chapter is to serve as background for all the remaining chapters. Section 2.1 gives the overview of color theory starting from the spectral level. Since the new anaglyph algorithms are based on the mechanism of color output devices, Section 2.2 discusses the output color device characterizations.

2.1 Color overview

2.1.1 Color and visual perceptual attributes

This section serves as fundamental knowledge to understand the following sections. Color, a psychophysical term, is used to describe what a human observer senses when visible light arrives to the eyes. Visible light actually is electromagnetic radiation with wavelengths between approximately 350 nm and 780 nm. The incidence of visible light stimulates two type of receptors, which are rods and cones, in the retina of the human eye to produce neural signals that are processed by the brain. The response of the receptors for light with wavelengths below 400 nm and above 700 nm is very small and often can be neglected in the calculations \cite{6}. The retinal stimuli thus can be characterized by the incident visible light power density spectrum (PDS) \( P(\lambda) \geq 0 \). Figure 2.1 shows an example of PDSs of the red, green, and blue light emitted by a Samsung Syncmaster LCD monitor.

The retinal responses are then transmitted to the brain where they are further processed to give us the sense referred to as color. This process is nonlinear and very complicated. The sense of color can be classified into different visual perceptual attributes which are hue, brightness, lightness, colorfulness, chroma, and saturation \cite[pp.119-23]{1}. Even though there
are many color models that have been developed to represent and predict colors, all the color models can be divided into two groups: Colorimetric Color Models, that represent colors in terms of the retinal responses, and Color Appearance Models, that represent colors in terms of visual perceptual attributes. Strictly speaking, a color appearance model is usually built upon a colorimetric color model (often the CIE XYZ color model). Note that, throughout this thesis, the phrase “color model” usually has the same meaning as the phrase “color space” and they are interchangeable.

2.1.2 Color distance

In most of the applications related to color, one question is often raised as to how the closeness (perceived difference with respect to color attributes) of two colors under given viewing conditions can be modeled. In this research, the heart of the new algorithms is the optimization process in which its objective functions are based on the closeness of perceived colors and desired colors. Therefore, it is important to discuss the closeness of two colors.

The closeness is often known as color difference or color distance. In general, for a given color model, the color distance metric, used to quantify the color distance, is often designed to make its results as close to human judgments as possible. The error metric between two very different colors is not very meaningful and hence most of the existing color distance metrics are focused on small differences between two colors [1, pg.28]. The definition of a color distance metric enables us to define the uniformness of a color model in which equal distance metric values in a color model correspond to equal perceived differences.
2.1.3 Colorimetric model

There are two different approaches for introducing the representation of a color: the first approach is to directly introduce the tristimulus values which are the representation of a color; the second approach is to start at the PDS level and to mathematically derive the color representation. In this section we will discuss the second approach as in this study we mainly work with PDSs emitted from a CRT display or reflected from a paper. All the proofs and arguments in the present section can be found in Dubois’ course notes [6].

First, all PDSs of visible light can be formed as a set

\[
P = \left\{ f(\lambda) : \lambda_{\text{min}} \leq \lambda \leq \lambda_{\text{max}}, \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} |f(\lambda)| \, d\lambda < \infty \right\}.
\]

(2.1)

There is an interesting psychological phenomenon in which two PDSs \(C_1(\lambda)\) and \(C_2(\lambda)\) will give an identical color sensation (same retinal stimuli) under the same viewing condition due to the fact that the HVS only has three types of cones. A color, denoted as \([C]\), can be defined as a set of all PDSs \(C(\lambda)\) in the set \(P\) such that three numbers \(\left(\frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) L(\lambda) \, d\lambda}, \frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) M(\lambda) \, d\lambda}, \frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) S(\lambda) \, d\lambda}\right)\) are equal, where \(L(\lambda)\), \(M(\lambda)\), and \(S(\lambda)\) are the long-wavelength, medium-wavelength, and short-wavelength cone sensitivities, respectively. Obviously, the set \([C]\) is a subset of \(P\). A set of all possible colors is defined as physical color space and denoted as \(C_P\). The physical color space \(C_P\), however, is not a vector space, as an element of \(C_P\) does not have a negative. By extending the set \(P\), the new set \(L\), which will include the PDSs with negative power, can be defined as

\[
L = \left\{ f(\lambda) : \lambda_{\text{min}} \leq \lambda \leq \lambda_{\text{max}}, \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} |f(\lambda)| \, d\lambda < \infty \right\}.
\]

(2.2)

In \(L\), by extending the color definition, a color \([C]\) can be defined as a set of all PDSs \(C(\lambda)\) in the set \(L\) such that \(\left(\frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) L(\lambda) \, d\lambda}, \frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) M(\lambda) \, d\lambda}, \frac{\lambda_{\text{max}}}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) S(\lambda) \, d\lambda}\right)\) are equal. Any two PDSs \(C_1(\lambda)\) and \(C_2(\lambda)\), which are in the set \(L\) and belong to a color, are called equivalent, denoted as \(C_1(\lambda) \bigcirc C_2(\lambda)\). The color notation \([C(\lambda)]\) can also be used to indicate the color in which its set of PDSs includes the particular PDS \(C(\lambda)\). It has been proven that the set of all colors will form a color vector space, denoted as \(C\), in which the vector addition
and multiplication by a scalar operators are defined as
\[
\begin{align*}
\alpha[C(\lambda)] &= [\alpha C(\lambda)] \\
[C_1(\lambda)] + [C_2(\lambda)] &= [C_1(\lambda) + C_2(\lambda)].
\end{align*}
\] (2.3)

As one can see, the physical color space \( \mathcal{P} \) is a subset of \( \mathcal{C} \), and if a color in \( \mathcal{C} \) contains at least one element of \( \mathcal{P} \) then it belongs to \( \mathcal{C}_P \) and it can be physically generated and seen.

The dimension of the color vector space \( \mathcal{C} \) is 3. Therefore, by applying vector space theory, a color can be represented exactly in terms of coefficients with respect to a basis, instead of by a PDS,
\[
[C] = C_1[P_1] + C_2[P_2] + C_3[P_3],
\] (2.4)
where \( (C_1, C_2, C_3) \) are three real numbers called the *tristimulus values*. \([P_1], [P_2], [P_3]\) are three linearly independent colors and considered as three *primaries*. Often, the primaries are carefully chosen such that the sum of one unit of each primary matches a selected reference white. For example, Red \([R(\lambda)]\), Green \([G(\lambda)]\), and Blue \([B(\lambda)]\) colors emitted by the Samsung LCD monitor in Figure 2.1 will form a basis for \( \mathcal{C} \), and the sum of one unit of each primary will produce a D65 reference white which is the daylight. There is no strict requirement that the primaries must be physical colors, as in the case of CIE XYZ primaries, which are considered as the standard primaries from which other sets of color primaries are described.

### 2.1.3.1 Color matching functions

The tristimulus values in Equation 2.4 can be computed by
\[
C_i = \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) \cdot \overline{p}_i(\lambda) \cdot d\lambda, \quad i = 1, 2, 3,
\] (2.5)
where \( C(\lambda) \) is the PDS of the incident light, and the functions \( \overline{p}_i(\lambda) \) are referred to as the *color matching functions* (CMF) associated with the primaries \([P_i]\). Note that the set of three CMFs \( \overline{p}_i(\lambda) \) can be different from the three cone sensitivities \( L(\lambda) \), \( M(\lambda) \), and \( S(\lambda) \). Figure 2.2 shows examples of CMFs defined by The Commission Internationale de l’Eclairage (CIE) for CIE XYZ primaries. In digital computation, the PDS \( C(\lambda) \) and the CMFs \( \overline{p}_i(\lambda) \) have values only at discrete uniformly spaced wavelengths \( \{\lambda_j\}_{j=0}^{N-1} \) over the region \([\lambda_{\text{min}}, \lambda_{\text{max}}]\), denoted as \( C[\lambda_j] \) and \( \overline{p}_i[\lambda_j] \) respectively, thus Equation 2.5 can be approximated by a
Riemann Sum

\[
C_i = \sum_{j=0}^{N-1} C[\lambda_j] \cdot \bar{p}_i[\lambda_j] \cdot \Delta \lambda.
\]  

(2.6)

2.1.3.2 Transformation of primaries

A given color will have different tristimulus values for different sets of primaries. Therefore, it is necessary to establish a relationship between two different sets of tristimulus values of the same color. In the thesis, this relationship will be used to establish the characterization function of a CRT display (Section 2.2.5.2). This characterization function will then be used in the anaglyph algorithm developed for a given CRT display.

Let \([P_1(\lambda)], [P_2(\lambda)], [P_3(\lambda)]\) be three primaries of the color vector space \(C\) with three CMFs \((\overline{p}_1(\lambda), \overline{p}_2(\lambda), \overline{p}_3(\lambda))\) and \([Q_1(\lambda)], [Q_2(\lambda)], [Q_3(\lambda)]\) be another three primaries with three CMFs \((\overline{q}_1(\lambda), \overline{q}_2(\lambda), \overline{q}_3(\lambda))\). For an arbitrary color \([C(\lambda)]\), if we assume that the vectors \(C_P = [C_{P1} \ C_{P2} \ C_{P3}]^T\) and \(C_Q = [C_{Q1} \ C_{Q2} \ C_{Q3}]^T\) are the tristimulus values of that color in primaries \([P_1], [P_2], [P_3]\) and primaries \([Q_1], [Q_2], [Q_3]\) respectively, then the relationships between \(C_P\) and \(C_Q\) and between the two sets of CMFs can be written as the following statements in terms of matrices

\[
C_Q = A \cdot C_P, \quad C_P = A^{-1} \cdot C_Q,
\]

(2.7)

\[
\begin{bmatrix} \overline{q}_1[\lambda] & \overline{q}_2[\lambda] & \overline{q}_3[\lambda] \end{bmatrix}^T = A \cdot \begin{bmatrix} \overline{p}_1[\lambda] & \overline{p}_2[\lambda] & \overline{p}_3[\lambda] \end{bmatrix}^T,
\]

(2.8)

where \([\overline{p}_1[\lambda] \ \overline{p}_2[\lambda] \ \overline{p}_3[\lambda]]\) and \([\overline{q}_1[\lambda] \ \overline{q}_2[\lambda] \ \overline{q}_3[\lambda]]\) are \(N \times 3\) matrices (these two matrices hold the discrete values of \((\overline{p}_1(\lambda), \overline{p}_2(\lambda), \overline{p}_3(\lambda))\) and \((\overline{q}_1(\lambda), \overline{q}_2(\lambda), \overline{q}_3(\lambda))\). The matrix \(A\) has the
form

\[
A_{jk} = \begin{bmatrix}
a_{11} & a_{12} & a_{13} \\
a_{21} & a_{22} & a_{23} \\
a_{31} & a_{32} & a_{33}
\end{bmatrix}
\]

where \( a_{jk} = \sum_{i=0}^{N-1} P_j[\lambda_i]q_{ik}[\lambda_i] \Delta \lambda, \quad j, k = 1, 2, 3. \) (2.9)

For example, the transformation matrix \( A \) between the CIE XYZ primaries and the EIZO CRT monitor primaries is

\[
\begin{bmatrix}
C_X \\
C_Y \\
C_Z
\end{bmatrix} = \begin{bmatrix}
0.3303 & 0.3255 & 0.2708 \\
0.1848 & 0.6967 & 0.1184 \\
0.0422 & 0.1603 & 1.4109
\end{bmatrix} \cdot \begin{bmatrix}
C_{EIZO,R} \\
C_{EIZO,G} \\
C_{EIZO,B}
\end{bmatrix}. \quad (2.10)
\]

### 2.1.3.3 Luminance and chromaticity of colorimetry model

The *luminance* of a color \([C(\lambda)]\), denoted as \(C_L\), can be determined in terms of the primaries \([P_1]\), \([P_2]\), and \([P_3]\) as

\[
C_L = K_m \int_{\lambda_{\min}}^{\lambda_{\max}} C(\lambda)V(\lambda)d\lambda, \quad (2.11)
\]

or

\[
C_L = C_1P_{1L} + C_2P_{2L} + C_3P_{3L}, \quad (2.12)
\]

where \(K_m\) is a constant that determines the units of luminance; \(V(\lambda)\) is the relative luminous efficiency curve as shown in Figure 2.3; and \(P_{iL} = K_m \int_{\lambda_{\min}}^{\lambda_{\max}} P_i(\lambda)V(\lambda)d\lambda\) is the luminosity coefficient of the primary \([P_i]\), \(i = 1, 2, 3\).

Similarly to the luminance, the *chroma* of a color \([C(\lambda)]\) with tristimulus values of \((C_1, C_2,\)
$C_3$ with respect to primaries $[P_1]$, $[P_2]$, and $[P_3]$ can be represented by the chromaticity coordinates $(c_1, c_2, c_3)$ and can be calculated as

$$c_i = \frac{C_i}{c_1 + c_2 + c_3}, \quad i = 1, 2, 3,$$

where $c_1 + c_2 + c_3 = 1$. (2.13)

Only two out of three chromaticity coordinates need to be specified. Often the chromaticity coordinates of a color are plotted on a two dimensional chromaticity diagram with axes $c_1$ and $c_2$. The chromaticity diagram is a useful visual aid for illustrating the gamut of a device as will be mentioned in a later section. Given any two of the chromaticity coordinates and the luminance of a color $(c_1, c_2, C_L)$ then its tristimulus values $(C_1, C_2, C_3)$ can be found as follows

$$C_i = \frac{c_i \cdot C_L}{c_1 \cdot P_{1L} + c_2 \cdot P_{2L} + c_3 \cdot P_{3L}}, \quad i = 1, 2, 3.$$ (2.14)

A color thus can be represented in terms of the tristimulus values $(C_1, C_2, C_3)$ or in terms of the chromaticity coordinates and luminance value $(c_1, c_2, C_L)$. Chromaticity coordinates will be used in Section 5.1.2.

### 2.1.3.4 CIE 1931 XYZ color space

The most commonly used color colorimetry model is the *CIE 1931 XYZ color space* with respect to which all modern color models are defined. In this research, the CIE XYZ space will be used as the color representation in the both anaglyph algorithm for CRT media and the anaglyph algorithm for printer media. The three CIE XYZ primaries are not physical colors (not realizable) because the purpose of the CIE XYZ space was for fast calculations. Figure 2.2 shows three CMFs $\pi(\lambda)$, $\gamma(\lambda)$, and $\tau(\lambda)$ of CIE XYZ color space corresponding to the primaries $[X]$, $[Y]$, and $[Z]$ respectively. A color $[C(\lambda)]$ in the CIE XYZ space thus can be represented by its tristimulus values $(C_X, C_Y, C_Z)$ as

$$C_X = k \cdot \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) \cdot \pi(\lambda) \cdot d\lambda,$$

$$C_Y = k \cdot \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) \cdot \gamma(\lambda) \cdot d\lambda,$$

$$C_Z = k \cdot \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} C(\lambda) \cdot \tau(\lambda) \cdot d\lambda,$$ (2.15)
where $k$ is a scalar. Thus, the xyz chromaticity coordinates $c_X$, $c_Y$, and $c_Z$ of the color $[C(\lambda)]$ can be calculated as

$$c_X = \frac{C_X}{C_X + C_Y + C_Z}, \quad c_Y = \frac{C_Y}{C_X + C_Y + C_Z}, \quad c_Z = \frac{C_Z}{C_X + C_Y + C_Z}. \quad (2.16)$$

The luminance of the colors $[X]$ and $[Z]$ are zero while the luminance of the color $[Y]$ is 1. Given $c_X$, $c_Y$ and $C_L$, the tristimulus values can be found as

$$C_X = \left(\frac{c_X}{c_Y}\right) \cdot C_L,$$

$$C_Y = C_L,$$

$$C_Z = \left(\frac{c_Z}{c_Y}\right) \cdot C_L. \quad (2.17)$$

Therefore, the $Y$ tristimulus value is the luminance of the color $[C(\lambda)]$. The color distance metric in the CIE XYZ space is the Euclidean distance between the two sets of tristimulus values and is defined as

$$\Delta E_{XYZ} = \sqrt{(\Delta C_X)^2 + (\Delta C_Y)^2 + (\Delta C_Z)^2}, \quad (2.18)$$

where $\Delta C_X = C_{1X}-C_{2X}$, $\Delta C_Y = C_{1Y}-C_{2Y}$, and $\Delta C_Z = C_{1Z}-C_{2Z}$. An experiment performed by MacAdam [6] showed that the CIE XYZ color space is a very non-uniform color space in the sense of Section 2.1.2.

### 2.1.4 Color appearance model

This section introduces the CIELAB color space that is used in the optimization problem for an anaglyph algorithm for printer media. This section is based primarily on Chapters 1 and 2 in the book of Sharma [1]. One trivial requirement for a color model is that colors with the same representation values must look the same. However, this requirement often fails for the color colorimetry model, since two colors with the same tristimulus values may look different depending on their contexts. This restriction is because the color colorimetry models are designed based on one strong condition: all colors must be viewed under the same designed viewing conditions - which are the stimulus, proximal field, background, surround, and modes of viewing; for more details about these viewing conditions please refer to reference [1, pg.137]. One example for this is two colors, in which one is displayed on a CRT display and one is displayed on paper and yet have the same CIE XYZ tristimulus values, will often look different. The phenomenon that the appearance of a color depends on a particular viewing condition is called a color appearance phenomenon. Many color models
try to formulate one or some of the color appearance phenomena in order quantify the visual perceptual attributes and use those values to represent color; such models are known as color appearance models. An excellent source about color appearance models can be found at [7].

2.1.4.1 Color appearance phenomena and chromatic adaptation models

There are many color appearance phenomena as Johnson and Fairchild [1, pg.141] have summarized. The Chromatic adaptation phenomenon, in which the appearance of a color is quite stable under the changes in light source’s chromaticity, is perhaps the most important appearance phenomenon. There are many attempts to model the chromatic adaptation such as the pioneering von Kries model and its derived models such as the Fairchild model, the Bradford model, etc. The chromatic adaptation model is often used to predict the CIE XYZ tristimulus values of a color in different viewing conditions.

- The von Kries chromatic adaptation model [1, p.154-55] transforms the CIE XYZ tristimulus values of a color in one viewing condition to CIE XYZ tristimulus values of this color in another viewing condition

\[
\begin{bmatrix}
X_2 \\
Y_2 \\
Z_2
\end{bmatrix} = M^{-1} \cdot \begin{bmatrix}
\frac{L_{white,2}}{L_{white,1}} & 0 & 0 \\
0 & \frac{M_{white,2}}{M_{white,1}} & 0 \\
0 & 0 & \frac{S_{white,2}}{S_{white,1}}
\end{bmatrix} \cdot M \cdot \begin{bmatrix}
X_1 \\
Y_1 \\
Z_1
\end{bmatrix},
\]

\[
\begin{bmatrix}
L_{white,1} \\
M_{white,1} \\
S_{white,1}
\end{bmatrix} = M \cdot \begin{bmatrix}
X_{white,1} \\
Y_{white,1} \\
Z_{white,1}
\end{bmatrix},
\]

\[
\begin{bmatrix}
L_{white,2} \\
M_{white,2} \\
S_{white,2}
\end{bmatrix} = M \cdot \begin{bmatrix}
X_{white,2} \\
Y_{white,2} \\
Z_{white,2}
\end{bmatrix},
\]

where \((L_{white,1}, M_{white,1}, S_{white,1})\) are the cone responses of the white point, whose CIE XYZ tristimulus values are \((X_{white,1}, Y_{white,1}, Z_{white,1})\), in the original viewing condition, and \((L_{white,2}, M_{white,2}, S_{white,2})\) are the cone responses of the white point, whose CIE XYZ tristimulus values are \((X_{white,2}, Y_{white,2}, Z_{white,2})\), in the new viewing condition.

- The Bradford chromatic adaptation model, which added a nonlinear term based on “spectrally sharpened” cone fundamentals upon the von Kries model, can be linearized and simplified down to Equation 2.19 [8] and with the linear transformation matrix M.
as

\[
M = \begin{bmatrix}
0.8951 & 0.2664 & -0.16614 \\
-0.7502 & 1.7135 & 0.0367 \\
0.0389 & -0.0685 & 1.0296
\end{bmatrix}.
\] (2.20)

For full details about the Bradford chromatic adaptation model please refer to reference [8].

2.1.4.2 CIELAB color space model

The CIELAB color space model was designed based on the CIE XYZ color space to improve the perceptual uniformness of the color space. The CIELAB color space will be also used in the optimization problem in both the developed anaglyph algorithms for CRT media and printer media. It is also used to test the accuracy of the characterization functions of the EIZO CRT monitor and the EPSON printer in Chapter 4.

If a color \([C]\) has CIE XYZ tristimulus values of \((C_X, C_Y, C_Z)\) with \((W_X, W_Y, W_Z)\) as the CIE XYZ tristimulus values of the reference (or the adapting) white, which are typically the CIE XYZ tristimulus values of the brightest color in the view, then this color is defined in the CIELAB space by three coordinates of \((C_{L*}, C_{a*}, C_{b*})\) where [1, pg.161]

\[
\begin{align*}
C_{L*} &= 116 f \left( \frac{C_Y}{W_Y} \right) - 16, \\
C_{a*} &= 500 \left( f \left( \frac{C_X}{W_X} \right) - f \left( \frac{C_Y}{W_Y} \right) \right), \\
C_{b*} &= 200 \left( f \left( \frac{C_Y}{W_Y} \right) - f \left( \frac{C_Z}{W_Z} \right) \right), \\
f(x) &= \begin{cases} \\
 x^{1/3} & \text{if } x \geq 0.008856, \\
 7.787(x) + \frac{16}{116} & \text{if } x \leq 0.008856.
\end{cases}
\end{align*}
\] (2.21)

The \(C_{L*}\) value predicts the lightness attribute, while \(C_{a*}\) and \(C_{b*}\) values predict the chroma and hue attributes of the color. CIELAB exploits the CIE XYZ scaling chromatic adaptation model, in which the CIE XYZ tristimulus values are scaled down according to the reference white.

There are a few different color distance metrics developed for the CIELAB color space. The simplest metric is the Euclidean distance between the CIELAB coordinates of two colors \([C_1]\) and \([C_2]\). A better distance metric is CIE-94 used in this study [1, pp.36-37]
\[ \Delta E_{94} = \sqrt{\left(\frac{\Delta L^*}{k_L S_L}\right)^2 + \left(\frac{\Delta C^*}{k_C S_C}\right)^2 + \left(\frac{\Delta H^*}{k_H S_H}\right)^2}, \]
\[ C_{1ab}^* = \sqrt{(C_{1a*})^2 + (C_{1b*})^2}, \]
\[ \Delta L^* = C_{1L*} - C_{2L*}, \]
\[ \Delta C^* = C_{1ab}^* - C_{2ab}^*, \]
\[ \Delta H^* = \sqrt{(\Delta E_{ab}^*)^2 - (\Delta L^*)^2 - (\Delta C^*)^2}, \]
\[ C_{ab}^* = \sqrt{C_{1abs} C_{2abs}}, \]
\[ S_C = 1 + 0.045 C_{ab}^*, \]
\[ S_H = 1 + 0.015 C_{ab}^*, \]
\[ S_L = 1. \]

Here, all the three scaling parameters are set to 1.

2.2 Color output devices

Most of the devices involved in a color imaging system can be classified as input devices (e.g., digital camera, scanner), which capture the color images and encode the colors, and output devices (e.g., monitor, TV, printer) which reproduce the color images on different media. As mentioned in Chapter 1, an anaglyph stereoscopic display system includes a color output device. Depending on a particular color display device there will be an optimized anaglyph algorithm for it. The developed anaglyph algorithms require knowledge of the relationship between the digital input signals and the PDSs produced by these color display devices. Therefore, this section discusses the steps to establish those relationships for typical color output devices which are CRT display and printer. This section is based primarily on Chapters 5, 10, and 11 in the book of Sharma [1].

2.2.1 Generic output device modeling

This section discusses the common approaches for establishing the function between the digital input signals and the PDSs produced by a color output device. Depending on the type of color output device, one approach may be more appropriate than another one. The upper path in Figure 2.4 is a typical setup of an output device. The digital input signal \( d \) first is sent through a Calibration process, denoted as \( \gamma_{Cal}(\cdot) \), to become the signal \( d' \). In the case of CRT displays, for instance, the signal \( d \) is a vector of three integer values [R, G, B], each in the range of [0, 255]. The calibration process adjusts the color device to make sure that this device is in its predefined initial state [1, pg.272]. The physical output color
device produces an output color signal $c_O$ based on the signal $d'$. In many applications, the output signal $c_O$ is the CIE XYZ tristimulus values or CIELAB coordinates. However, in an anaglyph stereoscopic display system, we need $c_O$ to be a PDS $C(\lambda)$. This PDS $C(\lambda)$ is not observed directly by the eyes, but rather is attenuated when propagating through colored-filter glasses (Section 2.3). It is these attenuated PDSs that the eyes perceive. Therefore, in order to predict the perceived color through colored-filter glasses, we need to know the reproduced PDSs $C(\lambda)$. We can see that the signal $d$ can be thought as a representation of the output color $c_O$. However, this signal $d$ can only be interpreted correctly by its associated color output device and hence the signal $d$ is also referred to as color device-dependent, while the output color $c_O$ is referred to as color device-independent.

The lower path in Figure 2.4 shows a mathematical model which is used to characterize the whole upper path process. If the same input signal $d$ is fed into this model then its output signal $c$ can be seen as an estimation of the real output signal $c_O$. This mapping function is referred to as the forward characterization function (FCF). If $c$ and $c_O$ are PDSs then FCF is called the spectral FCF (SFCF), denoted as $\Upsilon_{SFCF}(\cdot)$. The need for the calibration process is based on the fact that establishing a SFCF is often an expensive process in terms of time and labor, and it is needed every time the device’s response changes. Instead, a fast and easy calibration process can be used frequently to keep the SFCF accurate. To display an arbitrary device-independent color, we use the inverse FCF to estimate the input signal $d$.

The function $\Upsilon_{SFCF}(\cdot)$ can be found by two different approaches [1, pg.274]: empirical-based and model-based. In empirical approaches, a large enough set of inputs $d$ are fed into the upper process, and the output samples are measured by using a colorimeter, spectrophotometer, or spectroradiometer instrument. Then multi-dimensional interpolation and data fitting techniques can be applied to find the relationship between the input and output color samples. In model-based approaches, a mathematical model will be used to describe the device behaviors, and the model’s parameters can be found by the relationship between a

![Figure 2.4 Output device forward characterization block diagram. (Reproduced from [1, pg.284])](image-url)
small number of inputs \( \mathbf{d} \) and the corresponding output color samples \( \mathbf{c}_O \).

### 2.2.2 Multidimensional data fitting and interpolation

As mentioned in the previous section, in the empirical approach, we need to use the regression technique to perform data fitting and interpolation. The polynomial regression technique is used to model \( \gamma_{SFCP}(\cdot) \) for the EPSON printer in Section 4.3 and hence will be discussed in detail.

Assume that an experiment has \( T \) training samples in which \( \mathbf{d}_t = [d_{t,1}, d_{t,2}, ..., d_{t,m}] \) is the \( 1 \times m \) row vector of \( m \) inputs and \( \mathbf{c}_t = [c_{t,1}, c_{t,2}, ..., c_{t,n}] \) is the \( 1 \times n \) row vector of \( n \) outputs, and \( t = 1, 2, ..., T \). For instance, the sample vector \( \mathbf{d}_t \) can be the EPSON printer input \([R, G, B]\) values (in this case \( m = 3 \)) and the output vector \( \mathbf{c}_t \) is the 151 discrete values of the PDS reflected light corresponding to that input (in this case \( n = 151 \)). This section is based on Section 5.4 and Chapter 11 in the book of Sharma [1]. Although trilinear regular lattice, sequential interpolation, and neural network methods will be involved in Section 4.3.1 along with the polynomial regression method for comparison, they will not be discussed here. For details about trilinear regular lattice, sequential interpolation and neural network methods please refer to Chapter 4 in Kang’s book [9].

The polynomial regression technique is a special form of least-squares regression wherein the characterization function is approximated by a polynomial. The \( N \)-order polynomial approximation for a transformation of a training sample vector with three inputs is given by [1, pg.295]

\[
c_{t,l} = \sum_{i=0}^{N} \sum_{j=0}^{N} \sum_{k=0}^{N} \left( w_{i,j,k,t,l} \cdot d_{t,1}^i \cdot d_{t,2}^j \cdot d_{t,3}^k \right) \quad t = 1, 2, ..., T \text{ and } l = 1, 2, ..., n. \tag{2.23}
\]

In matrix notation, Equation 2.23 can be written as

\[
\mathbf{c}_t = \begin{bmatrix} 1, & d_{t,3}, & d_{t,2}, & ... , & d_{t,1}^N \end{bmatrix} \begin{bmatrix} w_{0,0,0,t,1} & w_{0,0,0,t,2} & ... & w_{0,0,0,t,n} \\
 w_{0,0,1,t,1} & w_{0,0,1,t,2} & ... & w_{0,0,1,t,n} \\
 ... & ... & ... & ... \\
 w_{N,N,N,t,1} & w_{N,N,N,t,2} & ... & w_{N,N,N,t,n} \end{bmatrix}
\]

\[
= \mathbf{p}_t \cdot \mathbf{A}.
\tag{2.24}
\]
The optimal matrix $A$ must satisfy the condition

$$A_{\text{opt}} = \arg \min_A \left\{ \frac{1}{T} \sum_{t=1}^{T} \|c_t - p_t \cdot A\|^2 \right\}. \tag{2.25}$$

If $P$ is the $T \times (N + 1)^3$ matrix $[p_1; p_2; \ldots; p_T]$, then the solution for Equation 2.25 is

$$A = (P^T \cdot P)^{-1} \cdot P^T \cdot C. \tag{2.26}$$

### 2.2.3 Spectral white-point normalization

To model the $\Upsilon_{\text{SCF}}(\cdot)$ processes for both a CRT display and a printer, the PDSs of emitting lights (in the case of the CRT display) or reflecting lights (in the case of the printer) are needed. These PDSs can often be measured by using measurement devices such as spectrophotometers or spectroradiometers. Often, the absolute units of these PDSs are not known nor often required in many applications. Therefore, these PDSs need to be normalized. The scaling value $k$ in Equation 2.15 is the normalization constant and often is chosen to have the Y luminance value in the CIE XYZ tristimulus values of the white color reproduced by the color device to be 1 [1, pg.289], and thus

$$k = \frac{1}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} \frac{W(\lambda) \cdot f(\lambda) \cdot d\lambda}{\lambda_{\text{max}}}}, \tag{2.27}$$

where $W(\lambda)$ is the reproduced PDS of the white color which can be the brightest point that the color device can generate. Therefore, a measured PDS $C_{\text{Measured}}(\lambda)$ from a device now can be normalized according to the white point as

$$C_{\text{Normalized}}(\lambda) = k \cdot C_{\text{Measured}}(\lambda). \tag{2.28}$$

This section will be applied to the raw measured PDSs that are emitted from the EIZO CRT monitor and the PDSs reflected from the EPSON printer in Chapter 4.

### 2.2.4 Device gamut, gamut mapping, and device profile

This section and the next are needed to understand the printing process of the EPSON printer in Section 4.3.1.1. In practice, a color device can only capture or reproduce a certain range of physical colors, and this set is referred to as the color gamut. This gamut is a subset of the set of all physical colors $\mathcal{C}_P$. In a color colorimetric model, a color gamut can
be projected onto a chromaticity diagram (e.g. the xy chromaticity diagram) as a tool for gamut visualization. For example, Figure 2.6 shows the xy chromaticity gamut of the EIZO CRT monitor. We can see that all the physical colors lie inside the area made up by the sharkfin-shaped curve and the line of purples, and all the colors in the EIZO CRT monitor's gamut have xy chromaticities that lie within the indicated triangle.

If we want to display colors that are outside the gamut, then first, these out-of-gamut colors must be mapped into colors that are inside the device's gamut. This mapping is referred to as **gamut mapping**. A gamut mapping is designed based on the **color rendering intent**, which is the specification of what properties of color (e.g. color attributes) we want to maintain in the reproduction color [1, pg.642]. The International Color Consortium (ICC) has classified the rendering intents into four different categories: perceptual intent, saturation intent, relative colorimetric intent, and absolute colorimetric intent. The perceptual intent was chosen for the EPSON printer printing process in this thesis. In the perceptual intent that is useful for photographic-type images, the perceptual appearance of an image color is preserved, and only a few or even no colors will stay the same as in the original [1, pg.643].

Every commercial color output device is associated with a profile. This contains the description of the device, the inverse FCF, and the device-independent color space. ICC-CMS (Color management system), which is a program module (e.g. Microsoft ICM or Adobe ACE), will be based on this profile and the desired color rendering intent to make sure the color device reproduces correct color. For more detail about profiles, one can refer to [10].

### 2.2.5 CRT displays

The general background about color devices has been overviewed in previous sections. In this section, we look at a particular color output device: CRT displays. The results of this section will be used in an anaglyph algorithm that renders anaglyph images to be best displayed on a given CRT display. This section also serves as background for characterizing the EIZO CRT monitor in Section 4.2.

Perhaps the most important color output device is the cathode-ray tube (CRT). The working mechanism of the CRT is that three voltages control red, green, and blue electron guns to fire electron beams onto a small area on the screen covered with red, green, and blue phosphor dots. This small area is referred to as a pixel. The collision of the electron beam from red, green, and blue electron guns with the red, green, blue phosphor dots, respectively, will excite the phosphors to emit red \([R(\lambda)]\), green \([G(\lambda)]\), and blue \([B(\lambda)]\) lights. Due to the small size of the pixel, we will see those three separate lights as a single color, which is the
additive mixture of those red, green, and blue lights. By controlling the input voltages of
the guns, the CRT can produce different colors. The red, green, blue input voltages in turn
are controlled by their corresponding three digital numbers \((R', G', B')\) (this is the input
signal \(d'\) in Figure 2.4), each number is an integer in the range of \([0, 255]\) for 24-bit color.

In the CRT, if the gun independence and pixel independence assumptions [1, pg.281] can be
made, then the spectral light emitted at a pixel \(x\), \(C(\lambda, x)\), can be formulated as [11]

\[
C(\lambda, x) = R(\lambda, x) + G(\lambda, x) + B(\lambda, x)
= \Upsilon_{\text{Gun}}(R'(x)) \cdot R_{\text{max}}(\lambda, x) + \Upsilon_{\text{Gun}}(G'(x)) \cdot G_{\text{max}}(\lambda, x)
+ \Upsilon_{\text{Gun}}(B'(x)) \cdot B_{\text{max}}(\lambda, x),
\]

where \(R(\lambda, x)\), \(G(\lambda, x)\), and \(B(\lambda, x)\) are the white-point normalized PDSs (Section 2.2.3) of
the lights emitted by the red, green, and blue phosphors. \(R_{\text{max}}(\lambda, x)\) is the red emitting
PDS at its maximum intensity, and \(\Upsilon_{\text{Gun}}(\cdot)\) is the nonlinear function that describes the
relationship between the digital inputs and the driving gun voltages.

### 2.2.5.1 CRT Calibration

In this section, we establish the function \(\Upsilon_{\text{Cal}}(\cdot)\) for a CRT display, denoted as \(\Upsilon_{\text{Cal,CRT}}(\cdot)\). It
has the input signal of \(d = (R, G, B)\) \((R, G, \text{and } B \text{ are in the range of } [0, 1])\) and the output
signal of \(d' = (R', G', B')\). Furthermore, the function \(\Upsilon_{\text{Cal,CRT}}(\cdot)\) is a separable function
which means that each of components \(R', G',\) and \(B'\) can be computed directly from \(R, G,\)
and \(B, \) respectively. We first set the brightness, contrast, and simulated temperature of the
CRT display to the known conditions and then establish the relationship

\[
R'(x) = \Upsilon_{\text{Cal,CRT}}(R(x)) = \Upsilon_{\text{Gun}}^{-1}(R(x)).
\]

Similar expressions hold for \(G'\) and \(B'\). \(R\) is also referred to as the red non-gamma-corrected
value, whereas the \(R'\) value is also referred to as the red gamma-corrected value.

#### 2.2.5.1.1 Simple gamma-correction model

The simplest form of the function \(\Upsilon_{\text{Gun}}(\cdot)\)
is [1, pg.325]

\[
R = \left(\frac{R'}{2^n - 1}\right)^{\gamma_R},
\]

where \(n\) is the number of bits of digital input \(R'\). This is known as the simple gamma-
correction model. To find the value of \(\gamma_R\), first for each different value of \(R'\) in a set of
pre-selected digital signals \(R'\) (and the other two signal values \(G'\) and \(B'\) are set to zero),
we measure the PDS of the emitted light from the CRT display and denotes these measured PDSs as $C_{\text{Measured}}(\lambda)$. If $\gamma_R$ is known then from Equation 2.39, the PDSs of emitted lights from the CRT display can be estimated, denoting these estimated PDSs as $C_{\text{Estimated}}(\lambda)$. We can use a nonlinear optimization method to find $\gamma_R$ so as to minimize the color distances between the measured colors $[C_{\text{Measured}}(\lambda)]$ and the corresponding estimated colors $[C_{\text{Estimated}}(\lambda)]$. Similar expressions and steps hold for $\gamma_G$ and $\gamma_B$.

2.2.5.1.2 GOG gamma-correction model This model is an extension of the simple gamma-correction model where the function $\Upsilon_{\text{Gun}}(\cdot)$ is defined as [12, 13]

$$R = \begin{cases} (k_{g,R} \cdot \left(\frac{R'}{2^n - 1}\right) + 1 - k_{g,R})^{\gamma_R} & \text{if } k_{g,R} \cdot \frac{R'}{2^n - 1} + 1 - k_{g,R} \geq 0, \\ 0 & \text{otherwise}, \end{cases}$$

where $k_{g,R}$ is a constant gain, greater than 1. The steps for obtaining the gamma value $\gamma_R$ are the same as the steps used for the simple gamma-correction model.

2.2.5.1.3 ITU-R 709 gamma-correction recommendation If a CRT display is set to a manufacturer predefined state then all three display gamma values should be around 2.2, and the standard gamma-correction function suggested by ITU-R 709 is [6]

$$R' = \begin{cases} 4.5R & \text{if } R \leq 0.018, \\ 1.099R^{0.45} - 0.099 & \text{if } 0.018 \leq R \leq 1.0, \\ 0.22R' & \text{if } R \leq 0.081, \\ \left(\frac{R + 0.099}{1.099}\right)^{2.22} & \text{if } 0.081 \leq R \leq 1.0. \end{cases}$$

(2.33)

Again similar expressions hold for $G$ and $B$.

2.2.5.2 Model-based CRT SFCF

In this section we will establish $\Upsilon_{\text{SFCF}}(\cdot)$ for a CRT display, denoted as $\Upsilon_{\text{SFCF,CRT}}(\cdot)$. This function has the input as a set of three signals $0 \leq R, G, B \leq 1$ and the output of PDS $C(\lambda)$ with $\lambda_{\text{min}} \leq \lambda \leq \lambda_{\text{max}}$. If three colors $[R_{\text{max}}(\lambda, x)], [G_{\text{max}}(\lambda, x)],$ and $[B_{\text{max}}(\lambda, x)]$ are chosen to be three primaries then from Section 2.1.3.2 and Equation 2.29 the CIE XYZ tristimulus values $(C_X, C_Y, C_Z)$ of a reproduced color $[C(\lambda, x)]$ with respect to these primaries can be calculated as

\[\text{Discussed in Section 2.2.5.2}\]
\[
\begin{bmatrix}
C_X \\
C_Y \\
C_Z
\end{bmatrix} = \begin{bmatrix}
R_{\text{max},X} & G_{\text{max},X} & B_{\text{max},X} \\
R_{\text{max},Y} & G_{\text{max},Y} & B_{\text{max},Y} \\
R_{\text{max},Z} & G_{\text{max},Z} & B_{\text{max},Z}
\end{bmatrix} \cdot \begin{bmatrix}
R \\
G \\
B
\end{bmatrix} = A \cdot \begin{bmatrix}
R \\
G \\
B
\end{bmatrix},
\]

where \((R_{\text{max},X}, R_{\text{max},Y}, R_{\text{max},Z})\) are the CIE XYZ tristimulus values of the color \(R_{\text{max}}(\lambda, x)\).

By measuring the PDS of each primary at its maximum intensity the matrix \(A\) can be obtained. The matrix \(A\) can also be rewritten as

\[
A = \begin{bmatrix}
R_{\text{max},X} & G_{\text{max},X} & B_{\text{max},X} \\
R_{\text{max},Y} & G_{\text{max},Y} & B_{\text{max},Y} \\
R_{\text{max},Z} & G_{\text{max},Z} & B_{\text{max},Z}
\end{bmatrix}
\begin{bmatrix}
\frac{r_{\text{max},X}}{1} & \frac{g_{\text{max},X}}{1} & \frac{b_{\text{max},X}}{1} \\
\frac{r_{\text{max},Y}}{1} & \frac{g_{\text{max},Y}}{1} & \frac{b_{\text{max},Y}}{1} \\
\frac{r_{\text{max},Z}}{1} & \frac{g_{\text{max},Z}}{1} & \frac{b_{\text{max},Z}}{1}
\end{bmatrix} \cdot \begin{bmatrix}
R_{\text{max},Y} & 0 & 0 \\
0 & G_{\text{max},Y} & 0 \\
0 & 0 & B_{\text{max},Y}
\end{bmatrix},
\]

where \((r_{\text{max},X}, r_{\text{max},Y}, r_{\text{max},Z})\) are the xyz chromaticity coordinates of \(R_{\text{max}}(\lambda, x)\) in the CIE XYZ color space. Normally, we want the CIE XYZ tristimulus values of the white light \((W_X, W_Y, W_Z)\), which are reproduced by summing one unit of each primary, to match the CIE XYZ tristimulus values of reference white. The reference white should be the measured brightest point (normally when all the inputs are set to 1). If the measured PDS of the brightest point is not available then we can replace it by a known reference white point such as D65 which has the CIE XYZ tristimulus values \((0.9504, 1.0000, 1.0889)\). Therefore, from Equations 2.34 and 2.35, we want

\[
\begin{bmatrix}
W_X \\
W_Y \\
W_Z
\end{bmatrix} = \begin{bmatrix}
\frac{r_{\text{max},X}}{1} & \frac{g_{\text{max},X}}{1} & \frac{b_{\text{max},X}}{1} \\
\frac{r_{\text{max},Y}}{1} & \frac{g_{\text{max},Y}}{1} & \frac{b_{\text{max},Y}}{1} \\
\frac{r_{\text{max},Z}}{1} & \frac{g_{\text{max},Z}}{1} & \frac{b_{\text{max},Z}}{1}
\end{bmatrix} \cdot \begin{bmatrix}
R_{\text{max},Y} & 0 & 0 \\
0 & G_{\text{max},Y} & 0 \\
0 & 0 & B_{\text{max},Y}
\end{bmatrix} \cdot \begin{bmatrix}
1 \\
1 \\
1
\end{bmatrix}.
\]

The values \(R_{\text{max},Y}, G_{\text{max},Y},\) and \(B_{\text{max},Y}\) that satisfy the equation above can be calculated as

\[
\begin{bmatrix}
R_{\text{max},Y,Norm} \\
G_{\text{max},Y,Norm} \\
B_{\text{max},Y,Norm}
\end{bmatrix} = \begin{bmatrix}
\frac{r_{\text{max},X}}{1} & \frac{g_{\text{max},X}}{1} & \frac{b_{\text{max},X}}{1} \\
\frac{r_{\text{max},Y}}{1} & \frac{g_{\text{max},Y}}{1} & \frac{b_{\text{max},Y}}{1} \\
\frac{r_{\text{max},Z}}{1} & \frac{g_{\text{max},Z}}{1} & \frac{b_{\text{max},Z}}{1}
\end{bmatrix}^{-1} \cdot \begin{bmatrix}
W_X \\
W_Y \\
W_Z
\end{bmatrix}.
\]
Table 2.1 The xy chromaticity coordinates of three primaries and the CIE XYZ tristimulus of the reference white used in sRGB color space. Note that these values are the same as those used in the ITU-R 709 RGB color space.

<table>
<thead>
<tr>
<th></th>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
<th>White (D65)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>0.640</td>
<td>0.300</td>
<td>0.150</td>
<td>0.3127</td>
</tr>
<tr>
<td>y</td>
<td>0.330</td>
<td>0.600</td>
<td>0.060</td>
<td>0.3290</td>
</tr>
<tr>
<td>z</td>
<td>0.030</td>
<td>0.100</td>
<td>0.790</td>
<td>0.3582</td>
</tr>
</tbody>
</table>

Therefore, the measured PDSs $R_{\text{max}}(\lambda, x)$, $G_{\text{max}}(\lambda, x)$, and $B_{\text{max}}(\lambda, x)$ need to be normalized to give those normalized luminances

$$R_{\text{max, Norm}}(\lambda, x) = R_{\text{max}}(\lambda, x) \cdot \left(\frac{R_{\text{max, Y, Norm}}}{R_{\text{max, Y}}}\right).$$  \hspace{1cm} (2.38)

Similar expressions hold for $G_{\text{max, Norm}}(\lambda, x)$ and $B_{\text{max, Norm}}(\lambda, x)$. Therefore, the output PDS $C(\lambda, x)$ can be found by

$$C(\lambda, x) = R(x) \cdot R_{\text{max, Norm}}(\lambda, x) + G(x) \cdot G_{\text{max, Norm}}(\lambda, x) + B(x) \cdot B_{\text{max, Norm}}(\lambda, x),$$

$$= \gamma_{\text{SCF, CRT}}(R(x), G(x), B(x)).$$  \hspace{1cm} (2.39)

And finally the matrix $A$ in Equation 2.35 can be normalized to become

$$A = \begin{bmatrix} \frac{r_{\text{max}, x}}{r_{\text{max}, Y}} & \frac{g_{\text{max}, x}}{g_{\text{max}, Y}} & \frac{b_{\text{max}, x}}{b_{\text{max}, Y}} \\ \frac{r_{\text{max}, z}}{r_{\text{max}, Y}} & \frac{g_{\text{max}, z}}{g_{\text{max}, Y}} & \frac{b_{\text{max}, z}}{b_{\text{max}, Y}} \end{bmatrix} \cdot \begin{bmatrix} R_{\text{max, Y, Norm}} & 0 & 0 \\ 0 & G_{\text{max, Y, Norm}} & 0 \\ 0 & 0 & B_{\text{max, Y, Norm}} \end{bmatrix}.$$  \hspace{1cm} (2.40)

### 2.2.5.3 sRGB color space

It is worth-while to mention briefly the sRGB color space as we will use it in the printing process in Section 4.3.1.1. Many CRT monitors have some similarities in three primaries’ xy chromaticity coordinates. Therefore, the main purpose of the sRGB color space is to reduce the color reproduction process complexity without sacrificing much the color accuracy [14]. The digital input $d = (R, G, B)$ in the sRGB color space can be displayed directly on CRT monitors and they are most likely to look similar. The chromaticities of the sRGB primaries and the reference white are shown in Table 2.1. The details of the sRGB gamma correction process are shown in reference [14].
2.2.6 Halftone printers

This section is needed for establishing the SF CF of the EPSON printer $\nu_{SFCF,Primer}(\cdot)$ (Section 4.3) which is used in developing the anaglyph algorithm that renders anaglyph images printed on ordinary paper to have a pleasant appearance.

A printer, which is a subtractive color device, can reproduce a color by mixing three type of colorants: cyan (C), magenta (M), and yellow (Y) and place this colorant mixture on a medium such as paper or transparency. A light $S(\lambda)$ will be reflected from (in the case of paper) or transmitted through (in the case of transparency) this colorant mixture when it is illuminated by an illuminant $I(\lambda)$. We have $S(\lambda) = I(\lambda) \cdot Ref(\lambda)$, where $Ref(\lambda)$ is the spectral reflectance (or transmittance) function of this colorant mixture. With an appropriate mixing of colorants to selectively modify the spectrum illuminant light we can produce a desired color. The quantity of each colorant in the mixture is controlled by a digital number.

Halftone printers exploit the optical illusion in which the human eye cannot distinguish small dots of colorants from a far distance and hence combine the light reflectance or transmittance from those colorant dots to give a unique color. It divides the printable area into small areas of so-called screen cells (similar to pixel in CRT). These screen cells are further divided into a matrix of smaller areas called dots where the printer may or may not place a fixed concentration ink droplet into these dots. By controlling the size, shape, frequency, and angle of those dots, halftone printers can produce desired colors. The characteristic of a printer is complex due to the nonlinear combination of many factors such as the unwanted absorption bands of colorants, the light scattering in the paper leads to optical and spatial interactions, imprecision of the colorant dots size. [1, pg.283].

The initial state of printers can be achieved by two common approaches: channel-independent and gray-balanced. Note that the number of colorants in a printer is not necessary restricted to only three colorants C, M, Y. Additional colorants can be black (K), orange (O), or green (G). In this case, the digital input $d'$ must be represented by a set of more than three values, for example a set of six values (C, M, Y, K, O, G) for a six-colorants CMYKOG printer. However, a color can be sufficiently represented by a set of three coefficients, e.g. (C, M, Y). Therefore, this printer’s driver will also carry an extra step of mapping the three values (C, M, Y) into six values (C, M, Y, K, O, G).

Often, many commercial halftone printers have drivers to work directly with programs that process colors which are represented by the CRT device-dependent format (e.g. the sRGB color space) and hence its input is a set of three signals ($R$, $G$, $B$). We refer these printers
to here as RGB printers. Therefore, a RGB printer’s \( \gamma_{SFCF,\text{Printer}}(\cdot) \) has the input as a set of three signals \( 0 \leq R, G, B \leq 1 \) and the output of PDS \( C(\lambda) \) with \( \lambda_{\min} \leq \lambda \leq \lambda_{\max} \). The EPSON printer used in this study is a RGB printer.

For a halftone color printer, in the model-based approach, the color separation process followed by the model-based Neugebauer model or its derived models such as Yule-Nielsen or Cellular Neugebauer are quite accurate to model the function \( \gamma_{SFCF,\text{Printer}}(\cdot) \). The Neugebauer model is based on the assumption that the unified spectral reflectance \( Ref(\lambda) \) within a screen cell is a sum of weighted spectral reflectance of all the colorant combinations. For an overview on the Neugebauer model, one can refer to Section 5.10.2.3 in [1].

In empirical approaches, a sufficiently large set of colors is printed on a paper. The spectral reflection of each printed colorant mixture is then measured. Finally, the printer SFCF can be established via a data fitting or interpolation technique such as the polynomial regression, the trilinear interpolation, or the neural network method (Section 2.2.2). However, due to the nonlinear characteristic of the printer SFCF, linear regression is obviously not suitable for printer characterization. The EPSON printer SFCF is derived based on this approach with the polynomial regression so as to give the best results in terms of the accuracy and the execution time if compared to other interpolation techniques.

### 2.3 Colored-filter glasses

In an anaglyph stereo system, the emitting or reflecting lights from the display devices have to go through the colored-filter glasses. This section describes the effect of a colored-filter glass. A colored-filter is a device that attenuates the PDS of lights \( C(\lambda) \) passing through it at certain wavelengths according to its spectral absorption curve \( f(\lambda) \) with \( 0 \leq f(\lambda) \leq 1 \) (e.g. Figure 2.5 shows the red and cyan colored-filter absorption curves used in this thesis). The attenuated PDS \( C_f(\lambda) \) can be calculated as

\[
C_f(\lambda) = C(\lambda) \cdot f(\lambda).
\]  

(2.41)

Through a colored-filter glass, the gamut of a color device is distorted.

#### 2.3.1 The effect of the colored-filter glass on CRT device

This section is very important for developing an anaglyph algorithm for CRT media. As shown in Section 2.3, a colored-filter glass attenuates a PDS that goes through it. From
Equations 2.39 and 2.41, the PDS of the emitting light from a CRT display after going through a colored-filter glass with the absorption curve of $f(\lambda)$ is

\[
C_f(\lambda, x) = C(\lambda, x) \cdot f(\lambda) = \Upsilon_{SFCF,CRT}(R(x), G(x), B(x)) \cdot f(\lambda) \\
= R(x) \cdot R_{max, Norm}(\lambda, x) \cdot f(\lambda) + G(x) \cdot G_{max, Norm}(\lambda, x) \cdot f(\lambda) + B(x) \cdot B_{max, Norm}(\lambda, x) \cdot f(\lambda).
\]

Thus the PDSs $R_{max, Norm}(\lambda, x) \cdot f(\lambda)$, $G_{max, Norm}(\lambda, x) \cdot f(\lambda)$, and $B_{max, Norm}(\lambda, x) \cdot f(\lambda)$ can be considered as three primaries for this filter. By converting these three primaries into the CIE XYZ tristimulus values, we can get the transformation matrix $A_{Filter}$, that describes the relationship between the input signal and the CIE XYZ tristimulus values of the perceived color through this filter

\[
\begin{bmatrix}
C_{f,X} \\
C_{f,Y} \\
C_{f,Z}
\end{bmatrix} = A_{Filter} \cdot \begin{bmatrix} R \\ G \\ B \end{bmatrix} = \begin{bmatrix}
R_{max,f,X} & G_{max,f,X} & B_{max,f,X} \\
R_{max,f,Y} & G_{max,f,Y} & B_{max,f,Y} \\
R_{max,f,Z} & G_{max,f,Z} & B_{max,f,Z}
\end{bmatrix} \cdot \begin{bmatrix} R \\ G \\ B \end{bmatrix},
\]

where $(R_{max,f,X}, R_{max,f,Y}, R_{max,f,Z})$ are the CIE XYZ tristimulus values of the color $[R_{max, Norm}(\lambda, x) \cdot f(\lambda)]$. Figure 2.6 shows the gamuts of the EIZO CRT monitor, of the red filter, and of the cyan filter in the xy chromaticity diagram. These two filters have the absorption curves as shown in Figure 2.5.)
Figure 2.6 The large triangle is the gamut of the EIZO CRT monitor. The small triangle at the bottom right is the gamut when seen through the red filter. The small upper left triangle is the gamut when seen through the cyan filter. (Background chromaticity diagram generated using software of from [2])

2.4 Summary

This chapter has overviewed the color theory necessary for this thesis research. Two types of color models have been discussed. The colorimetric model (with the CIE XYZ color space as its representative) models the colors under the same viewing conditions. This model however cannot predict if two colors will look the same if each of them is in different viewing conditions. This limitation led to the introduction of the color appearance model (with the CIELAB color space as its representative). The definition of color distance, that is used to measure the closeness of two colors, is extremely important in this study. The chapter also looked at different approaches for establishing the spectral forward characterization functions of a given CRT and a given printer. The last section showed the attenuation effect of a colored-filter glass on the CRT display or the printer.
CHAPTER

THREE

Mathematical formulation for anaglyph stereoscopic rendering

The previous chapter is necessary to understand color which is needed for this chapter. In this chapter, we will systematically formulate the anaglyph problem. Through the formulation we will be able to establish three quality factors for an anaglyph algorithm. These quality factors can be considered as guidelines for comparison between different anaglyph algorithms or for developing better anaglyph algorithms. Finally, the chapter will summarize the state of art of existing anaglyph algorithms.

3.1 Binocular Vision

The two following sub-sections is needed to help us define the limitation of the anaglyph technique (Section 3.2).

3.1.1 Correspondent points

The human eye in the simplest form can be represented by the Pinhole model as shown in Figure 3.1(a). The real scene points $P_1$ and $P_2$ are captured to become the points $P_{L1}$ and $P_{L2}$ respectively on the 2D left image plane (referred to as left-perspective image) and to become the points $P_{R1}$ and $P_{R2}$ on the 2D right image plane (referred to as right-perspective image). If the left-perspective image is seen only by the left eye and the right-perspective image is seen only by the right eye then the human brain will fuse these two images into one stereo image and therefore the observer can perceive the depth of $P_1$ and $P_2$ as demonstrated in Figure 3.1(b). These two images form a stereo image pair of the real scene. Refer to Appendix
B for examples. The points $P_{L1}$ and $P_{R1}$ are referred to as the correspondent points of $P_1$. Similarly, the points $P_{L2}$ and $P_{R2}$ are referred to as the correspondent points of $P_2$.

### 3.1.2 Dichoptic color mixture

Dichoptic color mixture is what the human brain will interpret when one color is presented to one eye and another color is presented to the other eye. Under some circumstances, the human brain will fuse these two colors to give an impression of a stable third color. However, under other circumstances, the brain can’t combine these two colors into a single color impression but instead will see one color, either the left or the right color, for a period of time and then see the other color also for a period of time. In other words, we see two separate colors alternately. We only found one quantitative model that can predict the dichoptic color mixture in certain restricted conditions, the Dichoptic ATDN model [15]. It has been known that [15] the dichoptic color mixtures are more stable when (1) the luminances of two colors are low and equal, (2) the saturations of the two colors decrease, (3) the background is dark and uniform, (4) the two color stimuli are small in diameter.

### 3.2 Anaglyph framework

A stereoscopic display system needs to present the left and right-perspective images to the corresponding eyes. The anaglyph stereoscopic display system uses the color-multiplexing technique to superimpose the left and right-perspective images into one single so-called anaglyph image. When the observer views this anaglyph image through a pair of colored-filter glasses with each eye having a different colored-filter glass (e.g. the left eye wears a red
filter and the right eye wears a cyan filter) then the left eye will see an image which looks similar (but not identical) to the original left-perspective image and the right eye will see an image which looks similar (but not identical) to the original right-perspective image. In other words, the left colored-filter glass will block the right-perspective image to the left eye and the right colored-filter glass blocks the left-perspective image to the right eye. From these left and right filtered images the observer’s visual system will fuse them into one single view with depth perception. The following section formulates the anaglyph process mathematically.

### 3.2.1 Anaglyph problem formulation

In this section, we would like to re-address the anaglyph technique from a mathematical point of view. These formulae are important for understanding the problem systematically and also serve as a framework for developing and evaluating anaglyph algorithms in later chapters. This formulation is an extension of the idea in reference [16] and hence this section and its subsections can be considered as the first contribution to this research area.

An anaglyph stereoscopic display system usually includes an output color device \( \mathcal{D} \) such as a CRT display or a printer, a pair of colored-filter glasses through which the eyes look at the device \( \mathcal{D} \), and a stereo image pair. Without loss of generality, let's assume that the device \( \mathcal{D} \) is a RGB color device whose input signal \( \mathbf{d} \) (Figure 2.4) is set of a three values \((R, G, B)\), that has SFCF of \( \Upsilon_{\text{SFCF}}(\cdot) \) and color gamut of \( \mathcal{C}_{\mathcal{D}} \). The left-perspective image in the stereo image pair, denoted as \( I_{L,RGB} \), can be considered as a set of digital inputs \( \mathbf{d} = I_{L,RGB}(\mathbf{x}) = [I_{L,RGB,R}(\mathbf{x}) I_{L,RGB,G}(\mathbf{x}) I_{L,RGB,B}(\mathbf{x})] \) for each point \( \mathbf{x} \in \mathcal{L} \), where \( \mathcal{L} \) is the sampling raster for the left-perspective image and can be either spatial or spatiotemporal. Similarly, the right-perspective image \( I_{R,RGB} \) is a set of digital inputs \( \mathbf{d} = I_{R,RGB}(\mathbf{x}) = [I_{R,RGB,R}(\mathbf{x}) I_{R,RGB,G}(\mathbf{x}) I_{R,RGB,B}(\mathbf{x})] \). The signal values in \( I_{L,RGB}(\mathbf{x}) \) and \( I_{R,RGB}(\mathbf{x}) \) are in the range of \([0, 1]\). Assume that the left eye sees the device \( \mathcal{D} \) through the left colored-filter glass (left filter) that has the absorption curve \( f_{L}(\lambda) \), and the right eye sees the device \( \mathcal{D} \) through the right colored-filter glass (right filter) that has the absorption curve \( f_{R}(\lambda) \).

If the device \( \mathcal{D} \) displays the inputs \( I_{L,RGB}(\mathbf{x}) \) and \( I_{R,RGB}(\mathbf{x}) \), individually, then the perceived colors at a point \( \mathbf{x} \) are

\[
\begin{align*}
[I_{L}(\lambda, \mathbf{x})] &= [\Upsilon_{\text{SFCF}}(I_{L,RGB}(\mathbf{x}))], \\
[I_{R}(\lambda, \mathbf{x})] &= [\Upsilon_{\text{SFCF}}(I_{R,RGB}(\mathbf{x}))].
\end{align*}
\]  

(3.1)

An anaglyph algorithm \( \Upsilon_{\text{Ana}}(\cdot) \) will have to render an image, called the anaglyph image, denoted as \( I_{A,RGB} \), from \( I_{L,RGB}, I_{R,RGB} \), and other information such as the absorption curves
of the two filters, the characteristic of the device $\mathcal{D}$, and probably the viewing conditions:

$$
I_{A,RGB} = \gamma_{Ana}(I_{L,RGB}, I_{R,RGB}, f_L(\lambda), f_R(\lambda), \gamma_{SFCF}(\cdot), ...).
$$

(3.2)

The anaglyph algorithm $\gamma_{Ana}(\cdot)$ may not be a memoryless system. Let's assume the input $I_{A,RGB}(x)$ has three components as

$$
I_{A,RGB}(x) = [I_{A,RGB,R}(x) \ I_{A,RGB,G}(x) \ I_{A,RGB,B}(x)].
$$

(3.3)

If the device $\mathcal{D}$ displays the input $I_{A,RGB}(x)$, then the perceived color by both eyes without glasses is

$$
[I_A(\lambda, x)] = [\gamma_{SFCF}(I_{A,RGB}(x))].
$$

(3.4)

Through the left filter, the left eye sees the color

$$
[I_{AL}(\lambda, x)] = [\gamma_{SFCF}(I_{A,RGB}(x)) \cdot f_L(\lambda)] = [I_A(\lambda, x) \cdot f_L(\lambda)],
$$

(3.5)

and through the right filter, the right eye perceives the color

$$
[I_{AR}(\lambda, x)] = [\gamma_{SFCF}(I_{A,RGB}(x)) \cdot f_R(\lambda)] = [I_A(\lambda, x) \cdot f_R(\lambda)].
$$

(3.6)

For convenience, let's assume that the CIE XYZ tristimulus values of colors $[I_L(\lambda, x)]$, $[I_R(\lambda, x)]$, $[I_A(\lambda, x)]$, $[I_{AL}(\lambda, x)]$, and $[I_{AR}(\lambda, x)]$ are

$$
\begin{align*}
I_{L,XYZ}(x) &= [I_{L,XYZ,R}(x) \ I_{L,XYZ,G}(x) \ I_{L,XYZ,B}(x)], \\
I_{R,XYZ}(x) &= [I_{R,XYZ,R}(x) \ I_{R,XYZ,G}(x) \ I_{R,XYZ,B}(x)], \\
I_{A,XYZ}(x) &= [I_{A,XYZ,R}(x) \ I_{A,XYZ,G}(x) \ I_{A,XYZ,B}(x)], \\
I_{AL,XYZ}(x) &= [I_{AL,XYZ,R}(x) \ I_{AL,XYZ,G}(x) \ I_{AL,XYZ,B}(x)], \\
I_{AR,XYZ}(x) &= [I_{AR,XYZ,R}(x) \ I_{AR,XYZ,G}(x) \ I_{AR,XYZ,B}(x)].
\end{align*}
$$

(3.7)

Ideally, if the left and right perceived colors $[I_{AL}(\lambda, x)]$ and $[I_{AR}(\lambda, x)]$ are identical to the ideal colors $[I_L(\lambda, x)]$ and $[I_R(\lambda, x)]$ respectively, then we have a perfect 3D perception. This is, in fact, impossible to achieve as shall be proved in the next section.

### 3.2.1.1 Conditions for the colored-filtered glasses to perceive 3D perception

Obviously, the color $[I_{AL}(\lambda, x)]$ has to be different from $[I_{AR}(\lambda, x)]$ at least at some points $x$; otherwise, both eyes will see the same image, thus destroying the binocular vision principle. In order for $[I_{AL}(\lambda, x)]$ to be different from $[I_{AR}(\lambda, x)]$, from Equations 3.5 and 3.6, the
absorption curve \( f_L(\lambda) \) has to be different from \( f_R(\lambda) \). Furthermore, due to the parallax in the stereoscopic image pair, it requires that at some locations the luminance of \([I_{AL}(\lambda, x)]\) must be greater than that of \([I_{AR}(\lambda, x)]\), and vice-versa [16]. For example, the left ICIP stereo image (Figure B.2) is dark at the pixel \( x(862, 666) \) in the interesting region ICIP1 (Figure B.5(a)) while the right ICIP stereo image has high luminance at this point. This implies that the absorption curves \( f_L(\lambda) \) and \( f_R(\lambda) \) must have some non-overlap bands and satisfy the following conditions

\[
\begin{align*}
&f_L(\lambda) > 0 \text{ and } f_R(\lambda) > 0 \quad \text{if} \ \lambda \in B_O, \\
&f_L(\lambda) \approx 0 \text{ and } f_R(\lambda) \approx 0 \quad \text{if} \ \lambda \in B_E, \\
&f_L(\lambda) > 0 \text{ and } f_R(\lambda) \approx 0 \quad \text{if} \ \lambda \in B_L, \\
&f_L(\lambda) \approx 0 \text{ and } f_R(\lambda) > 0 \quad \text{if} \ \lambda \in B_R,
\end{align*}
\]

(3.8)

where \( B_O \cap B_E \cap B_L \cap B_R = 0 \) and \( B_O \cup B_E \cup B_L \cup B_R = [\lambda_{\text{min}}, \lambda_{\text{max}}] \). We refer to the bands \( B_L \) and \( B_R \) as independent bands. For example, for the red (on the left eye) and cyan (on the right eye) colored-filter glass pair whose absorption curves are shown in Figure 2.5, the band \( B_L \) is \([590 \text{ nm}, 700 \text{ nm}]\) and the band \( B_R \) is \([400 \text{ nm}, 590 \text{ nm}]\), while the bands \( B_O \) and \( B_E \) can be considered as overlap and empty respectively. Thus, to have, for example, low luminance in \([I_{AL}(\lambda, x)]\) and high luminance in \([I_{AR}(\lambda, x)]\) (in the case of the example above) then the PDS \( I_A(\lambda, x) \) has to be chosen such that it has low power in \( B_L \) and high power in \( B_R \).

The effect of the band \( B_E \) would be on the left and right filter gamuts. As \( B_E \) increases, the two filter gamuts will be reduced. Therefore, we would like to have \( B_E \) to be empty. To see the effect of the PDSs in the bands \( B_O, B_L, \) and \( B_R, \) let us compute \( I_{AL,XYZ,Y}(x) \) and \( I_{AR,XYZ,Y}(x) \) as

\[
I_{AL,XYZ,Y}(x) = \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} I_A(\lambda, x) \cdot f_L(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda
= \int_{\lambda \in B_O} I_{A,B_O}(\lambda, x) \cdot f_L(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda + \int_{\lambda \in B_L} I_{A,B_L}(\lambda, x) \cdot f_L(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda,
\]

(3.9)

\[
I_{AR,XYZ,Y}(x) = \int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} I_A(\lambda, x) \cdot f_R(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda
= \int_{\lambda \in B_O} I_{A,B_O}(\lambda, x) \cdot f_R(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda + \int_{\lambda \in B_R} I_{A,B_R}(\lambda, x) \cdot f_R(\lambda) \cdot \frac{\mathbf{g}(\lambda)}{\mathbf{g}(\lambda)} \cdot d\lambda,
\]

(3.10)

where \( I_{A,B_O}(\lambda, x) = \begin{cases} I_A(\lambda, x) & \text{if} \ \lambda \in B_O \\ 0 & \text{if} \ \lambda \notin B_O \end{cases} \). Similar expressions hold for \( I_{A,B_L}(\lambda, x) \) and \( I_{A,B_R}(\lambda, x) \). From the two Equations 3.9 and 3.10, as \( I_{A,B_O}(\lambda, x) \) increases the luminances of
the colors perceived in both eyes also increase. Therefore, the PDS \( I_A(\lambda, x) \) effects on the colors that perceived by both eyes. In order for \( I_{AL,XYZ,Y}(x) \) to be adjusted independently with \( I_{AR,XYZ,Y}(x) \) and vice versa, we need the device \( \mathfrak{D} \) to be able to adjust \( I_{A,B_L}(\lambda, x) \) independently with \( I_{A,B_R}(\lambda, x) \) and vice versa. This condition often does not hold for many color output devices since the PDS \( I_A(\lambda, x) \) tends to be broad, as in the case of the EPSON printer (Chapter 6).

### 3.2.1.2 Generic anaglyph algorithm

Given a colored-filter pair that satisfies the conditions in Equation 3.8, an anaglyph algorithm can be seen as two mapping functions in which one maps \([I_L(\lambda, x)]\) to \([I_{AL}(\lambda, x)]\) and the other one maps \([I_R(\lambda, x)]\) to \([I_{AR}(\lambda, x)]\). Due to the properties of the absorption curves \(f_L(\lambda)\) and \(f_R(\lambda)\), the left and right filter gamuts are different from each other and also different from and smaller than the original device gamut. Furthermore, let \([I_L(\lambda, x_1)]\) and \([I_R(\lambda, x_2)]\) be a correspondent pair (Section 3.1.1) so that \(I_L(\lambda, x_1) \boxplus I_R(\lambda, x_2)\). Through the anaglyph algorithm, the color \([I_L(\lambda, x_1)]\) is mapped to \([I_{AL}(\lambda, x_1)]\) and \([I_R(\lambda, x_2)]\) is mapped to \([I_{AR}(\lambda, x_2)]\). If we assume that the dichoptic color mixture can be modeled by a function \(\Upsilon_{\text{Dichoptic}}(\cdot)\) then the dichoptic color mixture that we perceive is

\[
[I_{A,\text{Dichoptic}}] = \Upsilon_{\text{Dichoptic}}([I_{AL}(\lambda, x_1)], [I_{AR}(\lambda, x_2)]),
\]

and we would like \([I_{A,\text{Dichoptic}}] \boxplus I_L(\lambda, x_1) \boxplus I_R(\lambda, x_2)\). One trivial case for this to happen is that \(I_L(\lambda, x_1) \boxplus I_{AL}(\lambda, x_1)\) and \(I_R(\lambda, x_2) \boxplus I_{AR}(\lambda, x_2)\). However, this trivial case is not possible due to the conditions of colored-filter glasses. We can only make \(I_{A,\text{Dichoptic}}\) close to \([I_L(\lambda, x_1)]\) and hence this introduces color distortions. The function \(\Upsilon_{\text{Dichoptic}}(\cdot)\) can be derived from the two mapping functions.

### 3.2.1.3 Anaglyph quality factors

As discussed in Section 3.1.2, not all pairs of two distinct colors will give a third stable perceived color, and thus the mapping not only has to ensure that the dichoptic color mixture \([I_{A,\text{Dichoptic}}]\) is as close as possible to \([I_L(\lambda, x_1)]\) to reduce the color distortion, but also should give a dichoptic color mixture \([I_{A,\text{Dichoptic}}]\) that is stable. Also due to the dependency between the PDS \(I_{A,B_L}(\lambda, x)\) and the PDS \(I_{A,B_R}(\lambda, x)\), the anaglyph suffers to the ghosting effect (or crosstalk), in which partial information of the left image leaks into the right eye and vice-versa.

The ghosting effect and the rivalry effect will cause a degradation in the 3D effect, whereas
the color distortion will control the color fidelity (the set of colors that can be perceived through dichoptic color mixing phenomenon) of the perceived 3D scene. Thus the quality of an anaglyph stereoscopic system can be judged based on these three aspects, referred to as three anaglyph quality factors: ghosting effect, color stability, and color fidelity.

3.2.2 Anaglyph design problems

There are three design problems for an anaglyph stereoscopic display system: (1) For a given color output device, what are the best absorption curves \( f_L(\lambda) \) and \( f_R(\lambda) \), (2) For given absorption curves \( f_L(\lambda) \) and \( f_R(\lambda) \), what is the best color output device, and (3) For given color output device and absorption curves \( f_L(\lambda) \) and \( f_R(\lambda) \), what is the best mapping function to minimize the ghosting and color rivalry effect while increasing the perceived color fidelity. In this study, we mainly focused on the third problem. No literature that addresses the problems 1 and 2 has been found. In any case, the solution depends on the solution to problem 3.

3.3 Test stereo image pairs

In order to test different anaglyph algorithms, three different stereo image pairs were chosen, as shown in Appendix B. They are REDCAR, ICIP, and BEAR stereo image pairs. Each of the pairs has interesting regions that we want to pay particular attention to.

3.4 Overview of common colored-filter glasses

Even though no formulation has been developed for finding the best filter pair, in practice, the colored-filter glasses are chosen empirically. For a given CRT display, the red phosphor PDS \( R_{max}[\lambda, x] \) is mostly concentrated in the range of \([-600 \text{ nm}, 700 \text{ nm}]\). Similarly, the green and blue phosphor PDSs \( G_{max}[\lambda, x] \) and \( B[\lambda, x] \) mostly concentrate in the range of \([-500 \text{ nm}, -600 \text{ nm}] \) and \([400 \text{ nm}, -500 \text{ nm}]\) respectively. Thus to minimize the ghosting effect on a CRT display, the absorption curves \( f_L(\lambda) \) and \( f_R(\lambda) \) can be chosen such that the band \( B_L = [-600 \text{ nm}, 700 \text{ nm}] \) and \( B_R = [400 \text{ nm}, -600 \text{ nm}] \) (also called red-cyan filters, as shown in Figure 2.5) or \( B_L = [-500 \text{ nm}, -600 \text{ nm}] \) and \( B_R = [400 \text{ nm}, -500 \text{ nm}] \cup [-600 \text{ nm}, 700 \text{ nm}] \) (also called as green-magenta filters) or \( B_L = [500 \text{ nm}, -700 \text{ nm}] \) and \( B_R = [-400 \text{ nm}, 500 \text{ nm}] \) (also referred to as yellow-blue filters, as illustrated in Figure 3.3). In these cases the bands \( B_O \) and \( B_E \) are 0.
The choice of which pair out of these three filter pairs above should be used depends on applications. As pointed out by Sorensen et al. [17], yellow-blue filter pairs often give a very large range of the dichoptic color mixture $[I_{A,(X)(m)}}$ at the expense of strong imbalance between the luminances of $[I_{A(L}(\lambda, x)]$ and $[I_{A(R}(\lambda, x)]$. Green-magenta filter pairs often give the best in term of luminance balance between the left and right views. Red-cyan filter pairs often give better left right luminance balance but the range of the dichoptic color mixture $[I_{A,(X)(m)}}$ tends to be small.

### 3.5 Overview of existing ghosting effect measurements

As mentioned, the ghosting effect is the result of the correlation between $[I_{A(L}(\lambda, x)]$ and $[I_{A(R}(\lambda, x)]$. Woods et al. [18] provided a simple ghosting analysis to quantitatively calculate this correlation. For a given particular CRT display and a particular colored-filter glass (the red-cyan filters used in this paper), the amount of ghosting can be calculated by first displaying the red spectrum at its maximum intensity (by setting the input $d = (1, 0, 0)$) and then through the cyan filter measuring the area under the attenuated PDS, denoted as $A_{Red,Cyan-Filter},$ as well as through the red filter measuring the area under the attenuated PDS curve, denoted as $A_{Red,Red-Filter}.$

Similarly displaying the cyan spectrum at its maximum intensity (by setting $d = (0, 1, 1)$) and then through the red filter measuring the area under the attenuated PDS curve, denoted as $A_{Cyan,Red-Filter},$ and through the cyan filter measuring the area under the attenuated PDS curve, denoted as $A_{Cyan,Cyan-Filter}.$ Then finally, the percentage of the ratio $A_{Cyan,Red-Filter}/A_{Red,Red-Filter}$ is the percentage of the amount of leaking information from the right stereo image into the left eye (with the red filter) and similarly the percentage of the ratio $A_{Red,Cyan-Filter}/A_{Cyan,Cyan-Filter}$ is the percentage of the amount of leaking information from the left stereo image into the right eye (with the cyan filter).

### 3.6 Overview of existing anaglyph algorithms

Not many anaglyph algorithms have been developed and most of them are very empirical [16]. To the best of my knowledge, all the known existing anaglyph algorithms are developed for CRT displays. The following subsections are the overviews of each existing anaglyph algorithms designed for a CRT display $\mathcal{D}$. We assume this CRT has the transformation matrices $A_L$ for the left filter, $A_R$ for the right filter, and the transformation matrix $A$ (Section 2.3).
3.6.1 Photoshop algorithm

The most popular algorithm for rendering an anaglyph image is the so-called “Photoshop algorithm” which is described in detail by Turnmidge et al. [19]. In the Photoshop algorithm, one of the coefficients in the input \( \mathbf{I}_{A,RGB}(x) \) is taken from the input \( \mathbf{I}_{L,RGB}(x) \) and the remaining two coefficients are taken from the input \( \mathbf{I}_{R,RGB}(x) \). If the colored-filter pair glasses are red-cyan filters, then the input \( \mathbf{I}_{A,RGB}(x) \) can be established in matrix notation as

\[
\begin{bmatrix}
\mathbf{I}_{A,RGB,R}(x) \\
\mathbf{I}_{A,RGB,G}(x) \\
\mathbf{I}_{A,RGB,B}(x)
\end{bmatrix} =
\begin{bmatrix}
1 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 1 \\
0 & 0 & 0 & 0 & 1
\end{bmatrix}
\begin{bmatrix}
\mathbf{I}_{L,RGB,R}(x) \\
\mathbf{I}_{L,RGB,G}(x) \\
\mathbf{I}_{L,RGB,B}(x) \\
\mathbf{I}_{R,RGB,R}(x) \\
\mathbf{I}_{R,RGB,G}(x) \\
\mathbf{I}_{R,RGB,B}(x)
\end{bmatrix} =
\begin{bmatrix}
\mathbf{I}_{L,RGB,R}(x) \\
\mathbf{I}_{L,RGB,G}(x) \\
\mathbf{I}_{L,RGB,B}(x) \\
\mathbf{I}_{R,RGB,R}(x) \\
\mathbf{I}_{R,RGB,G}(x) \\
\mathbf{I}_{R,RGB,B}(x)
\end{bmatrix}.
\]

Similarly, for green-magenta filters the anaglyph input \( \mathbf{I}_{A,RGB}(x) \) is

\[
\begin{bmatrix}
\mathbf{I}_{A,RGB,R}(x) \\
\mathbf{I}_{A,RGB,G}(x) \\
\mathbf{I}_{A,RGB,B}(x)
\end{bmatrix} =
\begin{bmatrix}
\mathbf{I}_{L,RGB,R}(x) \\
\mathbf{I}_{L,RGB,G}(x) \\
\mathbf{I}_{R,RGB,R}(x) \\
\mathbf{I}_{R,RGB,G}(x) \\
\mathbf{I}_{R,RGB,B}(x)
\end{bmatrix},
\]

and for yellow-blue filters the anaglyph input \( \mathbf{I}_{A,RGB}(x) \) is

\[
\begin{bmatrix}
\mathbf{I}_{A,RGB,R}(x) \\
\mathbf{I}_{A,RGB,G}(x) \\
\mathbf{I}_{A,RGB,B}(x)
\end{bmatrix} =
\begin{bmatrix}
\mathbf{I}_{L,RGB,R}(x) \\
\mathbf{I}_{L,RGB,G}(x) \\
\mathbf{I}_{R,RGB,R}(x) \\
\mathbf{I}_{R,RGB,G}(x) \\
\mathbf{I}_{R,RGB,B}(x)
\end{bmatrix}.
\]

Clearly, the Photoshop algorithm doesn’t take the absorption curves of the filters into the production process. A derived version of the Photoshop algorithm would be to replace \( \mathbf{I}_{L,RGB,R}(x) \) by the grayscale of the left view for red-cyan filters as

\[
\begin{bmatrix}
\mathbf{I}_{A,RGB,R}(x) \\
\mathbf{I}_{A,RGB,G}(x) \\
\mathbf{I}_{A,RGB,B}(x)
\end{bmatrix} =
\begin{bmatrix}
0.299 & 0.587 & 0.114 \\
0 & 0 & 0 \\
0 & 0 & 0
\end{bmatrix}
\begin{bmatrix}
\mathbf{I}_{L,RGB,R}(x) \\
\mathbf{I}_{L,RGB,G}(x) \\
\mathbf{I}_{L,RGB,B}(x) \\
\mathbf{I}_{R,RGB,R}(x) \\
\mathbf{I}_{R,RGB,G}(x) \\
\mathbf{I}_{R,RGB,B}(x)
\end{bmatrix}.
\]
There are many free and shareware programs that render anaglyph images from stereo image pairs, including StereoPhotoMaker [20], AnaMaker [21], AnaBuilder [22]. Although there is usually no explicit indication of what anaglyph algorithm is used in these programs, the anaglyph images generated from the first two programs are very close to the ones generated from the Photoshop method implemented in MATLAB. This suggests that these two programs use the Photoshop algorithm while AnaBuilder implements the LP method which will be discussed in a later section.

The resulting anaglyph images of the three test stereo image pairs rendered by the Photoshop method are shown in Section C.5. All three anaglyph images for red-cyan filters show strong color rivalry overall (e.g. in the interesting region REDCAR2), since it doesn’t replace the red-like colors by more stable colors as in the LP method.

3.6.2 Midpoint algorithm

The anaglyph Midpoint algorithm [23] computes in the CIELAB color space a point \( O \) which is the midpoint of the line joining the two colors \( \mathbf{I}_{LL,XYZ}(x) \) and \( \mathbf{I}_{RR,XYZ}(x) \) where

\[
\begin{align*}
\mathbf{I}_{LL,XYZ}^L(x) &= \mathbf{A}_L \cdot \mathbf{I}_{L,RGB}^L(x), \\
\mathbf{I}_{RR,XYZ}^R(x) &= \mathbf{A}_R \cdot \mathbf{I}_{R,RGB}^R(x).
\end{align*}
\]  

First, transform \( \mathbf{I}_{LL,XYZ}(x) \) and \( \mathbf{I}_{RR,XYZ}(x) \) from the CIE XYZ color space to the CIELAB color space by using Equation 2.21 with \( \mathbf{D65} \) as the reference white point to obtain

\[
\begin{align*}
\mathbf{I}_{LL,Lab}(x) &= \begin{bmatrix}
I_{LL,Lab,L}(x) & I_{LL,Lab,a}(x) & I_{LL,Lab,b}(x)
\end{bmatrix}, \\
\mathbf{I}_{RR,Lab}(x) &= \begin{bmatrix}
I_{RR,Lab,L}(x) & I_{RR,Lab,a}(x) & I_{RR,Lab,b}(x)
\end{bmatrix}.
\end{align*}
\]  

Then the color point \( O \) in CIELAB space is

\[
\mathbf{I}_{A,Lab}(x) = (\mathbf{I}_{L,Lab}(x) + \mathbf{I}_{R,Lab}(x))/2.
\]  

Finally, convert \( \mathbf{I}_{A,Lab}(x) \) back to \( \mathbf{I}_{A,XYZ}(x) \) and then \( \mathbf{I}_{A,RGB}(x) = \mathbf{A}^{-1} \cdot \mathbf{I}_{A,XYZ}(x) \).

The resulting anaglyph images of the three test stereo image pairs rendered by the Midpoint method are shown in Section C.6. The BEAR and ICIP anaglyph images for red-cyan filters show very strong ghosting effect which completely destroy the 3D perception. The results are very poor.
3.6.3 Linear Projection algorithm

Dubois [16] proposed a new approach for obtaining an anaglyph image. This method is referred to here as the Linear Projection (LP) method. In the ideal case, we would like the left eye to see the color \([I_L(\lambda, x)]\) and the right eye to see the color \([I_R(\lambda, x)]\). The CIE XYZ tristimulus values of these colors can be computed in matrix notation as

\[
I_{L,XYZ}(x)^T = A \cdot I_{L,RGB}(x)^T, \\
I_{R,XYZ}(x)^T = A \cdot I_{R,RGB}(x)^T. 
\]  
(3.19)

Arranging Equation 3.19 we have

\[
\begin{bmatrix}
I_{L,XYZ}(x)^T \\
I_{R,XYZ}(x)^T
\end{bmatrix} =
\begin{bmatrix}
A & 0 \\
0 & A
\end{bmatrix}
\begin{bmatrix}
I_{L,RGB}(x)^T \\
I_{R,RGB}(x)^T
\end{bmatrix} = A_2 \cdot V(x),
\]

where

\[
A_2 = \begin{bmatrix}
A & 0 \\
0 & A
\end{bmatrix}, \quad 0 = \begin{bmatrix}
0 & 0 & 0 \\
0 & 0 & 0
\end{bmatrix},
\]

\[(3.20)\]

\[
V(x) = \begin{bmatrix}
I_{L,RGB}(x)^T \\
I_{R,RGB}(x)^T
\end{bmatrix}.
\]

However, with an anaglyph system the left eye would see \([I_{AL}(\lambda, x)]\) and the right eye see \([I_{AR}(\lambda, x)]\), and the CIE XYZ tristimulus values of these two colors can be computed in matrix notation as

\[
I_{AL,XYZ}(x)^T = A_L \cdot I_{A,RGB}(x)^T, \\
I_{AR,XYZ}(x)^T = A_R \cdot I_{A,RGB}(x)^T. 
\]  
(3.31)

Again by rearranging the equation above

\[
\begin{bmatrix}
I_{AL,XYZ}(x)^T \\
I_{AR,XYZ}(x)^T
\end{bmatrix} =
\begin{bmatrix}
A_L & 0 \\
0 & A_R
\end{bmatrix}
\begin{bmatrix}
I_{A,RGB}(x)^T
\end{bmatrix} = R \cdot I_{A,RGB}(x)^T,
\]

\[
R = \begin{bmatrix}
A_L & 0 \\
0 & A_R
\end{bmatrix}.
\]  
(3.22)

The main objective here is to find \(I_{A,RGB}(x)\) such that \([I_{AL}(\lambda, x)]\) and \([I_{AR}(\lambda, x)]\) are as similar as possible to \([I_L(\lambda, x)]\) and \([I_R(\lambda, x)]\), respectively. In other words, we want the color distances between \([I_{AL}(\lambda, x)]\), \([I_L(\lambda, x)]\) and between \([I_{AR}(\lambda, x)]\), \([I_R(\lambda, x)]\) to be minimal (Figure 3.2). The LP’s author chose the Euclidean distance in CIE XYZ color space (Equation 2.18) as the error metric. Therefore, the optimization problem can be stated as finding the
The LP algorithm tries to find the total shortest distances between points 1, 3 and points 2, 4. (Background chromaticity diagram generated using software of from [2])

The solution for this optimization problem can be obtained by using the projection theorem [24]. The matrix $V(x)$ can be seen as a vector in the six-dimensional space $S_6$ which has the six column-vectors of the matrix $A_2$ as basis vectors. Similarly, the matrix $I_{A,RGB}(x)$ is a vector in the three-dimensional $S_3$ with the three column-vectors of the matrix $R$ as basis vectors. The space $S_3$ is a subspace of $S_6$. From the projection theorem, the optimal vector $I_{A,RGB}(x)$ can be obtained by projecting the vector $V(x)$ onto subspace $S_3$ and the result is

$$I_{A,RGB}(x)^T = (R^T W R)^{-1} \cdot R^T W A_2 \cdot V(x),$$

where $W$ is a $6 \times 6$ positive-definite weight matrix. The resulting coefficients in $I_{A,RGB}(x)$ are not in the range of $[0, 1]$ but often greater than 1. This is because the luminances of $[I_{AL}(\lambda, x)]$ and $[I_{AR}(\lambda, x)]$ are attenuated by the filters. The projection method in fact tries to compensate this attenuation by increasing $I_{A,RGB}(x)$. However, the CRT can only generate
the maximum luminance when the input is [1, 1, 1] thus we need to normalize $I_{A,RGB}(x)$ to bring each component into the range of [0, 1]. The simple clipping normalization does not work well. The paper [16] suggested that $I_{A,RGB}(x)$ can be normalized according to the white point. Let

$$E = [E_R \ E_G \ E_B]^T = (R^TWR)^{-1} \cdot R^TWA_2 \cdot [1 \ 1 \ 1 \ 1 \ 1 \ 1]^T \quad (3.25)$$

be the result of applying the raw projection algorithm 3.24 to a white point in both left and right original colors. Then we set

$$I_{A,RGB}(x)^T = N \cdot (R^TWR)^{-1} \cdot R^TWA_2 \cdot V(x) = B \cdot V(x),$$

so that [1 1 1 1 1 1] maps to [1 1 1]. Finally, we clip any out of the range [0, 1] components in $I_{A,RGB}(x)$. In the case of the EIZO CRT monitor with the red-cyan filters, the resulting matrices $A_L$, $A_R$, $A$, $B$, and $N$ are:

$$A_L = \begin{bmatrix} 0.1802 & 0.0243 & 0.0095 \\ 0.0797 & 0.0150 & 0.0030 \\ 0.0008 & 0.0020 & 0.0275 \end{bmatrix}, \quad A_R = \begin{bmatrix} 0.0138 & 0.0999 & 0.1892 \\ 0.0208 & 0.3533 & 0.0865 \\ 0.0317 & 0.1271 & 1.0464 \end{bmatrix},$$

$$A = \begin{bmatrix} 0.3303 & 0.3255 & 0.2708 \\ 0.1848 & 0.6967 & 0.1184 \\ 0.0422 & 0.1603 & 1.4109 \end{bmatrix}, \quad N = \begin{bmatrix} 0.1671 & 0 & 0 \\ 0 & 0.4108 & 0 \\ 0 & 0 & 0.8600 \end{bmatrix}, \quad (3.27)$$

$$B = \begin{bmatrix} 0.3224 & 0.4951 & 0.2534 & -0.0121 & -0.0472 & -0.0115 \\ -0.0436 & -0.0616 & -0.0460 & 0.2847 & 0.8588 & 0.0077 \\ -0.0393 & -0.0606 & 0.0017 & -0.0009 & -0.0614 & 1.1605 \end{bmatrix}.$$

The introduction of the white-point normalization vector $N$ and the final clipping action cause the anaglyph input $I_{A,RGB}(x)$ to no longer be the optimal solution of the objective function 3.23 (Note that this white-point normalization is different with the spectral white point normalization in Section 2.2.3).

The resulting anaglyph images of the three test stereo image pairs rendered by the LP method, where the matrix $W$ is a $6 \times 6$ identity matrix, are shown in Section C.7. Overall it is very comfortable to view all three anaglyph images for red-cyan filters. All the red-like colors in the original REDCAR (e.g. the interesting region REDCAR3) are replaced by
dark-yellow-green like colors. This special feature gives better visual comfort in the anaglyph images. However, the perceived 3D image is seen to be greener compare to its original images. The biggest limitation in the LP method is that it suffers from the ghosting effect as represented in all three anaglyph images, especially in the interesting regions REDCAR3 and ICIP1. The LP method so far is the best available in existing anaglyph algorithms.

3.6.4 ColorCode algorithm

Another well known algorithm based on the Photoshop algorithm is presented in Sorensen et al. [17] and is called ColorCode. Instead of using red-cyan filters, ColorCode suggests to use a yellow-blue filter pair whose absorption curves are shown in Figure 3.3. The idea behind the ColorCode method is that if one eye sees a view that retains all the colors while the other eye sees a view that is in monochrome then the fused 3D image is most likely to give a full color range perception. The yellow filter basically allows most of the colors to go through while the blue filter gives a nearly monochrome image; therefore the yellow-blue filters let the observer see most of the colors, and more than other colored-filter glasses. For example, a red color most likely is seen as black if looking through the red-cyan filters but it remains as a red if the yellow-blue filters are used.

For the given yellow-blue filters, the process of producing an anaglyph image by using the ColorCode method basically consists of two steps: (1) applying a linear mapping with matrix
to give an anaglyph image $I_{A,RGB}(x)^T = B \cdot V(x)$ which will have a substantial luminance imbalance between images reaching the observers’ eyes, then (2) perform a color correction process to the anaglyph image $I_{A,RGB}(x)$ just created in the step (1). We can use the commercial software 3D-EASY$^{TM}$ [25] to render anaglyph images for the yellow-blue filters. Even though the ColorCode method offers a larger range in dichoptic color mixtures than typical red-cyan filters, there is one serious drawback: the luminances of the left perceived color and right perceived color are very different and this makes it very uncomfortable to look at, i.e., it has lower visual comfort.

### 3.7 Summary

Through the anaglyph formulation, the quality factors of an anaglyph algorithm consist of color stability (whether the overall perceived dichoptic color mixtures are stable or not), color fidelity (how large is the gamut of the perceived dichoptic color mixtures), and ghosting effect (the leaking of information of one perspective image into the other eye). Four different existing anaglyph algorithms have been overviewed. They are the Photoshop method, Midpoint method, LP method, and ColorCode method. The LP method is considered as the best method among those four methods as its resulting anaglyph images offer a good color stability and color fidelity. However the LP method suffers from the ghosting effect.
CHAPTER

FOUR

Implementation of the CRT monitor and printer SFCF

In this research, we would like to develop an algorithm for rendering anaglyph images which are optimized for a particular output color device type. Due to the popularity, CRT displays and printers are chosen for this study. To test anaglyph algorithms, it is necessary to display the rendered anaglyph images on these chosen devices. In this chapter, we would like to derive the SFCF for a particular CRT display and a printer which we will use for developing and testing new algorithms. Sections 2.2.5 and 2.2.6 provide procedures for characterizing the chosen CRT display and printer, respectively. The models are also tested to ensure their accuracy.

4.1 Apparatus

An Ocean Optics USB2000 spectrometer was used to measure the PDSs of lights emitting from a CRT display or lights reflecting from a printed paper. Each of measured PDSs has 151 discrete wavelength points taken at 2 nm interval between 400 nm and 700 nm. Appendix A shows in detail the usage of the Ocean Optics USB2000 spectrometer.

4.2 CRT monitor

The CRT monitor used in this study is the 21" EIZO FlexScan F980 CRT monitor. It has 0.23mm Dot Pitch and resolution of 1600×1200 pixels. The monitor was driven by a 24-bit video card with no profile installed in a dual Intel CPU workstation running Windows 2000. In this section, we will model the SFCF for this monitor based on steps in Section 2.2.5. First, the monitor was set to a known state which is the default settings provided by the
Figure 4.1 The measured PDSs of the red, green, blue lights at the maximum intensity and the white color. The data was collected by using the Ocean Optics USB2000 spectrometer.

Table 4.1 The xy chromaticities of three primaries of the EIZO CRT monitor.

<table>
<thead>
<tr>
<th></th>
<th>$R_{\text{max}}(\lambda, x)$</th>
<th>$G_{\text{max}}(\lambda, x)$</th>
<th>$B_{\text{max}}(\lambda, x)$</th>
<th>$W(\lambda, x)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x$</td>
<td>0.5786</td>
<td>0.2773</td>
<td>0.1526</td>
<td>0.2647</td>
</tr>
<tr>
<td>$y$</td>
<td>0.3325</td>
<td>0.5880</td>
<td>0.0715</td>
<td>0.2287</td>
</tr>
<tr>
<td>$z$</td>
<td>0.0888</td>
<td>0.1347</td>
<td>0.7739</td>
<td>0.4466</td>
</tr>
</tbody>
</table>

manufacturer (there is a default setting option in the monitor’s menu. When this option is chosen, all the current monitor settings are changed back to manufacture default setting values). This default state has the contrast value of 100% and the simulated temperature of 9300 K. All measurements were carried out in a dark room to reduce the flare effect. During the spectral measurement process, we tried to keep the spectrometer perpendicular to the monitor to minimize angular effects. MATLAB version 7.0 (R14) Service Pack 1 was used to control and display colors on the EIZO CRT monitor. In this study, we would like to skip the temporal stability testing for the monitor by assuming that the characteristic of this monitor would not be changed during the course of the study and hence only a one-time calibration and characterization would be needed.

4.2.1 Implementation of the EIZO CRT monitor SFCF

The model $\Upsilon_{\text{SFCF,CRT}}(\cdot)$ described in Section 2.2.5.2 is used to characterize the EIZO CRT monitor. First, the normalized spectral white-point (Section 2.2.3) $R_{\text{max}}(\lambda, x)$, $G_{\text{max}}(\lambda, x)$, $B_{\text{max}}(\lambda, x)$, and the white color PDS $W(\lambda, x)$ were measured as shown in Figure 4.1 with their xy chromaticity coordinates given in Table 4.1. The CIE XYZ tristimulus values of the white point $W(\lambda, x)$ were $(0.9268, 1.0, 1.5469)$. As we can see, the EIZO’s white point is not
Table 4.2 The normalization values of the EIZO CRT monitor, where i is R, G, or B.

<table>
<thead>
<tr>
<th>i</th>
<th>(i_{\text{max,}Y,\text{Norm}})</th>
<th>(i_{\text{max,}Y})</th>
<th>(i_{\text{max,}Y,\text{Norm}}/i_{\text{max,}Y})</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>0.1891</td>
<td>0.2057</td>
<td>0.9196</td>
</tr>
<tr>
<td>G</td>
<td>0.6875</td>
<td>0.7230</td>
<td>0.9509</td>
</tr>
<tr>
<td>B</td>
<td>0.1234</td>
<td>0.1272</td>
<td>0.9699</td>
</tr>
</tbody>
</table>

Figure 4.2 The white point normalized PDSs of the red, green, blue lights at the maximum intensity.

D65. From Equation 2.37, the values \(R_{\text{max,}Y,\text{Norm}}, G_{\text{max,}Y,\text{Norm}},\) and \(B_{\text{max,}Y,\text{Norm}}\) are given in Table 4.2. The resulting normalized matrix \(A\) in Equation 2.40 is

\[
A = \begin{bmatrix}
0.3291 & 0.3243 & 0.2634 \\
0.1891 & 0.6875 & 0.1234 \\
0.0505 & 0.1575 & 1.3389
\end{bmatrix}. \tag{4.1}
\]

The normalized spectra \(R_{\text{max,}Y,\text{Norm}}(\lambda, x), G_{\text{max,}Y,\text{Norm}}(\lambda, x),\) and \(B_{\text{max,}Y,\text{Norm}}(\lambda, x)\) are shown in the Figure 4.2.

The next step is to derive the calibration function. All three calibration models in Section 2.2.5.1 were implemented and tested. For each channel, for instance the red channel, ten PDS measurements were made, corresponding to the inputs \(R' = 255, 229, 204, 178, 153, 127, 102, 76, 51,\) and 25, while the other corresponding values of \(G'\) and \(B'\) were set to 0. In this way, a total of thirty PDSs were measured. Following Sections 2.2.5.1.1 and 2.2.5.1.2, the gain and the gamma values were calculated and are shown in the Table 4.3. Here, we used the MATLAB “fminimax” routine (Section 6.3) as the optimization method with CIELAB CIE-94 as the color distance metric.
Table 4.3 The gain and gamma values in the Simple gamma-correction and the GOG gamma-correction model for the EIZO CRT monitor.

<table>
<thead>
<tr>
<th>Model</th>
<th>$\gamma_R$</th>
<th>$\gamma_G$</th>
<th>$\gamma_B$</th>
<th>$k_{g,R}$</th>
<th>$k_{g,G}$</th>
<th>$k_{g,B}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>1.7959</td>
<td>1.9113</td>
<td>1.9104</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>GOG</td>
<td>1.7959</td>
<td>1.9108</td>
<td>1.8477</td>
<td>1.0</td>
<td>1.0</td>
<td>1.013</td>
</tr>
</tbody>
</table>

Table 4.4 The performance of three different gamma-correction models applied for the EIZO CRT monitor.

<table>
<thead>
<tr>
<th>Model</th>
<th>Spectral RMS</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean ($\times 10^{-2}$)</td>
<td>Max ($\times 10^{-2}$)</td>
<td>Std. dev. ($\times 10^{-2}$)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simple</td>
<td>0.0534</td>
<td>0.1114</td>
<td>0.0298</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GOG</td>
<td>0.0530</td>
<td>0.1114</td>
<td>0.0305</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ITU 709</td>
<td>0.0640</td>
<td>0.1279</td>
<td>0.0347</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Model | $\Delta E_{94}$ | Mean | Max | Std. dev. | | |
|-------|-----------------|------|-----|----------| | |
| Simple | 1.3891 | 7.3280 | 1.0 | | |
| GOG | 1.3521 | 6.4270 | 1.0439 | | |
| ITU 709 | 1.1849 | 3.2824 | 0.5279 | | |

4.2.2 Model accuracy test for the EIZO CRT monitor

Once $\gamma_{\text{SFCF,CRT}}(\cdot)$ was obtained, we tested it to determine the accuracy of the obtained function. A patch of 50 gamma-corrected inputs $d'_{\text{Test}}$ where each has coefficients ($R'_{\text{Test}}$, $G'_{\text{Test}}$, $B'_{\text{Test}}$) were displayed on the EIZO CRT monitor and their PDSs were measured. At the same time, the estimated PDSs versions of those test inputs could be obtained by first using each of the gamma-correction models to invert those values into non-gamma-corrected values ($R_{\text{Test}}$, $G_{\text{Test}}$, $B_{\text{Test}}$), and then applying Equation 2.39 on these non-gamma-corrected inputs to get the estimated PDSs. The errors between the measured PDSs and the estimated PDSs tell us the accuracy of the SFCF and the gamma-correction models. Both of the color distance metrics CIELAB CIE-94 and the spectral RMS (root-mean-square) were used as the error metric. The spectral RMS is defined as

$$RMS = \sqrt{\frac{\sum_{i=1}^{151} (C_{\text{Estimated}}[\lambda_i] - C_{\text{Measured}}[\lambda_i])^2}{151}}.$$  

These fifty test gamma-corrected inputs were randomly drawn from a uniform density. Table
4.4 gives the error results. We can see that, the GOG model gives the best accuracy in terms of the difference between the measured spectrum and the estimated spectrum. Since what we want is SFCF, therefore, we will use the GOG gamma-correction model as the gamma-correction model for the EIZO CRT monitor.

4.2.3 The effect of the colored-filter glasses on the EIZO CRT monitor

With the normalized PDSs of the primaries of the EIZO CRT monitor obtained, based on Section 2.3.1 the effect of the colored-filter glasses on this monitor can be described by the transformation matrix \( A_{\text{Filter}} \). For example, for a given input displayed on the EIZO CRT monitor, the CIE XYZ tristimulus values of the perceived color through the red and cyan filters whose transmission absorption curves are shown in Figure 2.5 can be calculated by the two matrices \( A_{\text{Red}} \) and \( A_{\text{Cyan}} \), where

\[
A_{\text{Red}} = \begin{bmatrix}
0.1764 & 0.0250 & 0.0110 \\
0.0782 & 0.0152 & 0.0038 \\
0.0010 & 0.0020 & 0.0260
\end{bmatrix},
\]

\[
A_{\text{Cyan}} = \begin{bmatrix}
0.0155 & 0.0987 & 0.1802 \\
0.0241 & 0.3470 & 0.0872 \\
0.0380 & 0.1247 & 0.9937
\end{bmatrix}.
\]

4.3 RGB Printer

The printer used in this research is an EPSON Stylus Photo 2200. It has seven pigment-based colorants: cyan, magenta, yellow, black, light cyan, light magenta, and light black. The resolution can go up to 2880×1440 dpi and the paper size is up to 13” wide×44” long. The chosen paper that was used with the EPSON printer is a high-quality EPSON semigloss photo paper. The Adobe Photoshop 6.0 program was used to control the printing process and the printer’s driver are installed in an Intel workstation running Windows XP Service Pack 2.

4.3.1 EPSON printer characterization implementation

To apply the model-based characterization (Section 2.2.6) on the EPSON printer, we need to be able to access to the seven digital values that control the amount of each colorant that needs to be applied to the paper. However, the driver that goes with the EPSON
printer doesn’t have such a feature. Therefore, to apply a model-based approach we need a custom driver to control printer. This is the approach used in Taplin’s study [26]. However, to simplify the process, we decided to go with the empirical characterization method by treating the whole EPSON printing process as a black box, where its \( T_{SFCF,\text{Printer}}(\cdot) \) needs to be characterized. \( T_{SFCF,\text{Printer}}(\cdot) \) has the input as a set of three signals \( 0 \leq R, G, B \leq 1 \) in sRGB color space and the output is the PDS \( C(\lambda) \) with \( \lambda_{\min} \leq \lambda \leq \lambda_{\max} \).

### 4.3.1.1 The EPSON printing process

The input of the printing process is assumed to be three values \( (R, G, B) \) in sRGB color space. This is because of the popularity of the JPEG format in sRGB. The following steps are applied for the EPSON printer to print an input image (here we assume that Adobe Photoshop and the EPSON printer driver are installed and working properly):

1. Open the image in the Photoshop program.
2. On Photoshop menu, choose Image > Mode > Assign Profile. On the opened dialog, click on the Profile radio button and choose the profile name sRGB IEC61966-2.1. This action in fact is to ensure that the image is in sRGB color space.
3. Choose File > Print Options, and on the opened “Print Options” dialog click the “Page Setup” button.
4. On the opened “Page Setup” dialog, choose the “EPSON Stylus Photo 2200” printer. Then click on the “Properties...” button.
5. On the opened “EPSON Stylus Photo 2200 Properties” dialog, make sure the dialog is in the “Main” tab, then click the “Advanced” button.
6. On the “Paper & Quality Options” area choose these settings: “Premium Semigloss Photo Paper”, “SuperPhoto - 2880dpi”. This step tells the printer to choose the correct paper which is the EPSON photo premium semigloss paper. On the “Color Management” area, check the “ICM” radio button. Then on the ICC Profile, check “No Color Adjustment” radio button. The “No Color Adjustment” option will tell the driver not to apply the color adjustment procedure, since Photoshop will perform the gamut mapping based on the profiles.
7. Click “OK” button to go back to “Print Options” dialog. Check “Show More Options” option and this will extend the “Print Options” dialog.
Table 4.5 The input values in the target chart that has a total of $10 \times 12 \times 7 = 840$ training samples.

<table>
<thead>
<tr>
<th></th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>R</td>
</tr>
<tr>
<td>0</td>
<td>45</td>
</tr>
<tr>
<td>75</td>
<td>50</td>
</tr>
<tr>
<td>100</td>
<td>125</td>
</tr>
<tr>
<td>125</td>
<td>150</td>
</tr>
<tr>
<td>175</td>
<td>200</td>
</tr>
<tr>
<td>200</td>
<td>230</td>
</tr>
<tr>
<td>230</td>
<td>255</td>
</tr>
</tbody>
</table>

8. Choose the “Color Management” option. Make sure that on the “Source Space” area the “Document: sRGB IEC61966-2.1” radio button is checked. On the “Print Space” area choose the “SP2200 Premium Semigloss_PK” on the “Profile” drop off box and choose the “Perceptual” on the “Intent” drop off box. This step chooses the perceptual intent (Section 2.2.4) for the gamut mapping and assigns correct output profile to the printer.

9. Finally, click the “Print” button to print.

4.3.1.2 Determination of the EPSON printer SFCF

Similar to the EIZO CRT monitor, we assume that the characteristics of this EPSON printer do not vary much during the course the study, and that the printer has been pre-calibrated by the manufacturer. This thus allows us to skip the calibration process. As mentioned in Section 2.2.1, the empirical method applies data fitting and interpolation technique on a large enough set of input color samples and measured output samples. In this section, four different interpolation techniques are investigated: polynomial regression, tri-linear interpolation, sequential interpolation, and neural network (Section 2.2.2). At the end we will choose which technique is the best for the EPSON printer.

The input vector $\mathbf{d}_i = [R_i, G_i, B_i]$ for the interpolation has size of $m = 3$, and the size of the output vector $\mathbf{c}_i$ is $n = 151$ corresponding to 151 discrete wavelength points. A patch of $T = 840$ training sample inputs (also referred to as target chart which is included on the attached CD) chosen to lay on a rectangular lattice with the coefficient values of the inputs, as presented in Table 4.5, was generated. By following the EPSON printing process described in Section 4.3.1.1, we first printed the target chart and then measured the reflecting PDSs from each colorant mixture in this printed target chart using the Ocean Optics USB2000 under fixed illuminant light. These reflecting PDSs are further performed the spectral white-point normalization, where the printer white point is the color of the paper (without any colorant mixtures) under the illuminant light and it is in the 840 training sample inputs.
Figure 4.3 The measured PDSs and associated estimated PDSs from order-5 polynomial, trilinear, and sequential for two different inputs (a) RGB=(0.4863, 0.7725, 0.4824) and (b) RGB=(0.6274, 0.1961, 0.8745).

The illuminant light used for this study is commercial 60W incandescent light bulbs. Each of the coefficients in the output vector is modeled independently from the other coefficients. For the polynomial regression technique, the order of 5 was chosen. For the neural network, the three-layer feed-forward structure was chosen with 10 nodes for the first layer, 10 nodes for second layer and 151 nodes for the third layer. Figure 4.3 shows the measured PDS and associated estimated PDSs for each of the interpolation technique (except the neural network).

The accuracy of the model depends on the selection of the input training samples. We want to lay more input sample training points at certain nonlinear regions of the SFCF within the gamut to refine the function. However, we didn’t really know in which regions of the gamut the characteristic function exhibits nonlinear characteristic. So refinement can be done through a multi-stage design, with a rearrangement of the training samples based on the previous modeled SFCF. In this study, we decided not to do the refinement process. Instead, because the HVS seems to more sensitive to the green component than to blue and red components [17], it would be a good idea to have more steps in the green stimulus set. In this study, we didn’t investigate the effect of the number of colors in the target chart used since the accuracy of the model increases as the target chart increases. However this is not a proportional relationship. We felt that 840 test inputs gave a sufficiently large target chart size; in fact the test in the next section shows that the accuracy of the model is very satisfactory.
Figure 4.4 The magnitude of $X$, $Y$, and $Z$ stimulus with different inputs $R$ and $G$ when $B$ is kept constant for the order-5 polynomial model.
Table 4.6 Performance of four different interpolation techniques applied for characterizing the EPSON printer using the spectral RMS error metric and $\Delta E_{94}$.

<table>
<thead>
<tr>
<th>Method</th>
<th>Spectral RMS</th>
<th>$\Delta E_{94}$</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean ($\times 10^{-2}$)</td>
<td>Max ($\times 10^{-2}$)</td>
</tr>
<tr>
<td>order-5 polynomial</td>
<td>0.0327</td>
<td>0.210</td>
</tr>
<tr>
<td>Trilinear</td>
<td>0.0723</td>
<td>0.258</td>
</tr>
<tr>
<td>Sequential</td>
<td>0.0320</td>
<td>0.198</td>
</tr>
<tr>
<td>Neural Network</td>
<td>0.4276</td>
<td>0.938</td>
</tr>
</tbody>
</table>

4.3.2 Model accuracy test

To test the transformation, similar to the test applied to test the EIZO CRT monitor (Section 4.2.2), a different set of 425 selected input colors was used (also called test chart which is included in the attached CD). These test inputs were selected such that each stimulus was drawn randomly from a uniform density. These random inputs may or may not be the same as the training color in the target chart. The PDSs of the colors measured from the printed test chart are compared to the estimated PDSs by using the spectral RMS error metric (Equation 4.2) and the CIELAB CIE-94 $\Delta E_{94}$ error metric (Equation 2.22).

Table 4.6 gives the resulting errors in terms of mean, max, and standard deviation of both the RMS and $\Delta E_{94}$ error metrics. Giorgianni et al. [1, pg.360] reported $\Delta E_{94} = 1.8$ for the CMYK Xerox Docucolor 12 laser printer using the sequential interpolation method. This result strengthens our confidence about the accuracy of the whole modeling process as we got $\Delta E_{94} = 1.63$ for our sequential model. Clearly as one can see, the sequential interpolation technique is the most accurate model as we expected. However, the biggest drawback of sequential interpolation is in its slow speed. It is much slower than the second best model, the order-5 polynomial model. The resulting error of the order-5 polynomial model remains in the acceptable range. As a result of this test, we decided to choose the polynomial model for our study.

The order of the polynomial also affects the accuracy of the model. Table 4.7 shows the performance of the polynomial model when the order is 4, 5, and 6 based on the spectral
Table 4.7 Performance of the polynomial technique with different order values based on the spectral RMS error metric.

<table>
<thead>
<tr>
<th>Polynomial order</th>
<th>Spectral RMS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean ($\times 10^{-2}$)</td>
</tr>
<tr>
<td>4</td>
<td>0.0416</td>
</tr>
<tr>
<td>5</td>
<td>0.0327</td>
</tr>
<tr>
<td>6</td>
<td>0.0459</td>
</tr>
</tbody>
</table>

RMS error metric. We conclude that the polynomial order of 5 is the best model and will be used in this study.

4.3.3 The effect of the colored-filter glass

Unlike the monitor, where the effect of the colored-filter glasses can be represented by a simple 3×3 matrix, the CIE XYZ tristimulus values of the light reflecting from a paper and going through an colored-filter glass $S(\lambda)$ can be estimated as follows: first estimate the reflecting light $S(\lambda)$ from the given input RGB tristimulus using the order-5 polynomial model described in the previous section, and then multiply this spectrum with the filter absorption curve $f(\lambda)$, and finally calculate the CIE XYZ tristimulus values from this estimated spectrum.

4.4 Summary

The CRT display and printer used in the study are the EIZO CRT monitor and the EPSON Stylus Photo 2200 printer. Their SFCFs were implemented and tested. With the EIZO CRT monitor, its SFCF is the model-based. We chose the GOG model as its gamma-correction function. With the EPSON printer, its SFCF is based on the empirical method. As the results of the accuracy test, we concluded that the order-5 polynomial gives the best result in terms of the accuracy and execution time. The details of the implementations are given in this chapter.
CHAPTER
FIVE

Development of an anaglyph algorithm for additive displays

The intention of this chapter is to find an anaglyph method that renders anaglyph images optimized for displaying on a CRT display with better 3D perception than previous methods. During the research, many techniques have been tried but none of them has shown a strong improvement over the LP method in terms of the color stability and color fidelity. A simple experiment was set up to help us to conclude that it is unlikely that we can do any better than the LP method in terms of color stability and color fidelity. So rather than concentrating on improving the color fidelity, we focused on the ghosting effect which leads us to a new method for reducing the ghosting effect. This method can be seen as a post-processing on a given anaglyph method. In this chapter, all the algorithms were tested with the EIZO CRT monitor whose $T_{\text{SFCE}}$, $C_{\text{CRT}}(\cdot)$ has been determined in Section 4.2, and the colored-filter glasses are the red-cyan filters whose absorption curves are shown in Figure 2.5.

5.1 Search for a better anaglyph algorithm

In this section we describe anaglyph algorithms that are found to have good potential but so far have not given us better results than the LP method.

5.1.1 Extension of the LP method in the color-appearance space

The LP method is considered to be the best method so far for creating anaglyph images for display on CRT displays even though its drawback is in the ghosting effect. We have
5.1 Search for a Better Anaglyph Algorithm

seen that the LP method basically minimizes the color distances in CIE XYZ color space between the left anaglyph perceived color \([I_{AL}(\lambda, x)]\) and the original color \([I_L(\lambda, x)]\) and between \([I_{AR}(\lambda, x)]\) and \([I_R(\lambda, x)]\). Now, one possibility for modifying the method is that the optimization can be carried in a color-appearance space. We chose the CIELAB color space. In order to do this, we first convert the CIE XYZ tristimulus values \(I_{L,XYZ}(x)\), \(I_{R,XYZ}(x)\), \(I_{AL,XYZ}(x)\), and \(I_{AR,XYZ}(x)\) into the CIELAB coordinates \(I_{L,Lab}(x)\), \(I_{R,Lab}(x)\), \(I_{AL,Lab}(x)\), and \(I_{AR,Lab}(x)\) using Equation 2.21 with the CRT display white point as the reference white. We then search for the anaglyph image input \(I_{A,RGB}(x)\) such that

\[
I_{A,RGB,\text{opt}}(x) = \arg \min_{I_{A,RGB}(x)} \{ \Delta E_{94}(I_{L,Lab}(x), I_{AL,Lab}(x)) + \Delta E_{94}(I_{R,Lab}(x), I_{AR,Lab}(x)) \}.
\]

(5.1)

The optimal solution \(I_{A,RGB}(x)\) can be found by using a nonlinear optimization method. From Section 6.3, the MATLAB function \texttt{fminimax} in the “Optimization Toolbox” is used. We don’t restrict the range of the solution in \texttt{fminimax}. The starting point for the \texttt{fminimax} function is set to the result from the LP method. At the end, the white-point normalization, that is similar to the one used in the LP method, needs to be performed to bring the solution in the range of \([0, 1]\). This means we first find an input \(E = I_{A,RGB}(x)\) for \(I_{L,RGB}(x) = [1, 1, 1]\) and \(I_{R,RGB}(x) = [1, 1, 1]\), then

\[
I_{A,RGB,\text{Norm}}(x) = \begin{bmatrix} 1/E_R & 0 & 0 \\ 0 & 1/E_G & 0 \\ 0 & 0 & 1/E_B \end{bmatrix} \cdot I_{A,RGB}(x).
\]

(5.2)

The rendered anaglyph images of the three test stereo image pairs using this method were poor as they show very strong ghosting effect and the colors are getting more saturated which leads to the loss of the details of the original images.

5.1.2 Luminance matching algorithm

As mentioned in Section 3.1.2, the luminances of the left and right perceived colors play an important role in determining the quality of the dichoptic color mixture. By controlling the luminance of the left and right views we can hopefully improve the quality of the 3D perception. This is the idea behind the Luminance Matching (LuM) method proposed here. In the LuM method, the first two degrees of freedom in \(I_{A,RGB}(x)\) can be used to control the luminance \(I_{AL,XYZ}(x)\) and the luminance \(I_{AR,XYZ}(x)\). The remaining degree of freedom in \(I_{A,RGB}(x)\) can be used to match the chromaticities of \([I_{AL}(\lambda, x)]\) and \([I_{AR}(\lambda, x)]\). Basically, we want \(I_{AL,XYZ}(x) = D_L(x)\) and \(I_{AR,XYZ}(x) = D_R(x)\), where \(D_L(x)\) and \(D_R(x)\) are
the desired luminances. From Equation 3.21 we have

\begin{align*}
D_L(x) &= a_{L,21} \cdot I_{A,RGB,R}(x) + a_{L,22} \cdot I_{A,RGB,G}(x) + a_{L,23} \cdot I_{A,RGB,B}(x), \\
D_R(x) &= a_{R,21} \cdot I_{A,RGB,R}(x) + a_{R,22} \cdot I_{A,RGB,G}(x) + a_{R,23} \cdot I_{A,RGB,B}(x),
\end{align*}

where \([A_L]_{ij} = a_{L,ij}\) and \([A_R]_{ij} = a_{R,ij}\) with \(i, j = 1, 2, 3\). Section 4.2.3 gives the values of the matrix \(A_L\) and \(A_R\) for the EIZO CRT monitor. From Equations 5.3 and 5.4, we obtain

\begin{align*}
I_{A,RGB,R}(x) &= E_1 + E_2 \cdot I_{A,RGB,B}(x), \\
I_{A,RGB,G}(x) &= E_3 + E_4 \cdot I_{A,RGB,B}(x),
\end{align*}

where \(E_1, E_2, E_3,\) and \(E_4\) are constants and that can be precomputed based on \(D_L(x), D_R(x), a_{L,ij},\) and \(a_{R,ij}\). Thus the only thing left to find is \(I_{A,RGB,B}(x)\). We want to use this last degree of freedom to match the chromaticites. Let \((I_{AL,XYZ,x}(x), I_{AL,XYZ,y}(x))\) and \((I_{AR,XYZ,x}(x), I_{AR,XYZ,y}(x))\) be the \(xy\) chromaticity coordinates of \(I_{AL,XYZ}(x), I_{AR,XYZ}(x)\), respectively. With Equations 5.5 and 5.6, we can easily prove that these \(xy\) chromaticity coordinates are functions of one variable \(I_{A,RGB,B}(x)\) with some constants and can be precomputed from \(D_L(x), D_R(x), a_{L,ij},\) and \(a_{R,ij}\). Assume that \((D_{L,x}(x), D_{L,y}(x))\) are the desired \(xy\) chromaticity coordinates for \((I_{AL,XYZ,x}(x), I_{AL,XYZ,y}(x))\) and \((D_{R,x}(x), D_{R,y}(x))\) are the desired \(xy\) chromaticity coordinates for \((I_{AR,XYZ,x}(x), I_{AR,XYZ,y}(x))\). We want to determine \(I_{A,RGB,B}(x)\) using

\[
I_{A,RGB,B,\text{Opt}}(x) = \arg \min_{I_{A,RGB,B}(x)} \{\text{Obj}_{\text{LuM}}\}
\]

\[
\text{Obj}_{\text{LuM}} = (I_{AL,XYZ,x}(x) - D_{L,x}(x))^2 + (I_{AL,XYZ,y}(x) - D_{L,y}(x))^2 + (I_{AR,XYZ,x}(x) - D_{R,x}(x))^2 + (I_{AR,XYZ,y}(x) - D_{R,y}(x))^2.
\]  

The objective function 5.7 can be expressed as

\[
\text{Obj}_{\text{LuM}} = \left(\frac{E_5 + E_9 \cdot I_{A,RGB,B}(x)}{E_7 + E_8 \cdot I_{A,RGB,B}(x)} - D_{L,x}(x)\right)^2 + \left(\frac{E_5 + E_9 \cdot I_{A,RGB,B}(x)}{E_7 + E_8 \cdot I_{A,RGB,B}(x)} - D_{L,y}(x)\right)^2 + \left(\frac{E_{13} + E_{14} \cdot I_{A,RGB,B}(x)}{E_{11} + E_{12} \cdot I_{A,RGB,B}(x)} - D_{R,x}(x)\right)^2 + \left(\frac{E_{13} + E_{14} \cdot I_{A,RGB,B}(x)}{E_{11} + E_{12} \cdot I_{A,RGB,B}(x)} - D_{R,y}(x)\right)^2,
\]  

where all the constants \(E_i\) with \(i = 5, ..., 12\) can be precomputed directly from \(D_L(x), D_R(x), a_{L,ij},\) and \(a_{R,ij}\). The latter objective function includes only one variable \(I_{A,RGB,B}(x)\) and hence it can be minimized by taking the derivative with respect to \(I_{A,RGB,B}(x)\) and setting it to 0 to solve for \(I_{A,RGB,B}(x)\). Alternatively, we can use a nonlinear optimization method to solve for \(I_{A,RGB,B}(x)\). Then the desired \(I_{A,RGB,R}(x)\) and \(I_{A,RGB,G}(x)\) can be
calculated from Equations 5.5 and 5.6. If the resulting $I_{A,RGB}(\mathbf{x})$ is not in the range $[0, 1]$ then we can perform the white-point normalization similar to the one used in the LP method.

The desired values of $D_L(\mathbf{x})$ and $D_R(\mathbf{x})$ should be functions of the luminances of the original left and right perspective images respectively. The values of $(D_{L,x}(\mathbf{x}), D_{L,y}(\mathbf{x}))$ and $(D_{R,x}(\mathbf{x}), D_{R,y}(\mathbf{x}))$ should be functions of the xy chromaticity coordinates of $I_{L,XYZ}(\mathbf{x})$ and $I_{R,XYZ}(\mathbf{x})$ respectively. We have tested the method with different values of those desired parameter. One trivial selection was $D_L(\mathbf{x}) = I_{L,XYZ,Y}(\mathbf{x})$, $D_R(\mathbf{x}) = I_{R,XYZ,Y}(\mathbf{x})$, $D_{L,x}(\mathbf{x}) = I_{L,XYZ,Z}(\mathbf{x})$, $D_{L,y}(\mathbf{x}) = I_{L,XYZ,Y}(\mathbf{x})$, $D_{R,x}(\mathbf{x}) = I_{R,XYZ,Z}(\mathbf{x})$, and $D_{R,y}(\mathbf{x}) = I_{R,XYZ,Y}(\mathbf{x})$. So far, we have not succeeded in finding a set of parameters that can render anaglyph images which give better quality than those of the LP method.

5.2 Anaglyph dichoptic color mixture experiment

Many trials were performed to find a better anaglyph algorithm but none have succeeded to give noticeably better results than the LP method in terms of the color stability and color fidelity. We have also noticed that with the red-cyan filters, if we look at a color through these glasses then the perceived dichoptic color mixture (Section 3.1.2) is very close to the color that the right eye perceives through the cyan filter. One example is that the colors we perceive when we view the colors in the target chart and the test chart through the red-cyan filters are close to the perceived colors when we view them through the cyan filter only. This suggests it is likely that the gamut of the perceived dichoptic color mixture is not much larger than, and overlaps with, the gamut of the cyan filter.

To further confirm the above observation we set up a simple experiment. In this experiment, two same-size squares of the same color are displayed side by side on the EIZO CRT monitor on a gray background (since people often assume a gray-world assumption) in a dark room. The observer, with the left eye wearing the red filter and right eye wearing the cyan filter, looks at these two squares through a device called “Stereoopticon 707” [27]. This device allows each eye to see only one square. The position of this device is adjusted such that the right eye will see two areas: one area has the color that is the perceived dichoptic color mixture and the other area has the color that is perceived by the right eye as it sees the color while the left eye is closed. This step allows us to check the similarity between the perceived dichoptic color mixture and the right perceived color. In the next step, the position of “Stereoopticon 707” is readjusted such that the left eye will see two areas: again one is the perceived dichoptic color mixture and the other one is the left perceived color. This step
allows us to check the similarity between the perceived dichoptic color mixture and the left perceived color. In the experiment, each of the colors in the test chart is displayed in those two squares. The experiment was repeated for a yellow-blue filter pair whose absorption curves shown in Figure 3.3.

Through the experiment, with the red-cyan filter, we saw that most of the perceived dichoptic color mixtures are close to the right perceived colors. With the yellow-blue filters, we observed that most of the perceived dichoptic color mixtures are close to either the left or the right perceived colors. From this experiment we also noticed that when the left and right perceived colors have very different chromaticities, then if the luminances of these two colors are high and equal, a strong rivalry occurs. If one of those two colors has higher luminance then dichoptic color mixture is close to that one. In the case of rivalry, the perceived dichoptic color mixture becomes more stable as the sizes of those two squares get smaller. This observation may explain why the dichoptic color mixtures are close to either the left or the right perceived colors. Please note that these observations in this experiment were made only by the author of the thesis.

With these results, we may conclude that it is unlikely to have an anaglyph image that gives the 3D perception with colors the same as the original scene. Moreover, we have concluded that the anaglyph images rendered by the LP method give good color fidelity and color stability. Also through observation, the dichoptic color mixtures of these anaglyph images pretty much spans the gamut of the cyan filter. Therefore, it is likely that we cannot find anaglyph images that have better color fidelity and color stability than the anaglyph images rendered by the LP method\textsuperscript{1}. Because of this, we shifted our focus to reducing the ghosting effect that occurs with the LP method. This leads us to redefine the ghosting effect, as discussed in the following section.

5.3 A new way of defining the anaglyph ghosting effect

The way of defining the quantity called “ghosting effect” shown in Section 3.5 is rather simple and mainly used for testing whether a pair of colored-filter glasses and the color display device are good for viewing anaglyph images overall. It, however, doesn’t allow us to define or measure the ghosting level of a particular anaglyph algorithm at a particular pixel. One good example to demonstrate this is that the interesting region REDCAR3 rendered by the Photoshop method gives much less ghosting effect than that rendered from the LP method, even though, based on the overall effect, the one from the LP method is much

\textsuperscript{1}This conclusion represents the opinion of the author of this thesis
more comfortable to view. Therefore, in this section we propose a new way of establishing a mathematical formula to calculate the ghosting level at a particular pixel for a given anaglyph algorithm.

### 5.3.1 New anaglyph ghosting effect formulation

The colors \([I_{AL}(\lambda, x)]\) and \([I_{AR}(\lambda, x)]\) are the colors perceived by the left and right eyes, respectively, when the anaglyph input \(I_{A,RGB}(x)\) is displayed and viewed with a pair of glasses. From Equations 3.2, 3.4, 3.5, and 3.6, the left and right perceived colors \([I_{AL}(\lambda, x)]\) and \([I_{AR}(\lambda, x)]\) can be derived as

\[
[I_{AL}(\lambda, x)] = [\Upsilon_{SFCF}(\Upsilon_{Ana}(I_{L,RGB}(x), I_{R,RGB}(x))) \cdot f_L(\lambda)],
\]

\[
[I_{AR}(\lambda, x)] = [\Upsilon_{SFCF}(\Upsilon_{Ana}(I_{L,RGB}(x), I_{R,RGB}(x))) \cdot f_R(\lambda)],
\]

where \(\Upsilon_{SFCF}(\cdot)\) is the color display device’s SFCF. We have seen that, the color \([I_{AL}(\lambda, x)]\) cannot be the same as \([I_{L}(\lambda, x)]\). Therefore, it can be considered as a combination of two colors in which one of them is contributed by \(I_{L,RGB}(x)\), and the other one is contributed by \(I_{R,RGB}(x)\). Thus \([I_{AL}(\lambda, x)]\) can be redefined as

\[
[I_{AL}(\lambda, x)] = [\Upsilon_{SFCF}(\Upsilon_{Ana, L}(I_{L,RGB}(x))) \cdot f_L(\lambda)]
+ [\Upsilon_{SFCF}(\Upsilon_{Ana, Ghost L}(I_{R,RGB}(x))) \cdot f_L(\lambda)],
\]

where \(\Upsilon_{Ana, L}(\cdot)\) is the function to convert \(I_{L,RGB}(x)\) into the information which is received by the left eye (this information can be seen as the intended image for left eye) and \(\Upsilon_{Ana, Ghost L}(\cdot)\) is the function to define the leaking information of \(I_{R,RGB}(x)\) into the left eye (this information can be seen as the ghosting information for the left eye). With the same argument, the right perceived color \([I_{AR}(\lambda, x)]\) can be redefined as

\[
[I_{AR}(\lambda, x)] = [\Upsilon_{SFCF}(\Upsilon_{Ana, R}(I_{R,RGB}(x))) \cdot f_R(\lambda)]
+ [\Upsilon_{SFCF}(\Upsilon_{Ana, Ghost R}(I_{L,RGB}(x))) \cdot f_R(\lambda)],
\]

where \(\Upsilon_{Ana, R}(\cdot)\) is the function to convert \(I_{R,RGB}(x)\) into the information which is received by the right eye, and \(\Upsilon_{Ana, Ghost R}(\cdot)\) is the function to define the leaking information of \(I_{L,RGB}(x)\) into the right eye. To simplify notation, let’s define

\[
I_{LA,RGB}(x) = \Upsilon_{Ana, L}(I_{L,RGB}(x)),
\]

\[
I_{RA,RGB}(x) = \Upsilon_{Ana, R}(I_{R,RGB}(x)).
\]
\( I_{LA,RGB} \) is referred to as the left anaglyph intended image, and \( I_{RA,RGB} \) is referred to as the right anaglyph intended image. We now need to find the two functions \( \gamma_{\text{Ana,L}}(\cdot) \) and \( \gamma_{\text{Ana,R}}(\cdot) \). We can denote the CIE XYZ tristimulus values of the colors \([\gamma_{\text{SFCF}} (I_{LA,RGB}(x)) \cdot f_L(\lambda)], [\gamma_{\text{SFCF}} (I_{RA,RGB}(x)) \cdot f_L(\lambda)]\), and \([\gamma_{\text{SFCF}} (I_{RA,RGB}(x)) \cdot f_R(\lambda)]\) as

\[
\begin{align*}
I_{LAL,XYZ}(x) &= [I_{LAL,XYZ}(x) \quad I_{LAL,XYZ}(x) \quad I_{LAL,XYZ}(x)], \\
I_{LAR,XYZ}(x) &= [I_{LAR,XYZ}(x) \quad I_{LAR,XYZ}(x) \quad I_{LAR,XYZ}(x)], \\
I_{RAL,XYZ}(x) &= [I_{RAL,XYZ}(x) \quad I_{RAL,XYZ}(x) \quad I_{RAL,XYZ}(x)], \\
I_{RAR,XYZ}(x) &= [I_{RAR,XYZ}(x) \quad I_{RAR,XYZ}(x) \quad I_{RAR,XYZ}(x)].
\end{align*}
\]

(5.13)

In order to have a good 3D perception, the color \( I_{LAL,XYZ}(x) \) must be close to \([I_{AL}(\lambda, x)]\) and must contain no information of \( I_{R,RGB}(x) \). In order words, we must absolutely see \( I_{LAL,XYZ}(x) \) without any ghosting effect when viewing under the red filter, and this leads to one possible definition for \( I_{LA,RGB}(x) \) as

\[
I_{LA,RGB}(x) = \gamma_{\text{Ana,L}} (I_{L,RGB}(x)) = \gamma_{\text{Ana}} (I_{L,RGB}(x), 0),
\]

(5.14)

where 0 is the zero vector \([0 0 0] \). This is equivalent to replacing the right original image in the stereo image pair by a same-size black image in the original anaglyph algorithm. Obviously, \( I_{LA,RGB}(x) \) doesn’t contain any information of \( I_{R,RGB}(x) \) in the equation. In fact, it has been seen from the LP and Photoshop methods that according to this definition the color \( I_{LAL,XYZ}(x) \) looks very similar to \([I_{AL}(\lambda, x)]\). Similarly, \( I_{RA,RGB} \) is defined as

\[
I_{RA,RGB}(x) = \gamma_{\text{Ana,R}} (I_{R,RGB}(x)) = \gamma_{\text{Ana}} (0, I_{R,RGB}(x)).
\]

(5.15)

This is equivalent to replacing the left image in the stereo image pair by a same-size black image in the original anaglyph algorithm.

Similar to the idea in [18], one possible way of defining the level of ghosting in one eye can be defined as the percentage of the ratio of area under the PDS curve of the absolute difference between PDS \( I_{AL}(\lambda, x) \) and the PDS \( \gamma_{\text{SFCF}} (I_{LA,RGB}(x)) \cdot f_L(\lambda) \), and the PDS \( \gamma_{\text{SFCF}} (I_{LA,RGB}(x)) \cdot f_L(\lambda) \),

\[
I_{GL}(x) = \frac{\int_{\lambda_{\text{max}}}^{\lambda_{\text{min}}} w(\lambda) |I_{AL}(\lambda, x) - \gamma_{\text{SFCF}} (I_{LA,RGB}(x)) \cdot f_L(\lambda)| d\lambda}{\int_{\lambda_{\text{min}}}^{\lambda_{\text{max}}} w(\lambda) |\gamma_{\text{SFCF}} (I_{LA,RGB}(x)) \cdot f_L(\lambda)| d\lambda} \times 100%,
\]

(5.16)
where \( w(\lambda) \) is a weight function. A similar expression holds for defining the ghosting level in the right eye. However, test results revealed that these equations are not good measures of the ghosting level. Therefore, we need to find different formulae.

Consequently, we defined the ghosting level for the left eye at a point \( \mathbf{x} \) as the color distance between the real color perceived by the left eye \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \) and the left intended color \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \). Similarly the ghosting level for the right eye at a point \( \mathbf{x} \) is the color distance between the color perceived by the right eye \( \mathbf{I}_{RAR,XYZ}(\mathbf{x}) \) and the right intended color \( \mathbf{I}_{RAR,XYZ}(\mathbf{x}) \). The color distance metric can be the CIE XYZ Euclidean distance or \( \Delta E^* \).

We chose CIELAB CIE-94 (Equation 2.22) as it is a more uniform color space. Therefore, the ghosting level indications for the left eye can be calculated by first converting the CIE XYZ tristimulus values \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \) and \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \) into the CIELAB coordinates \( \mathbf{I}_{LAL,Lab}(\mathbf{x}) \) and \( \mathbf{I}_{LAL,Lab}(\mathbf{x}) \) with the CRT white point as the reference white and then applying the color distance metric

\[
\mathbf{I}_{GL}(\mathbf{x}) = \Delta E^*_94(\mathbf{I}_{LAL,Lab}(\lambda, \mathbf{x}), \mathbf{I}_{LAL,Lab}(\lambda, \mathbf{x})).
\]

(5.17)

A similar expression holds for the right ghosting level indication \( \mathbf{I}_{GR}(\mathbf{x}) \). One interesting point is that if the left perceived color \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \) is darker than the left intended color \( \mathbf{I}_{LAL,XYZ}(\mathbf{x}) \) then we experience the so-called dark ghosting effect. And if the left perceived color is lighter than the left intended color then we have the light ghosting effect. The section below shows an example for this definition.

### 5.3.2 Example of applying the new ghosting calculation for a CRT display

For CRT displays, we replace \( \Upsilon_{SFCF}(\cdot) \) by \( \Upsilon_{SFCF,CRT}(\cdot) \). Here, we used the EIZO CRT monitor’s SFCF established in Section 4.2. Therefore, under the LP method, from Equation 3.26, the left and right anaglyph intended images \( \mathbf{I}_{LRA,RGB} \) and \( \mathbf{I}_{RA,RGB} \) can be found as

\[
\mathbf{I}_{LRA,RGB}(\mathbf{x})^T = \mathbf{N} \cdot (\mathbf{R}^T \cdot \mathbf{R})^{-1} \cdot \mathbf{R} \cdot \mathbf{A}_2 \cdot \begin{bmatrix} \mathbf{I}_{L,RGB}(\mathbf{x})^T \\ 0 \end{bmatrix},
\]

(5.18)

\[
\mathbf{I}_{RA,RGB}(\mathbf{x})^T = \mathbf{N} \cdot (\mathbf{R}^T \cdot \mathbf{R})^{-1} \cdot \mathbf{R} \cdot \mathbf{A}_2 \cdot \begin{bmatrix} 0 \\ \mathbf{I}_{R,RGB}(\mathbf{x})^T \end{bmatrix}.
\]

(5.19)
Table 5.1 The ghosting levels at four different points in the REDCAR stereo image pair and two different points in the ICIP stereo image pair for the red-cyan filters and the EIZO CRT monitor for the Photoshop and LP algorithms using the new definition.

<table>
<thead>
<tr>
<th>Algorithms</th>
<th>( x_1 )</th>
<th>( x_2 )</th>
<th>( x_3 )</th>
<th>( x_4 )</th>
<th>( x_5 )</th>
<th>( x_6 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoshop</td>
<td>1.304</td>
<td>7.628</td>
<td>13.238</td>
<td>0.143</td>
<td>0.066</td>
<td>3.066</td>
</tr>
<tr>
<td>LP</td>
<td>0.385</td>
<td>11.719</td>
<td>9.206</td>
<td>0.474</td>
<td>0.378</td>
<td>2.330</td>
</tr>
<tr>
<td>Photoshop</td>
<td>1.555</td>
<td>0.688</td>
<td>0.464</td>
<td>4.333</td>
<td>37.405</td>
<td>0</td>
</tr>
<tr>
<td>LP</td>
<td>0.552</td>
<td>1.645</td>
<td>0.106</td>
<td>10.06</td>
<td>35.246</td>
<td>0.025</td>
</tr>
</tbody>
</table>

For the Photoshop method, from Equation 3.12, \( I_{LA,RGB}(x) \) and \( I_{RA,RGB}(x) \) can be found as

\[
I_{LA,RGB}(x)^T = \begin{bmatrix}
1 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 1 & 0 \\
0 & 0 & 0 & 0 & 0 & 1
\end{bmatrix} \cdot \begin{bmatrix}
I_{L,RGB}(x)^T \\
0
\end{bmatrix}, \tag{5.20}
\]

\[
I_{RA,RGB}(x)^T = \begin{bmatrix}
1 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 1 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 1
\end{bmatrix} \cdot \begin{bmatrix}
0 \\
I_{R,RGB}(x)^T
\end{bmatrix}. \tag{5.21}
\]

In order to demonstrate the new ghosting effect formula, we pick four different points in the REDCAR stereo image pair, which are \( x_1(443, 343) \) (this point is in the flower in the left image and it exhibits a strong ghosting for the right eye under the LP method), \( x_2(440, 318) \) (this point is in the flower of right image and it exhibits a ghosting for the left eye), \( x_3(295, 275) \) (this point is at the red car), \( x_4(110, 149) \) (this point is at the green leaf), and two different points in the ICIP stereo image pair, which are \( x_5(305, 355) \) (this point exhibits a strong ghosting for the right eye) and \( x_6(862, 666) \) (this point exhibits a strong ghosting for the left eye). Table 5.1 summarizes the resulting ghosting levels using the Photoshop and LP methods at these chosen points for the red-cyan filter pair and the EIZO CRT monitor using the new definition.

As we see from the table, at the points \( x_1 \) and \( x_5 \) (these two points are the right occluded points), they show a much stronger ghosting effect on right eye if compared to that on the left eye for both the Photoshop and LP algorithms. This complies with what we observed from the rendered REDCAR anaglyph images. However, at the points \( x_2 \) and \( x_6 \) (these two points are the left occluded points), they show a much stronger ghosting effect on the left
Figure 5.1 The ghosting reduction component is used after the anaglyph algorithm to reduce the ghosting level without sacrificing the color stability and fidelity.

eye if compared to that on the right eye for both the Photoshop and LP methods. This again complies with what we observed from the rendered anaglyph images. Between the Photoshop and LP methods, the right eye ghosting effect is stronger for the LP method at \( x_1 \) and \( x_5 \) and the left eye ghosting effect is stronger for the Photoshop method at \( x_2 \) and \( x_6 \). However the right ghosting effect seems to suppress the left ghosting effect in the case of the red-cyan filters to give us the perception of overall strong ghosting effect on the LP method. This can be explained due to characteristic of the dichoptic color mixture phenomenon of the red-cyan filters (Section 5.2). At the points \( x_3 \) and \( x_4 \) (these two points are not the occluded points), they show weak ghosting effects on both the left and right eyes. These results comply with the fact that the ghosting effect is most visible near the border of the scene objects.

5.4 Reduction of the ghosting component

Through both human judgment and the results of Table 5.1, we conclude that the ghosting level in the REDCAR anaglyph image rendered by the LP method is higher than that in the REDCAR anaglyph image rendered by the Photoshop method. However, the LP method gives better overall comfort in terms of the color fidelity and color stability. Thus, rather than finding a new anaglyph algorithm that can satisfy all three conditions, we can try to reduce the ghosting level in the anaglyph images rendered by the LP method without sacrificing much of its comfort and color fidelity. This idea leads us to a way of decomposing the anaglyph algorithm into two components: anaglyph rendering component and ghosting reduction component as illustrated in the Figure 5.1. Based on the new definition of the ghosting effect, we propose a way of reducing the ghosting level known as the left-right matching (LRM) ghosting reduction algorithm.
5.4.1 LRM ghosting reduction method for a CRT

In the LRM ghosting reduction method, for a given anaglyph algorithm, e.g. the Photoshop method or the LP method, the left and right anaglyph intended images $I_{LA,RGB}$ and $I_{RA,RGB}$ can be found by using Equations 5.14 and 5.15. The idea of the LRM ghosting reduction method is that we want to find the ghosting reduced anaglyph input $I_{A,RGB}(x)$ such that its left and right perceived colors $I_{AL,XYZ}^*(x)$ and $I_{AR,XYZ}^*(x)$ are as close as possible to $I_{LAL,XYZ}(x)$ and $I_{RAR,XYZ}(x)$, respectively. In other words, we want to minimize the ghosting levels. We have developed two different ways to do this: LRM-1 and LRM-2.

5.4.1.1 LRM-1 ghosting reduction method

The objective above naturally leads us to think of finding the optimal solution $I_{A,RGB}^*(x)$ to minimize the following objective function

$$I_{A,RGB,\text{Opt}}^*(x) = \arg \min_{I_{A,RGB}(x)} \{ \text{Obj}_{\text{LRM-1}} \}$$

$$\text{Obj}_{\text{LRM-1}} = w_1 (I_{LAL,XYZ}(x) - I_{AL,XYZ}^*(x))^2 + w_2 (I_{LAL,XYZ,Z}(x) - I_{AL,XYZ,Z}^*(x))^2$$

$$- I_{AL,XYZ}^*(x))^2 + w_3 (I_{LAL,XYZ,Z}(x) - I_{AL,XYZ,Z}^*(x))^2$$

$$+ w_4 (I_{RAR,XYZ}(x) - I_{AR,XYZ}^*(x))^2 + w_5 (I_{RAR,XYZ,Z}(x) - I_{RAR,XYZ,Z}^*(x))^2,$$

where $w_i$ with $i = 1, 2, ..., 6$ are weights and

$$I_{LAL,XYZ}(x)^T = A_L \cdot I_{LA,RGB}(x)^T,$$

$$I_{RAR,XYZ}(x)^T = A_R \cdot I_{RA,RGB}(x)^T.$$

Equation 3.22 can be applied for $I_{A,RGB}^*(x)$ as

$$\begin{bmatrix} I_{AL,XYZ}^*(x)^T \\ I_{AR,XYZ}^*(x)^T \end{bmatrix} = \begin{bmatrix} A_L \\ A_R \end{bmatrix} \cdot I_{A,RGB}^*(x)^T = R \cdot I_{A,RGB}^*(x)^T,$$

$$R = \begin{bmatrix} A_L \\ A_R \end{bmatrix}.$$ 

This is the same as finding the minimum sum of the two color distances between $I_{AL,XYZ}^*(x)$ and $I_{LAL,XYZ}(x)$ and between $I_{AR,XYZ}^*(x)$ and $I_{RAR,XYZ}(x)$ in the CIE XYZ color space. To find the solution for this optimization problem, one way is that we take the partial derivative of the function $\text{Obj}_{\text{LRM-1}}$ with respect to $I_{A,RGB,R}$, $I_{A,RGB,G}$, and $I_{A,RGB,B}$ and set these partial derivatives to 0 and solve for $I_{A,RGB,R}$, $I_{A,RGB,G}$, and $I_{A,RGB,B}$. A different way
to solve this problem is to apply the well known projection method [24] as used in the LP method (Section 3.6.3).

By rearranging Equation 5.23, we obtain

$$\begin{bmatrix} I_{LAL,XYZ}(x)^T \\ I_{RAR,XYZ}(x)^T \end{bmatrix} = \begin{bmatrix} A_L & 0 \\ 0 & A_R \end{bmatrix} \cdot \begin{bmatrix} I_{LA,RGB}(x)^T \\ I_{RA,RGB}(x)^T \end{bmatrix} = A_3 \cdot V_1(x),$$

$$A_3 = \begin{bmatrix} A_L & 0 \\ 0 & A_R \end{bmatrix}, \quad 0 = \begin{bmatrix} 0 & 0 & 0 \\ 0 & 0 & 0 \\ 0 & 0 & 0 \end{bmatrix},$$

$$V_1(x) = \begin{bmatrix} I_{LA,RGB}(x)^T \\ I_{RA,RGB}(x)^T \end{bmatrix}.$$  (5.25)

From the projection method, the optimal vector $I^*_{A,RGB}(x)$ can be obtained by projecting the vector $V_1(x)$ onto subspace $S_3$, giving

$$I^*_{A,RGB}(x)^T = (R^T W R)^{-1} \cdot R W A_3 \cdot V_1(x),$$  (5.26)

where $W$ is the $6 \times 6$ positive-definite diagonal weight matrix with the diagonal entries of $(w_i \times w_i)$.

The minimum sum of two color distances between $I^*_{AL,XYZ}(x)$ and $I_{LAL,XYZ}(x)$ and between $I^*_{AR,XYZ}(x)$ and $I_{RAR,XYZ}(x)$ can also be carried in the CIELAB space with CIE-E94 as the color distance metric. Then a nonlinear optimization method can be used to find $I^*_{A,RGB}(x)$, with the anaglyph image rendered by the LP method as starting point. However, the CIELAB space is not much better than the CIE XYZ space for this purpose and it is very slow.

### 5.4.1.2 LRM-2 ghosting reduction method

This method is based on the idea of predistorting the left and right anaglyph intended images $I_{LA,RGB}$ and $I_{RA,RGB}$, and is similar to the idea used in [28]. As we pointed out previously, the left perceived color $I_{AL,XYZ}(x)$ can be considered as a combination of two parts: $I_{LAL,XYZ}(x)$ plus the ghosting contributed by $I_{RA,RGB}(x)$. Therefore, if somehow we are able to predistort the color $I_{LAL,XYZ}(x)$ with an amount of the ghosting level contributed by $I_{RA,RGB}(x)$, then by adding those left and right predistorted colors together, the ghosting can be reduced.
Notice that if by letting $\mathbf{I}^*_A,\mathbf{RGB}(x) = \mathbf{I}_{LA,\mathbf{RGB}}(x) + \mathbf{I}_{RA,\mathbf{RGB}}(x)$, then the left eye perceives

$$
\mathbf{I}^*_{AL,\mathbf{XYZ}}(x) = \mathbf{A}_L \cdot \mathbf{I}_{LA,\mathbf{RGB}}(x)^T + \mathbf{A}_L \cdot \mathbf{I}_{RA,\mathbf{RGB}}(x)^T = \mathbf{I}_{LA,\mathbf{XYZ}}(x)^T + \mathbf{A}_L \cdot \mathbf{I}_{RA,\mathbf{RGB}}(x)^T.
$$

(5.27)

The source of the left ghosting thus can be seen as $\mathbf{A}_L \cdot \mathbf{I}_{RA,\mathbf{RGB}}(x)^T$. Similarly, the source of the right ghosting can be seen as $\mathbf{A}_R \cdot \mathbf{I}_{LA,\mathbf{RGB}}(x)^T$. We then predistort the left perceived color and the right perceived color as

$$
\mathbf{I}_{LA,\mathbf{XYZ},\text{Distorted}}(x)^T = \mathbf{A}_L \cdot (\mathbf{I}_{LA,\mathbf{RGB}}(x)^T - \mathbf{I}_{RA,\mathbf{RGB}}(x)^T),
$$

$$
\mathbf{I}_{RA,\mathbf{XYZ},\text{Distorted}}(x)^T = \mathbf{A}_R \cdot (\mathbf{I}_{RA,\mathbf{RGB}}(x)^T - \mathbf{I}_{LA,\mathbf{RGB}}(x)^T).
$$

(5.28)

Next, we want to find $\mathbf{I}_{LA,\mathbf{RGB},\text{Distorted}}(x)$ such that its left perceived color must be close to $\mathbf{I}_{LA,\mathbf{XYZ},\text{Distorted}}(x)$ and its right perceived color must close to dark. This problem again is similar to the optimization problem stated for LRM-1 with $\mathbf{V}_1(x)$ replaced by $\mathbf{V}_{LA,\text{Distorted}}(x)$, where

$$
\mathbf{V}_{LA,\text{Distorted}}(x) = \begin{bmatrix}
\mathbf{I}_{LA,\mathbf{RGB}}(x)^T - \mathbf{I}_{RA,\mathbf{RGB}}(x)^T \\
0
\end{bmatrix},
$$

(5.29)

and by applying the projection method, $\mathbf{I}_{LA,\mathbf{RGB},\text{Distorted}}(x)$ can be found as

$$
\mathbf{I}_{LA,\mathbf{RGB},\text{Distorted}}(x)^T = (\mathbf{R}^T \mathbf{W}_L \mathbf{R})^{-1} \cdot \mathbf{R}^T \mathbf{A}_3 \cdot \mathbf{V}_{LA,\text{Distorted}}(x),
$$

(5.30)

where $\mathbf{W}_L$ is the $6 \times 6$ positive-definite diagonal weight matrix. Similarly, we want to find $\mathbf{I}_{RA,\mathbf{RGB},\text{Distorted}}(x)$ that its right perceived color must be close to $\mathbf{I}_{RA,\mathbf{XYZ},\text{Distorted}}(x)$ and its left perceived color must be close to dark and we obtain

$$
\mathbf{I}_{RA,\mathbf{RGB},\text{Distorted}}(x)^T = (\mathbf{R}^T \mathbf{W}_R \mathbf{R})^{-1} \cdot \mathbf{R}^T \mathbf{A}_3 \cdot \begin{bmatrix}
0 \\
\mathbf{I}_{RA,\mathbf{RGB}}(x)^T - \mathbf{I}_{LA,\mathbf{RGB}}(x)^T
\end{bmatrix},
$$

(5.31)

where $\mathbf{W}_R$ is the $6 \times 6$ positive-definite diagonal weight matrix. Finally, the anaglyph input $\mathbf{I}^*_A,\mathbf{RGB}(x)$ can be found by first clipping $\mathbf{I}_{LA,\mathbf{RGB},\text{Distorted}}(x)$ and $\mathbf{I}_{RA,\mathbf{RGB},\text{Distorted}}(x)$ to be in the range of $[0, 1]$ and then adding them to get

$$
\mathbf{I}^*_A,\mathbf{RGB}(x) = \mathbf{I}_{LA,\mathbf{RGB},\text{Distorted}}(x) + \mathbf{I}_{RA,\mathbf{RGB},\text{Distorted}}(x).
$$

(5.32)

### 5.4.2 Test results and discussion

The LP method was chosen to be the base anaglyph algorithm for these two LRM methods for EIZO CRT monitor and the red-cyan filters. Sections C.8 and C.9 contain the resulting
anaglyph images from the three test stereo image pairs for the LRM-1 and LRM-2 methods respectively for the EIZO CRT monitor and the red-cyan filters. Here, for LRM-1 the $W$ matrix is a $6 \times 6$ identity matrix; for LRM-2 the $W_L$ and $W_R$ matrices are diagonal matrices with diagonal entries of $[10^4, 10^4, 10^4, 1, 1, 1]$ and $[1, 1, 1, 10^4, 10^4, 10^4]$ respectively. Similar to Table 5.1, Table 5.2 shows the resulting ghosting levels under the LRM-1 and LRM-2 methods at those six points for the red-cyan filter pair and the EIZO CRT monitor.

First, all the anaglyph images rendered by those two LRM methods are better than their LP versions in term of the ghosting effect. The ghosting effects in those anaglyph images are significantly reduced without sacrificing the strengths of the LP method (e.g. clearly demonstrated at the interesting region REDCAR3). The results from Table 5.2 also indicate that there were significant reductions in the ghosting levels at those six points when compared with the LP method. The three anaglyph images rendered by LRM-2 give better overall 3D perception than the anaglyph images rendered by LRM-1. The anaglyph images rendered by LRM-2 tend to exhibit a light ghosting effect. The quality of the rendered anaglyph images from LRM1 and LRM-2 strongly depends on the values of their weight matrices. Ideally, for each different stereo image pair, it is necessary to adjust the weight matrices to get the best results.

The LRM ghosting reduction algorithms work well in general. However, there is one condition that is required in order for the LRM methods to work well, that is the leaking color perceived by the left eye $I_{\text{RA},XYZ}(x)$ (when seeing the right anaglyph intended image $I_{\text{RA},RGB}(x)$) must be darker than the left anaglyph intended color $I_{\text{LA},XYZ}(x)$, and similarly the leaking color perceived by the right eye $I_{\text{LA},XYZ}(x)$ (when seeing the left anaglyph intended image $I_{\text{LA},RGB}(x)$), must be darker than the right anaglyph intended color $I_{\text{RA},XYZ}(x)$. The reason for the leaking PDSs $I_{\text{LA}}(\lambda, x) = \Upsilon_{\text{SFCF, CRT}}(I_{\text{LA},RGB}(x)) \cdot f_R(\lambda)$ and $I_{\text{RA}}(\lambda, x) =$
Figure 5.2 At the point $x_6$, LRM can’t reduce the ghosting level in the left eye. Because in the lower figure, the PDS of the color $I_{RAL,XYZ}(x_6)$ (dotted line) is much stronger than the useful PDS of the color $I_{LAL,XYZ}(x_6)$ (solid line). In the upper figure, the useful PDS (solid line) is dominated. In the upper figure, the leaking signal is not shown since it is very small.

\[ \gamma_{SFCF, CRT}(I_{RA,RGB}(x)) \cdot f_L(\lambda) \] to exist is that the independent condition for the device $D$ in Section 3.2.1.1 doesn’t hold for the EIZO CRT monitor.

One example to demonstrate this condition is that from Tables 5.1 and 5.2, the left and right ghosting levels from the LRM-1 and LRM-2 methods at the point $x_6$ are the same as the left and right ghosting levels from the LP method. This means the ghosting is not reduced at this point. The upper and lower dotted lines in Figure 5.2 are the leaking PDSs $I_{LAR}(\lambda, x_6)$ and $I_{RAL}(\lambda, x_6)$ respectively at $x_6$ and the upper and lower solid lines are the useful PDSs $I_{RAR}(\lambda, x_6)$ and $I_{LAL}(\lambda, x_6)$ respectively. We can see that the leaking PDS $I_{RAL}(\lambda, x_6)$ is much stronger than the useful PDS $I_{LAL}(\lambda, x_6)$. If we take a close look at the interesting regions ICIP1 rendered by the LRM-1 and LP methods through the red filter only, we can see that both of the regions exhibit a strong ghosting at the dark horizontal bars where are not uniform dark but there are a darker areas.

## 5.5 Preprocessing module

From the above section for the case of the point $x_6$, in order to further reduce the ghosting level we can increase the useful PDS $I_{LAL}(\lambda, x_6)$ and/or to decrease the leaking PDS $I_{RAL}(\lambda, x_6)$. In the other words, we have to lighten the color $I_{LAL,XYZ}(x_6)$ and/or darken
Figure 5.3 The Preprocessing component is used after the LP algorithm to further reduce the ghosting effect.

the color $I_{RAR,XYZ}(x_6)$. However, if we only lighten $I_{LAL,XYZ}(x)$ at the pixels that violate the LRM condition (these points are usually at the boundaries of the objects in the stereo image pairs) then we in fact create a ghosting effect on the left anaglyph intended image. Similarly, if we only darken $I_{RAR,XYZ}(x)$ at the violated pixels then we create a ghosting effect on the right anaglyph intended image. As a result, these ghosting effects will slip in the left or right anaglyph perceived color $I_{AL,XYZ}(x)$ or $I_{AR,XYZ}(x)$ through the LRM ghosting reduction component. Therefore, to prevent this we need to modify not only those violated points but also all the points in the objects which the violated points belong to. The violation condition at the point $x_6$ is for the left eye, and similarly, the violation condition can also happen in the right eye.

5.5.1 Luminance adjusted preprocessing module

To even further reduce the ghosting effect, we propose another process or Preprocessing component as illustrated in Figure 5.3. The idea of the Preprocessing component is that we want to increase the luminance of all the points in one anaglyph intended image and/or decrease the luminance of the other anaglyph intended image. The choice of which anaglyph intended image, whose luminance should be increased, depends on what pair of colored-filter glasses are being used. From Section 5.2, we concluded that the final dichoptic color mixture is similar to the color that is perceived by the eye with colored-filter glass that has the larger independent band (Section 3.2.1.1). Also, one of the objectives of ghosting reduction is not to sacrifice too much the color stability and color fidelity. Therefore, it should be a good choice if we increase the luminance of the anaglyph intended image on the side with the colored-filter glasses that has the smaller independent band. For example, with the red-cyan filters we should choose to increase the luminance of the left anaglyph intended image. Without loss of generality, assume that we want to increase the luminance of the left anaglyph intended image $I_{LA,RGB}$ for the case of the red-cyan filters.

The Preprocessing step can be decomposed into three stages. In the first stage, we increase the luminances of the dark colors and decrease the luminances of the bright colors...
in the right intended image \( I_{RA,RGB} \). First, convert the CIE XYZ tristimulus values of the color \( I_{RAR,XYZ}(x) \) into the CIELAB coordinates \( I_{RAR,Lab}(x) = [I_{RAR,Lab,L}(x) \ I_{RAR,Lab,a}(x) \ I_{RAR,Lab,b}(x)] \) with the reference white being the CRT display white seen through the right filter \((Y_{SFCF,CRT}([1, 1, 1]) \cdot f_R(\lambda))\). Next, find the maximum luminance \( I_{RAR,Lab,L,Max} \) and the minimum luminance \( I_{RAR,Lab,L,Min} \) among those colors. Then \( I_{RAR,Lab,L}^*(x) \), which is the luminance of the \( I_{RAR,Lab}^*(x) \), can be found from \( I_{RAR,Lab,L}(x) \) as

\[
I_{RAR,Lab,L}^*(x) = \left( c_2 - c_1 \times \frac{I_{RAR,Lab,L}(x) - I_{RAR,Lab,L,Min}}{I_{RAR,Lab,L,Max} - I_{RAR,Lab,L,Min}} \right) + c_1 \tag{5.33}
\]

where \( c_1 \) and \( c_2 \) are two constants in the range of \([0, 1]\) and \( c_2 > c_1 \). Figure 5.4 graphs this linear relationship. Thus the CIELAB coordinates \( I_{RAR,Lab}^*(x) \) are \([I_{RAR,Lab,L}^*(x) \ I_{RAR,Lab,a}^*(x) \ I_{RAR,Lab,b}^*(x)]\). Convert \( I_{RAR,Lab}^*(x) \) back to CIE XYZ tristimulus values \( I_{RAR,XYZ}^*(x) \) and then to \( I_{RA,RGB}^*(x) \) (in the case of LRM-2).

Specifically, to convert \( I_{RAR,XYZ}^*(x) \) to \( I_{RA,RGB}^*(x) \), we want to find the optimal input \( I_{RA,RGB}^*(x) \) such that sum of \( \Delta E_{XYZ} \) between the color which the right eye with filter sees and \( I_{RAR,XYZ}^*(x) \) and \( \Delta E_{XYZ} \) between the color which the left eye with filter sees and black. The values of \( c_1 \) and \( c_2 \) control the appearance of the right intended color \( I_{RAR,XYZ}^*(x) \), thus they control the appearance of the final 3D perception. If \( c_1 = 0 \) and \( c_2 = 1 \) then this stage is turned off.

The second stage includes the following steps: first convert the CIE XYZ tristimulus values of the left anaglyph intended color \( I_{LAL,XYZ}(x) \) and the right leaking color \( I_{RAL,XYZ}(x) \) into the CIELAB coordinates \( I_{LAL,Lab}(x) = [I_{LAL,Lab,L}(x) \ I_{LAL,Lab,a}(x) \ I_{LAL,Lab,b}(x)] \) and \( I_{RAL,Lab}(x) \)
\[ \begin{bmatrix} a \\ b \end{bmatrix} = \begin{bmatrix} \frac{I_{RL, Lab, L}(x)}{L_{max}} & 1 \\ \frac{1}{L_{max}} & 1 \end{bmatrix}^{-1} \begin{bmatrix} g \cdot \frac{I_{RL, Lab, b}(x)}{L_{max}} \\ \frac{g}{L_{max}} \end{bmatrix}, \quad (5.34) \]

where \( L_{max} \) is the maximum luminance that can be perceived by the left eye through the red filter and \( g \) is a scaler that is normally set to 1. Then the luminance \( I'_{LAL, Lab, L}(x) \) can be expressed from \( I_{LAL, Lab, L}(x) \) as

\[ I'_{LAL, Lab, L}(x) = a \cdot I_{LAL, Lab, L}(x) + b \cdot L_{max}. \quad (5.35) \]

Figure 5.5 illustrated the linear conversion function between \( I'_{LAL, Lab, L}(x) \) and \( I_{LAL, Lab, L}(x) \). It can be easily seen that none of the adjusted luminances \( I'_{LAL, Lab, L}(x) \) can be larger than the maximum luminance which can be produced by the CRT and hence we don’t need to perform white-point normalization. However, the \( b \) value can be further changed by adjusting \( g \).

The second stage increases the luminances of all the colors in left intended images. This thus makes the bright colors in the left intended image even brighter. This in turn will cause the ghosting effect in the right eye to increase. Thus we should decrease the luminances of the bright colors in the left intended image without decreasing the luminances of the dark
colors. In the last stage, the first step is to find the maximum luminance $I'_{LAL,Lab,L,Max}$ and the minimum luminance $I'_{LAL,Lab,L,Min}$ among $I'_{LAL,Lab,L}(x)$. Then calculate $a$ and $b$ as

$$
\begin{bmatrix}
  a \\
  b
\end{bmatrix} = 
\begin{bmatrix}
  \left( \frac{I'_{LAL,Lab,L}(x_{max}) - I'_{LAL,Lab,L,Min}}{I'_{LAL,Lab,L,Max} - I'_{LAL,Lab,L,Min}} \right) & 1 \\
  1 & 1
\end{bmatrix}
^{-1}
\begin{bmatrix}
  \left( \frac{I'_{LAL,Lab,L}(x_{max}) - I'_{LAL,Lab,L,Min}}{I'_{LAL,Lab,L,Max} - I'_{LAL,Lab,L,Min}} \right) \\
  c_3
\end{bmatrix},
$$

where $c_3$ is a constant in the range of $[0, 1]$ and $x_{max}$ is the point found in the second stage. Then the luminance $I^*_{LAL,Lab,L}(x)$ can be calculated as

$$
I^*_{LAL,Lab,L}(x) = \left( a \times \left( \frac{I'_{LAL,Lab,L}(x) - I'_{LAL,Lab,L,Min}}{I'_{LAL,Lab,L,Max} - I'_{LAL,Lab,L,Min}} \right) + b \right) \times (I'_{LAL,Lab,L,Max} - I'_{LAL,Lab,L,Min}) + I'_{LAL,Lab,L,Min}.
$$

Thus the final CIELAB coordinates $I^*_{LAL,Lab}(x)$ are $[I^*_{LAL,Lab,L}(x) \ I_{LAL,Lab,a}(x) \ I_{LAL,Lab,b}(x)]$. Convert $I^*_{LAL,Lab}(x)$ back to CIE XYZ tristimulus values $I^*_{LAL,XYZ}(x)$ and then to $I^*_L_{LA,RGB}(x)$ (in the case of LRM-2).

Specifically, to convert $I^*_{LAL,XYZ}(x)$ to $I^*_L_{LA,RGB}(x)$, we want to find the optimal input $I^*_L_{LA,RGB}(x)$ such that sum of $\Delta E_{XYZ}$ between the color which the left eye with filter sees and $I^*_{LAL,XYZ}(x)$ and $\Delta E_{XYZ}$ between the color which the right eye with filter sees and black. Figure 5.6 graphs the linear relationship between $I'_{LAL,Lab,L}(x)$ and $I'_{LAL,Lab,L}(x)$. Clearly from the graph, $c_3$ should not less than $p$. As $c_3$ get smaller, the left intended image is blurrier. Set $c_3$ to 1 if we want to turn off the effect of this stage.
Table 5.3 The ghosting levels at four different points in the REDCAR stereo image pair and two different points in the ICIP stereo image pair for the red-cyan filters and the EIZO CRT monitor for the Preprocessing algorithm prior to the LRM-1 algorithm based on the LP method.

<table>
<thead>
<tr>
<th>Algorithms</th>
<th>$x_1$</th>
<th>$x_2$</th>
<th>$x_3$</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td>Right</td>
<td>Left</td>
</tr>
<tr>
<td>Preprocessing prior to LRM-1</td>
<td>1.415</td>
<td>3.427</td>
<td>2.34</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.031</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Algorithms</th>
<th>$x_4$</th>
<th>$x_5$</th>
<th>$x_6$</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td>Right</td>
<td>Left</td>
</tr>
<tr>
<td>Preprocessing prior to LRM-1</td>
<td>0.099</td>
<td>5.114</td>
<td>0.041</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.021</td>
</tr>
</tbody>
</table>

5.5.2 Test results

To test the proposed Preprocessing algorithm, we used the LP method for base anaglyph component and both LMR-1 and LMR-2 for ghosting reduction component with weight matrices $W$, $W_L$, and $W_R$ set to the suggested values. Section C.10 contains the rendered anaglyph images from the three test stereo image pairs with $g = 1$, $c_1 = 0$, $c_2 = 1$, and $c_3 = 0.8$, for the EIZO CRT monitor and the red-cyan filters. The resulting anaglyph images are comfortable to view with stable 3D perception and very little ghosting effect. However, there is a bit less comfort to view these anaglyph images than to view those rendered by LRM-1 or LRM-2 alone due to the decreasing in color stability. The increasing of the $g$ value will cause this discomfort to increase as well. If we look at the interesting region ICIP1, we notice that the ghosting effect is reduced a lot if compared with LRM-1 or LRM-2. This, therefore, provides a tradeoff between the color stability and the ghosting effect.

Similar to Table 5.2, Table 5.3 shows the resulting ghosting levels with the Preprocessing algorithm prior to the LRM-1 method based on the LP method at those six points for the red-cyan filter pair and the EIZO CRT monitor. From Section 5.3.1, the left ghosting level for the Preprocessing algorithm is defined as the color distance $\Delta E^*_{94}$ between $L_{LAL,XYZ}(x)$ and $L_{AL,XYZ}(x)$. Similarly, the right ghosting level is defined as the color distance $\Delta E^*_{94}$ between $R_{RAR,XYZ}(x)$ and $R_{AR,XYZ}(x)$. We can see that in general the left ghosting levels at those six points are reduced (this complies with the fact that we observed the ghosting level reduction in the REDCAR anaglyph image), whereas, the right ghosting levels are increased only at the non-occluded points (points $x_3$ and $x_4$). This however does not increase the overall right ghosting effect but decreases the color stability.
5.5.3 Observations on other additive display devices

The process of modeling CRT displays is a time-consuming process. However, we have observed that the rendered anaglyph images based on the EIZO CRT monitor's SFCF still gave very satisfactory results when displayed on different CRT monitors, e.g., the ghosting effect is very low while the color stability and fidelity are kept high. Therefore, we can reuse the EIZO CRT monitor's SFCF and gamma-correction model to render anaglyph images for different CRT monitor devices. Similarly, we have also used the rendered anaglyph images for the EIZO CRT monitor to project onto a screen using the Electrohome EPS1024 SUPER PolySi LCD projector and again the overall 3D perception of these anaglyph images was very satisfactory. For LCD display devices, the rendered anaglyph images using the EIZO CRT monitor's SFCF gave good color stability and fidelity, but the ghosting effect in these anaglyph images was a bit stronger than that of the rendered anaglyph images using the LCD device's SFCF. However, if one refers not to model LCD devices, then a CRT monitor's SFCF can be used to give good overall 3D perception.

5.6 Summary

The chapter started with discussions of two new algorithms: one is the extension of the LP method in CIELAB color space, and the other one is LuM that first tries to exactly match the luminances of the left and right perceived colors with desired luminances, and then uses the last degree of freedom to match the chromaticities of the left and right perceived colors with desired chromaticities. However, these two algorithms are not considered to be better than the LP method. Through a simple experiment, it is likely that we cannot have an anaglyph image that has better color fidelity and color stability than the anaglyph rendered by the LP method. Thus we tried to minimize the ghosting effect in the LP method. This led us to a new way of defining the ghosting level. This novel definition allows us to calculate the ghosting levels of a particular anaglyph algorithm at a specific pixel. Based on this definition, we proposed two extra processes, an LRM ghosting reduction component and a Preprocessing component (Figure 5.3), to reduce the ghosting effect in the LP method without sacrificing the strengths of the LP method. We have shown that the rendered anaglyph images have very little ghosting effects.

Our recommendation for rendering an anaglyph image that is best displayed on a CRT display from a given stereo image pair is as follows: first use the LP method to render the anaglyph image. If the resulting anaglyph image is satisfactory then there is no need for further processing. If the resulting image has strong ghosting, then apply the LRM-2 method
after the LP method. If further ghosting reduction is desired then the Preprocessing method can be involved prior to LRM-2.
CHAPTER

SIX

Development of anaglyph algorithm for printers

So far no literature has been found for anaglyph algorithms that are used to render anaglyph images which are optimized for a particular printer. The intention of this chapter is to find an anaglyph method that renders anaglyph images to be best printed on ordinary paper. To test the developed anaglyph algorithm, the EPSON printer, whose $\gamma_{SFCF,\text{Printer}}(\cdot)$ has been obtained in Section 4.3, is used to print the rendered anaglyph images, and the colored-filter glasses are the red-cyan filters whose absorption curves are shown in Figure 2.5.

6.1 Strong ghosting effect problem in printer

As mentioned in Chapter 1, the biggest advantage of the anaglyph technique is that it is the only way to allow us to perceive 3D effects with ordinary paper. In the prior technique for perceiving 3D effect on paper, we print an anaglyph image that is rendered for CRT displays. For example with the EPSON printer, we follow Section 4.3.1.1 to print an anaglyph image that is optimized for the EIZO CRT monitor. However, due to the gamut mismatch between the EIZO CRT monitor and the EPSON printer, the perceived image from the printed version is not same as the perceived image from the monitor. The closeness between the printed image and the monitor displayed image depends on the gamut mapping algorithm, the printer’s profile, and the monitor’s profile (Section 2.2.4) which are involved during the printing process.

Even in the case that these two images look the same, there is no guarantee that the left and the right eye perceived images through the two colored-filter glasses of a monitor displayed
image are the same as those of the printed image. With the EPSON printer and the red-cyan filters, we can expect a stronger ghosting effect in the final fused 3D perception for EPSON than EIZO. The main reason is that the EPSON printer cannot adjust the PDS $I_{A,B_L}(\lambda, x)$ independently with the PDS $I_{A,B_R}(\lambda, x)$ and *vice versa* (Section 3.2.1.1) and this dependency between $I_{A,B_L}(\lambda, x)$ and $I_{A,B_R}(\lambda, x)$ is much stronger for the EPSON printer than for the EIZO CRT monitor. For example, Figure 6.1 shows the reflected PDSs when the inputs to the EPSON printer are $(0, 0.3, 0)$, $(0, 0.6, 0)$, and $(0, 1, 0)$. We can see that those PDSs are expanded in both the band $B_L$ of the red filter and the band $B_R$ of the cyan filter. If the green component in the input increases then both $I_{A,B_L}(\lambda, x)$ and $I_{A,B_R}(\lambda, x)$ also increase. Therefore, it is impossible for the EPSON printer to produce the green-like color on the right eye and dark color on the left eye.

This problem can be illustrated in Figure D.1 which is the EPSON printed version of the REDCAR anaglyph image rendered by the LP-Preprocessing-LRM-1 method for the EIZO CRT monitor and the red-cyan filters. In this figure, the interesting region REDCAR3 shows a stronger ghosting effect than that of the EIZO CRT monitor displayed image. In general, we have observed that a ghosting effect will be stronger in the printed versions. Therefore, anaglyph images to be best displayed on paper cannot be rendered directly from anaglyph algorithms specified for CRT displays.
6.2 Test for compatibility between colored-filter glasses and color output devices

It would be useful if we were able to capture the dependency between $I_{A,B_L}(\lambda, x)$ and $I_{A,B_R}(\lambda, x)$. Here, we suggest a simple test to check this. A typical challenge in an anaglyph algorithm would be to find an anaglyph input such that the perceived color in one eye with the filter is bright and the perceived color in the other eye with the filter is dark. Often as we increase the luminance of one perceived color then the luminance of the other perceived color is also increased as well due to the dependency. Therefore, at a point $x$ for instance, if we want to have a desired luminance in the left perceived color then the luminance of right perceived color cannot be lower than a certain minimum luminance. If the desired luminance of the right perceived color is less than that of the minimum luminance then we simply cannot find an anaglyph input to satisfy this requirement and hence the ghosting effect will appear at that point.

To test the effect of $I_{A,B_R}(\lambda, x)$ on $I_{A,B_L}(\lambda, x)$, we want to find a digital input such that it gives minimum luminance of the left eye perceived color while keeping the luminance of the right eye perceived color to be greater than a fixed given luminance. We repeat that step for several different fixed given luminances. For example, we can pick these fixed luminances to be 50%, 60%, 70%, 80%, 85%, 90%, and 94% of the maximum luminance that the right eye can perceive through the cyan filter. Finally, we convert those minimum luminances into the percentage ratios with respect to the maximum luminance that the left eye can perceive. The higher the percentage, the larger is the effect of $I_{A,B_R}(\lambda, x)$ on $I_{A,B_L}(\lambda, x)$. Similar steps can be performed to see the effect of $I_{A,B_L}(\lambda, x)$ on $I_{A,B_R}(\lambda, x)$.

Table 6.1 shows the minimum resulting percentages for the red-cyan filters on the EIZO CRT monitor and the EPSON printer. The first column is the fixed desired percentage luminances with respect to the maximum luminance. The second column contains minimum luminance percentages with respect to the maximum luminance that the left eye can perceive while the luminance perceived by the right eye is kept fixed (testing the effect of $I_{A,B_R}(\lambda, x)$ on $I_{A,B_L}(\lambda, x)$) for the EIZO CRT monitor. One example is that in the third row, to have the luminance perceived by the right eye greater than 90% of the maximum luminance, then the luminance perceived by the left eye cannot be less than 18.64% of the maximum luminance. The third column contains minimum luminance percentages with respect to the maximum luminance that the right eye can perceive while the luminance perceived by the left eye is kept fixed (testing the effect of $I_{A,B_L}(\lambda, x)$ on $I_{A,B_R}(\lambda, x)$) for the EIZO CRT monitor. The meaning of the fourth and fifth columns are similar to those of the second and third
Table 6.1 The minimum percentage luminances with respect to the maximum luminance.

<table>
<thead>
<tr>
<th>Fixed Luminance percentage</th>
<th>EIZO Monitor</th>
<th>EPSON Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left Eye (Red Filter)</td>
<td>Right Eye (Cyan Filter)</td>
</tr>
<tr>
<td>94%</td>
<td>19.48%</td>
<td>71.03%</td>
</tr>
<tr>
<td>90%</td>
<td>18.64%</td>
<td>51.67%</td>
</tr>
<tr>
<td>85%</td>
<td>17.60%</td>
<td>27.53%</td>
</tr>
<tr>
<td>80%</td>
<td>16.56%</td>
<td>5.24%</td>
</tr>
<tr>
<td>70%</td>
<td>14.48%</td>
<td>4.60%</td>
</tr>
<tr>
<td>60%</td>
<td>12.42%</td>
<td>3.94%</td>
</tr>
<tr>
<td>50%</td>
<td>10.35%</td>
<td>3.28%</td>
</tr>
</tbody>
</table>

columns, respectively, for the EPSON printer. As we can see with the red filter, the effect of $I_{A,B_R}(\lambda, x)$ on $I_{A,B_L}(\lambda, x)$ is much stronger for the EPSON printer than that of the EIZO CRT monitor. This explains why we experience a stronger ghosting on the left eye with the EPSON printer than the EIZO CRT monitor. With the cyan filter, both the EPSON printer and the EIZO CRT monitor give approximately the same effect of $I_{A,B_L}(\lambda, x)$ on $I_{A,B_R}(\lambda, x)$. There is a big drop on the minimum percentage when the fixed desired luminance is dropped from 85% to 80% (from 27.53% down to 5.24% for the EIZO CRT monitor and from 22.54% down to 8.34% for the EPSON printer). Through this test, we can predict that the anaglyph stereoscopic system consisting of the red-cyan filters and the EIZO CRT monitor will perhaps give better 3D perception than that of the system consisting of the red-cyan filters and the EPSON printer. And in fact in practice, this is correct.

6.3 Evaluation of MATLAB nonlinear optimization routines

In the previous and current chapter, there are situations where we want to find digital inputs to the EIZO CRT monitor or the EPSON printer such that the left eye through the left filter sees a desired color and the right eye through the right filter sees another desired color. This problem can be solved using optimization techniques. With the EIZO CRT monitor, linear optimizations such as the projection theorem can be used if the color distances are evaluated in the CIE XYZ color space. However, if the device is the EPSON printer, where the whole SFCF is a nonlinear function, then a nonlinear optimization must be involved.

As the work in this study was implemented in MATLAB, we concentrated on the nonlinear
optimization routines that are available in the “Optimization Toolbox”. These routines are
\texttt{fminsearch} (which finds a minimum of a multivariables unconstrained scalar function using
the Nelder-Mead simplex method starting at an initial estimate), \texttt{fminunc} (which finds a
minimum of a multivariables unconstrained scalar function starting at an initial estimate),
\texttt{fmincon} (which finds a minimum of a multivariables constrained scalar function starting at
an initial estimate), \texttt{lsqnonlin} (which finds a minimum of a nonlinear least-squares problem
starting at an initial estimate. The optimal results might be subject to constraints), and
\texttt{fminimax} (which finds a minimum of the worst-case value of a set of multivariable func-
tions, starting at an initial estimate. The optimal results might be subject to constraints)\(^1\).
However, since the inputs to the devices must be limited to the range \([0, 1]\), thus only the
routines \texttt{fmincon}, \texttt{lsqnonlin}, and \texttt{fminimax} will be examined as \texttt{fminsearch} and \texttt{fminunc} are
unconstrained routines.

To test these three routines, we set a test as follows: from the REDCAR stereo image pair
we follow Equations 5.14 and 5.15 for the LP method to create the left and right intended
images. We randomly pick 100 points on these images. At each of these points we want to
find an input to the EPSON printer so as to minimize the sum of two CIE XYZ Euclidean
distances between the left and right intended colors and the left and right perceived colors.
We use each of these three optimization functions to find the optimal results. These three
functions can only find local optimal results, thus they depend on the starting point to give
the correct optimal results. In this test, we use the values of the REDCAR anaglyph image
rendered by the LP method at those random points as the starting points. The number
of times that each routine gives the smallest objective value will be used to decide which
routine is better. Furthermore, to increase the confidence on the test, we also used a heuristic
\textit{Adaptive Simulated and Annealing} (ASA) routine [29] to find the optimal result, as it is likely
that ASA will give the best global optimal solution.

In all 100 cases, the \texttt{lsqnonlin} routine didn’t yield any minimum objective value. The \texttt{fmincon}
routine yielded 95 out 100 times while the \texttt{fminimax} routine had 97 times that it gave the
minimum objective values. As expected, the ASA routine gave the minimum objective
values at all 100 points. However, we won’t use the ASA routine in the study, because it is
extremely slow. During the test, \texttt{fmincon} called the objective function a total of 6394 times,
while \texttt{fminimax} involved 9373 times. Thus \texttt{fmincon} is about 32\% faster than \texttt{fminimax}.
Through this test we decided to use \texttt{fminimax} as the nonlinear optimization. Figure 6.2
shows the graph of the objective function when the CIE XYZ tristimulus values of the left

\(^1\)The information was taken from the MATLAB’s help. For more details on the usages of these routines
please refer to again the MATLAB’s help.
and right desired colors are (0.0220, 0.0095, 0.0001) and (0.0064, 0.0188, 0.0186) and the coefficient $B$ in the input to the EPSON printer is set to 0.2451. The optimal input is (0.2633, 0.2910, 0.2451).

6.4 Search for a better anaglyph algorithm

As the LP method gives very good color stability and color fidelity for CRT displays, it is natural to think of adapting it to printer media. The LP method tries to match the left and right anaglyph perceived colors $[I_{AL}(\lambda, \mathbf{x})]$ and $[I_{AR}(\lambda, \mathbf{x})]$ with the original left and right colors $I_{L,XYZ}(\mathbf{x})$ and $I_{R,XYZ}(\mathbf{x})$, respectively. The values of the rendered anaglyph input $I_{A,RGB}(\mathbf{x})$ are often bigger than 1 because of the attenuation caused by colored-filter glasses. By applying white-point normalization we can bring those values back in the range [0, 1]. For a printer, the nonlinear optimization method must replace the linear projection method used in the LP method for a CRT display. As the printer’s SFDCF is a nonlinear function based on the interpolation technique, it can only return a valid estimated spectrum when the inputs are in the appropriate range of [0, 1]. Therefore, if the nonlinear optimization does not constrain the optimal results to the range [0, 1] then these optimal results will be completely wrong and of course cannot be scaled down by the white-point normalization as in the case of the CRT. However, if that constraint is included, then many optimal results will often be at the boundary which is 1. As a result, the rendered anaglyph will have a lot of white area. Therefore, the LP method cannot be applied directly for a printer.

The anaglyph images rendered for a CRT display have a pleasant appearance. Therefore,
instead of trying to find a new algorithm for a printer that works from the pair of two original stereo images, we can reuse the result from the anaglyph algorithm specified for the CRT. In other words, we want to render a printed anaglyph image such that it looks as close as possible to the anaglyph image that is optimized for the CRT through the colored-filter glass pair with minimum ghosting effect. This idea is like the idea of the gamut mapping between the CRT and printer where the dichoptic color mixtures are the colors to be matched. The advantage of this approach is that if the CRT display anaglyph algorithm is improved then the anaglyph images rendered for printer are also improved.

6.5 A new anaglyph method for printer media

In this section we propose a novel method based on the idea presented above. Figure 6.3 shows a block diagram of the new method. It includes four modules: CRT anaglyph algorithm module, Gamut Mapping (GM) module, Preprocessing module, and LRM module. The first module, an anaglyph algorithm specified for CRTs, can be the LP method or the method proposed in previous chapter. The purpose of this module is to create the left and right CRT anaglyph intended images \( \hat{I}_{LA,RGB} \) and \( \hat{I}_{RA,RGB} \) from the original left and right-perspective images \( I_{L,RGB} \) and \( I_{R,RGB} \) by using Equations 5.14 and 5.15 for a given CRT device. The next three modules are presented in following subsections.

6.5.1 Gamut Mapping module

The purpose of the GM module is to find the left printer anaglyph intended input \( \hat{I}_{LA,RGB}(x) \) such that if it is printed onto a paper, then the left and right eyes will perceive colors \( [\hat{I}_{LAL}(\lambda, x)] \) and black respectively. We want to have \( [\hat{I}_{LAL}(\lambda, x)] \) close to \( I_{LAL,XYZ}(x) \), which is the color that the left eye perceives when viewing the left CRT intended input \( I_{LA,RGB}(x) \). Similarly, we seek the right printer anaglyph intended input \( \hat{I}_{RA,RGB}(x) \) such that if it is printed onto a paper, then the left and right eyes will perceive black and color \( [\hat{I}_{RAR}(\lambda, x)] \) respectively. Again, we want to have \( [\hat{I}_{RAR}(\lambda, x)] \) close to \( I_{RAR,XYZ}(x) \), which is the color that the right eye perceives when viewing the right CRT intended input \( I_{RA,RGB}(x) \).
Let \( \hat{I}_{LAL,XYZ}(x) \), \( \hat{I}_{LAR,XYZ}(x) \), \( \hat{I}_{RAL,XYZ}(x) \), and \( \hat{I}_{RAR,XYZ}(x) \) be the CIE XYZ tristimulus values of the following four colors respectively

\[
\begin{align*}
[\hat{I}_{LAL}(\lambda, x)] &= \left[ \gamma_{SFCP_{\text{Printer}}} \left( \hat{I}_{LA,RGB}(x) \right) \cdot f_L(\lambda) \right], \\
[\hat{I}_{LAR}(\lambda, x)] &= \left[ \gamma_{SFCP_{\text{Printer}}} \left( \hat{I}_{LA,RGB}(x) \right) \cdot f_R(\lambda) \right], \\
[\hat{I}_{RAL}(\lambda, x)] &= \left[ \gamma_{SFCP_{\text{Printer}}} \left( \hat{I}_{RA,RGB}(x) \right) \cdot f_L(\lambda) \right], \\
[\hat{I}_{RAR}(\lambda, x)] &= \left[ \gamma_{SFCP_{\text{Printer}}} \left( \hat{I}_{RA,RGB}(x) \right) \cdot f_R(\lambda) \right],
\end{align*}
\]  

(6.1)

where \( \gamma_{SFCP_{\text{Printer}}} \) is the printer’s SFCF\(^2\).

Obviously, the color error metric for measuring the above closeness cannot be color distance between \( I_{LAL,XYZ}(x) \) and \( \hat{I}_{LAL,XYZ}(x) \) or between \( I_{RAR,XYZ}(x) \) and \( \hat{I}_{RAR,XYZ}(x) \) as those colors have different viewing conditions. Therefore, first we must convert those colors to the same viewing condition by using either the chromatic adaptation model or the color appearance model. We use the simplified Bradford model as the chromatic adaptation model (Section 2.1.4.1) to find the CIE XYZ tristimulus values \( I_{LAL,XYZ,Adapted}(x) \), as the chromatic adaptation version of \( I_{LAL,XYZ}(x) \), where the white point of the original viewing conditions is the white point of the CRT monitor seen through the left colored-filter glass \( \left( [\gamma_{SFCF,CRT}(l_1, l_2, l_3)] \cdot f_L(\lambda) \right) \) and the white point of the adapting viewing conditions is the white point of the paper seen through the left colored-filter glass \( \left( [\gamma_{SFCF,Printer}(l_1, l_2, l_3)] \cdot f_L(\lambda) \right) \). Here, \( [l_1, l_2, l_3] \) is the result of Equation 5.18 with \( I_{L,RGB}(x) = [1, 1, 1] \).

Similarly, we want to find the CIE XYZ tristimulus values \( I_{RAR,XYZ,Adapted}(x) \), as the chromatic adaptation version of \( I_{RAR,XYZ}(x) \) where the white point of the original viewing conditions is the white point of the CRT monitor seen through the right colored-filter glass \( \left( [\gamma_{SFCF,CRT}(r_1, r_2, r_3)] \cdot f_R(\lambda) \right) \) and the white point of the adapted viewing conditions is the white point of the paper seen through the right colored-filter glass \( \left( [\gamma_{SFCF,Printer}(r_1, r_2, r_3)] \cdot f_R(\lambda) \right) \), and where \( [r_1, r_2, r_3] \) is the result of Equation 5.19 with \( I_{R,RGB}(x) = [1, 1, 1] \).

We would like to find the optimal solution \( \hat{I}_{LA,RGB}(x) \) to minimize the following objective function

\[
\hat{I}_{LA,RGB,Opt}(x) = \arg \min_{\hat{I}_{LA,RGB}(x)} \left\{ \Delta E_{XYZ}(\hat{I}_{LAL,XYZ}(x), I_{LAL,XYZ,Adapted}(x)) + \Delta E_{XYZ}(\hat{I}_{LAR,XYZ}(x), 0) \right\}. \tag{6.2}
\]

Similarly, we want to find the optimal solution \( \hat{I}_{RA,RGB}(x) \) to minimize the following objective

\(^2\)The EPSON printer’s SFCF was used in the study.
function

\[
\hat{I}_{RA,RGB,\text{Opt}}(x) = \arg \min_{I_{RA,RGB}(x)} \left\{ \Delta E_{XYZ}(\hat{I}_{RAR,XYZ}(x), I_{RAR,XYZ,\text{adapted}}(x)) + \Delta E_{XYZ}(\hat{I}_{RAL,XYZ}(x), 0) \right\}.
\] (6.3)

The \textit{fminimax} routine is used here with the starting points being \(I_{LA,RGB}(x)\) and \(I_{RA,RGB}(x)\), respectively.

### 6.5.2 Preprocessing module

The purpose and the steps in this module are exactly the same as the Preprocessing module described for the CRT monitor in Section 5.5.1. The differences are that we replace the CRT’s SFCF \(\Upsilon_{\text{SFCF,CRT}}\) by the printer’s SFCF \(\Upsilon_{\text{SFCF,Printer}}\) and replace the monitor’s white point by the printer’s white point\(^3\), when converting the CIE XYZ tristimulus values into the CIELAB coordinates. Let \(\hat{I}_{LAL,XYZ}(x)\) and \(\hat{I}_{RAR,XYZ}(x)\) be the CIE XYZ tristimulus values of the luminance adjusted colors \(I_{LAL,XYZ}(x)\) and \(I_{RAR,XYZ}(x)\), respectively.

To convert \(\hat{I}_{LAL,XYZ}(x)\) to \(\hat{I}_{LA,RGB}(x)\), we use the \textit{fminimax} routine to find the optimal input \(\hat{I}_{LA,RGB}(x)\) to minimize the sum of \(\Delta E_{XYZ}\) between the color perceived by the left eye with filter and color \(\hat{I}_{LAL,XYZ}(x)\) and \(\Delta E_{XYZ}\) between the color perceived by the right eye with filter and black color. Similarly, to convert \(\hat{I}_{RAR,XYZ}(x)\) to \(\hat{I}_{RA,RGB}(x)\), we can use \textit{fminimax} routine to find the optimal input \(\hat{I}_{RA,RGB}(x)\) to minimize the sum of \(\Delta E_{XYZ}\) between the color perceived by the right eye with filter and color \(\hat{I}_{RAR,XYZ}(x)\) and \(\Delta E_{XYZ}\) between the color perceived by the left eye with filter and black color. The effect of the parameters \(g\), \(c_1\), \(c_2\), and \(c_3\) are the same as that for the proposed CRT display anaglyph algorithm.

### 6.5.3 LRM module

The LRM module here is similar to the one used in Section 5.4.1.1. Its purpose is to find the final anaglyph image \(\hat{I}_{A,RGB}(x)\) such that its left and right perceived colors \(\hat{I}_{AL,XYZ}(x)\) and \(\hat{I}_{AR,XYZ}(x)\) are close to the left and right intended colors \(\hat{I}_{LAL,XYZ}(x)\) and \(\hat{I}_{RAR,XYZ}(x)\) obtained from the previous module. We would like to find the optimal solution \(\hat{I}_{A,RGB}(x)\) to minimize the following objective function

\[
\hat{I}_{A,RGB,\text{Opt}}(x) = \arg \min_{I_{A,RGB}(x)} \left\{ \Delta E_{XYZ}(\hat{I}_{AL,XYZ}(x), \hat{I}_{LAL,XYZ}(x)) + \Delta E_{XYZ}(\hat{I}_{AR,XYZ}(x), \hat{I}_{RAR,XYZ}(x)) \right\}.
\] (6.4)

---

\(^3\)Based on the measurement
The starting point for the \textit{fniminax} routine can be set to \((\hat{I}_{LA,RGB}(x) + \hat{I}_{RA,RGB}(x))\).

6.5.4 Test results

To test the proposed algorithm, we used it to render three test stereo image pairs with the parameter values set to \(g = 1\), \(c_1 = 0.2\), \(c_2 = 1\), and \(c_3 = 0.8\) for the EPSON printer with EIZO is the CRT device. Figures D.2, D.4, and D.6 are the printed version of REDCAR, ICIP, and BEAR anaglyph images that are optimized for the EPSON printer. Figures D.1, D.3, and D.5, whose softcopies are in Appendix C.10, are the printed version of REDCAR, ICIP, and BEAR anaglyph images that are optimized for the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. At the interesting regions REDCAR1, ICIP1, and BEAR1, we can see that the ghosting effect is significantly reduced for the EPSON printed versions compared with the EIZO printed versions.

6.5.5 Observations on the effect of different illuminant lights and different photo-quality papers

The EPSON printer’s SFCF was established under illumination by incandescent light bulbs. Therefore, under different illuminants the EPSON printer’s SFCF does not estimate the output PDFs correctly. As a result, the rendered anaglyph images using this SFCF model under different illuminants may not look as good as these anaglyph images under the incandescent light bulbs. Fortunately, we verified that Figures D.2, D.4, and D.6 under the daylight and fluorescent light look as good as under incandescent light bulbs, e.g., the ghosting effect is very low, the color fidelity and stability are high. Therefore, the illuminant light does no thave strong effect on the overall 3D perception.

We also used another photo-quality paper, different than the EPSON semigloss photo paper used for modeling EPSON printer’s SFCF, to print the printer version ICIP anaglyph image. The printed ICIP image looks as good as the one printed with the EPSON semigloss photo paper. Therefore, different types of photo-quality papers may not affect too much the overall 3D perception. These results can save us from re-modeling new printers, which is a very time-consuming process, under different illuminant lights or different types of photo-quality papers.
6.6 Summary

This chapter started with the discussion of why we cannot use the anaglyph algorithm that is specified for a CRT display to render anaglyph images that would give good 3D perception when they are printed on ordinary paper. A strong ghosting effect is the primary problem. The reason for the strong ghosting in the EPSON printer is because of the strong dependency between the PDS on the band $B_L$ and the PDS on the band $B_R$. We also showed a simple test to quantify this dependency. Through the result of the test we see that the red-cyan filter pair is better for the EIZO CRT monitor than for the EPSON printer. The chapter also concluded that the MATLAB $fminimax$ optimization routine gives the best result.

Our recommendation for a method to render an anaglyph image when printed on a paper from a given stereo image pair is as follows: first use the LP method to render the left and right intended images for a given CRT display. Then convert these two images for the given printer. Apply the Preprocessing steps to modify the luminance of these two intended images. Finally use the LRM method to find the final anaglyph image.
7.1 Overview of findings

The aim of this thesis was to develop methods for rendering anaglyph images which are displayed on a CRT display or printed on paper to give best 3D perception. This was done by presenting the background (Chapter 2) on color theory and the characterization of two popular color display device types: CRT displays and printers. The color theory review included the colorimetric color space which is a three-dimensional vector space, with the CIE XYZ color space as its most popular representative, and color appearance model which is based on the color attributes (hue, brightness, lightness, colorfulness, chroma, and saturation) rather than the quantified visible light stimuli, with the CIELAB color space as its representative. The characterization process review presented a generic way of establishing SFCFs of a CRT display and a printer. SFCF is the relationship between the device digital input, which is also considered as color device-dependent representation, and the PDS of the emitting or reflecting spectrum from the characterized device.

Chapter 3 contained a literature survey on existing anaglyph algorithms. It formulated the anaglyph problem which is used as the framework for the later chapters. The condition of colored-filter glasses was also described. Through the formulation, the quality factors of an anaglyph algorithm can be classified as: color stability, which indicates stability of the overall perceived dichoptic color mixtures, color fidelity, which indicates how large the gamut of the perceived dichoptic color mixtures is, and ghosting effect, which is the leaking information of one perspective image into the other eye. There were only a few existing anaglyph algorithms and they are Photoshop, Midpoint, LP, and ColorCode methods. The Photoshop method in general gives strong color rivalry. The Midpoint method gives a poor 3D perception. The LP
method gives stable perceived colors with good color fidelity. Its rendered anaglyph images are very comfortable to view. However, one drawback of the LP method is that it gives a strong ghosting effect. The ColorCode method is primarily used for the yellow-blue filter pair. Since the yellow-blue filter pair exhibits strong imbalance of luminances between the two eyes; therefore, ColorCode method suffers from a strong luminance imbalance between left and right eyes. This limitation makes the rendered anaglyph images uncomfortable to view. The advantage of the ColorCode method lies with greater color fidelity (e.g. the red color can be perceived by the yellow-blue filters while it is very hard to see the red color through the red-cyan filters).

The SFCFs of color display devices used in this study were described on Chapter 4, specifically for the EIZO CRT monitor and the EPSON Stylus Photo 2200 printer. The EIZO's SFCF is established based on the model-based approach, whereas, the SFCF's EPSON printer is based on the empirical approach in which a satisfactory solution was found by using the order-5 polynomial regression.

The new anaglyph algorithm which is optimized for a CRT display was presented in Chapter 5. It is an enhancement of the LP method. The limitation of the LP method lies with its ghosting effect. Through a simple experiment we have been able to see that for the red-cyan filters and yellow-blue filters, the perceived dichoptic color mixtures are very close to either the monoptic colors that are perceived by the left or right eyes, and hence we cannot reproduce the original colors. The result from this experiment couples with the fact that the LP method gives very good color fidelity and color stability suggested that it is likely that we cannot improve the color stability and color fidelity. Therefore, the developed method focused on reducing the ghosting effect limitation in the LP method. In order to do this, a new ghosting definition was defined. It can be applied at a single pixel for a given algorithm. Based on this definition, a new method was derived and consisted of the following steps: first finding the left and right anaglyph intended images using the LP method, then adjusting the luminances of these left and right anaglyph intended images (Preprocessing algorithm), and finally using the linear optimization to find the anaglyph image that gives the left perceived image close to the left anaglyph intended image and the right perceived image close to the right anaglyph intended image (LRM algorithm).

The anaglyph images to be printed on a paper to give good 3D perception cannot be rendered using the algorithms that are intended for a CRT display as the ghosting effect will be magnified in the printed version. This is mostly due to the strong dependency between the reflecting PDSs from the paper perceived by the left and right eyes through filters. A simple
method has been shown to capture this dependency, and it suggested that the dependency of the EIZO CRT monitor is much lower than that of the EPSON printer. The proposed anaglyph algorithm optimized for printer was presented in Chapter 6. It consisted of the following steps: first finding the CRT left and right anaglyph intended images by using the LP method, then mapping these two images into printer’s gamut to obtain the printer left and right anaglyph intended images, next adjusting the luminance of these two images, and finally using the nonlinear optimization to find the final anaglyph image.

The test results from three stereo image pairs have shown that the novel anaglyph algorithm for a given CRT display renders anaglyph images that exhibit much lower ghosting effects than these rendered by the LP method and yet give a good color stability and color fidelity. The test results also revealed that the novel anaglyph algorithm for a given printer renders anaglyph images which when printed on ordinary paper exhibit much lower ghosting effects than the printed versions of the anaglyph images rendered for a given CRT display. Although the novel ghosting definition can be used to measure numerically the ghosting effect on each eye, however, the overall quality of an anaglyph algorithm can only be judged by a human. This means that the comparison between two algorithms must be drawn from a large number of observers and a large set of rendered anaglyph images. However, all the observations in this study were made primarily by two people, one of them the author of the thesis.

7.2 Contributions of the thesis

The novel contributions of this thesis are as follows:

1. Introduced a novel way of measuring numerically the ghosting effect. This novel method can be applied at a single pixel for a given anaglyph algorithm.

2. Developed a novel anaglyph algorithm used to render anaglyph images for a given CRT display. This novel algorithm uses the LP method to find the left and right anaglyph intended images, then adjusts the luminances of these left and right anaglyph intended images, and finally uses the linear optimization to find the anaglyph image. The test results have shown that the new rendered anaglyph images had much less the ghosting effect than those anaglyph images rendered by the LP method without sacrificing much the color stability and the color fidelity.

3. Developed a novel anaglyph algorithm used to render anaglyph images for a given printer. This novel algorithm uses the LP method to find the CRT left and right
7.3 Future work

For the future work, more sophisticated appearance color spaces such as CIECAM02 and its
h
color distance metric errors may be used to replace the CIE XYZ Colorimetric model used
in ILM-1, ILM-3, or the printer anaglyph algorithm developed in Chapter 6, or replace the
CIELAB color space used in the Preprocessing algorithm. So far, only the Preprocessing
algorithm uses global information (which is the maximum luminance difference between the
left and right anaglyph images) in the calculation while all other calculations are
carried out independently at each sample point. Therefore, in future work, we can investigate
more about the effect of the neighborhood effect on the anaglyph image for a printer's extremely
slow speed, such as converting the MATLAB code into C code or finding faster nonlinear
rendering speed, such as converting the MATLAB code into C code or finding faster nonlinear
optimization methods.

1. Measured the PDS of three primaries of the EIZO CRT monitor, and based on these
measurements, established its SFCS using the model-based approach. The parameter
values for the GOG gamma-correction model for the EIZO CRT monitor were also
calculated based on 30 measurements of the PDS of the emitting lights.

2. Measured the PDUs of the EIZO CRT monitor, and based on these measurements, established its SFCS
using the model-based approach. The parameter values for the GOG gamma-correction model for the
EIZO CRT monitor were also calculated based on 30 measurements of the PDS of the emitting lights.

3. Proposed a novel method to check the compatibility between a colored-filter glass pair
and a color output device.

4. Formulated the anaglyph problem from a mathematical point of view and established
the condition for colored-filter glasses.

Besides these main contributions, a significant amount of work has been done for measuring
the spectra and modeling the devices. Specifically:

1. The test results have shown that the anaglyph images rendered by the novel algorithm
compare with the printed versions of the anaglyph images rendered by the novel anaglyph
algorithm for a given CRT display.

2. To obtain anaglyph images, they map these two images into the printer's gamut to ob-
tain the printer's anaglyph images, next adjusts the luminance of
two images, and finally uses the nonlinear optimization algorithms to obtain the final anaglyph
image. The test results have shown that the anaglyph images were reduced significantly
by the novel algorithm compared with the printed versions of the anaglyph images rendered by the novel anaglyph
algorithm for a given CRT display.
REFERENCES


Ocean Optics USB2000

This appendix summarizes the usage of the Ocean Optics USB2000-VIS-NIR spectrometer. In this study, it is used to measure the PDS of light emitting from a CRT display, the PDS of light reflecting from a colorant mixture printed by a printer, and the spectral absorption curve of a colored-filter glass. All the information in this appendix is taken from references [30, 31].

A.1 Introduction

In general, a spectrometer is an instrument that measures the intensity of radiation as a function of wavelength and can be used to measure both emissive and reflective light, whereas the spectrophotometer can only measure the reflective light. USB2000-VIS-NIR is a small size spectrometer (89 mm x 64 mm x 34 mm LWH) with two connections: the USB port used communicate with a PC (also used as power source) and the SMA fiber optic connector as entrance aperture used to connect sampling accessories that filter light into the USB2000. In this research, the USB2000 is preconfigured by the manufacturer to have grating #3, OFLV-350-850 order sorting filter, 23 micron slit entrance aperture, and optical resolution 1.5 micron. It is capable of measuring light with wavelength in the range of 200nm-1100nm and its resolution is ~0.3 - 10.0 nm. For its other features please refer to its instruction manual [30].

The Ocean Optics OOIBase32 is a program used to communicate with the USB2000. It receives the measured spectral data from the USB2000 and plots it onto the monitor screen in real time. For installation steps and the configurations to work with the USB2000 please refer to Section 2 in its instruction manual [31]. Depending on the type of measuring (emittance,
reflectance, or absorbent), the USB2000 needs different type of sampling accessories. Each sampling accessory gathers and transmit a certain amount of light into the USB2000. Besides that, we need a light source to act as a black body with a known temperature. The reason for this is that USB2000 itself is a light photon to voltage converter. The signal generated from the USB2000 due to stimuli is just the raw voltage values at different wavelength but not the real spectrum of the measuring light. In order to convert the raw voltage data into the meaningful light PDS, the OOIBase32 compares the measured raw voltage data with the raw voltage data caused by a blackbody light source. The PDS of a black body can be generated from its body’s temperature. Here, we use the Ocean Optic LS-1 Tungsten Halogen light source with it’s body temperature of 3100 K and its spectral range of 360 nm - 2500 nm.

A.2 Settings

There are a few important settings in OOIBase32 needed to be set before conducting any experiment. The value in the “Integ. Time” box indicates the amount of time (in ms) which the USB2000 lets the light’s photons to come inside the box. Always try to adjust the integration time to have the raw voltage signal at its peak of about 3500 counts. The value of the “Average” box indicates the number of measurements of the raw voltage data of the same stimuli light. The average of these measurements is the final raw data. The value in “Boxcar” box, for instance 5, indicates a raw voltage at a specific wavelength is the average of 5 adjacent points to its left and 5 adjacent points to its right.

A.3 Steps for measuring colored-filter glass’s absorption curve

Apparatus used to measure the colored-filter glass’s absorption curve consists of: spectrometer USB2000, configured OOIBase32 software, LS-1 light source, and Ocean Optics CC-3-DA Direct-attach Cosine Corrector light sampling accessory. Figure A.1 illustrates the set up. Before starting the measuring process, OOIBase32 is needed to be configured as follows: set the value in the “Integ. Time” box to 1000, the value in the “Average” box to 3, and the value in the “Boxcar” box to 5. The following are the steps for measuring an absorption curve:

1. Attach the CC-3-DA Direct-attach Cosine Corrector to the USB2000.
2. Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar, or by selecting “Spectrum > Scope” mode from the menu bar.

3. Turn on the LS-1 light source and let it warm up for about 10 minutes. Now place the CC-3-DA in front of the LS-1 to measure the light source PDS. Adjust the distance between the USB2000 and the light source to have the intensity signal of light source about 3500 counts. Click the "Store Reference" spectrum icon on the toolbar or select “Spectrum > Store Reference” from the menu bar to store the reference. (Note we can save this reference spectrum for future use by select “File > Save > Reference” from the menu bar to permanently save this spectrum to hard disk for later reuse).

4. Block any light coming to the USB2000, but be careful not to move the USB2000. Then, take a dark spectrum by clicking the "Store Dark Spectrum" icon on the toolbar or by selecting “Spectrum > Store Dark” from the menu bar. (Note we can save this dark spectrum for future use by select “File > Save > Dark” from the menu bar to permanently save this spectrum to hard disk for later reuse).

5. Click on "Spectrum > Reference Color Temperature" and enter 3100 into the box (note 3100 is the temperature of the black body light source LS-1).
Figure A.2 The set up for measuring emitting light PDS from a monitor.

6. Click on the "Transmission" mode icon on the toolbar or select "Spectrum > Transmission Mode" from the menu bar.

7. Place the colored-filter glass in front of the CC-3-DA and wait for about 6 seconds to let the signal stabilize.

8. Save the transmission curve to the hard disk by clicking the “save” icon on the toolbar or select "File > Save > Processed" from the menu bar (please refer to Appendix C in the reference [31, pg.69] for an example of the saved file format).

9. Finally, interpolate the saved data into the designed wavelength range (e.g. in the range of 400 nm - 700 nm with the interval of 2nm for this research) (in MATLAB, the function `interp1` can be used).

A.4 Steps for measuring emitting light PDS from a monitor

Apparatuses used to measure the emitting light from a monitor consists of: spectrometer USB2000, configured OOIBase32 software, LS-1 light source, and Ocean Optics CC-3-DA Direct-attach Cosine Corrector light sampling accessory. Figure A.2 illustrates the set up. Before starting the measuring process, OOIBase32 is needed to be configured as follows:
set the value in the “Integ. Time” box to 2000, the value in the “Average” box to 3, and the value in the “Boxcar” box to 5. The following are the steps for measuring emitting light PDS:

1. Attach the CC-3-DA Direct-attach Cosine Corrector to the USB2000.

2. Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar, or by selecting “Spectrum > Scope” Mode from the menu bar.

3. Turn on the LS-1 light source and let it warm up for about 10 minutes. Now place the CC-3-DA in front of the LS-1 to measure the light source. Adjust the distance between the USB2000 and the light source to have the intensity signal of light source about 2000 counts. Click the "Store Reference" spectrum icon on the toolbar or select “Spectrum > Store Reference” from the menu bar to store the reference. (Note we can save this reference spectrum for future use by select “File > Save > Reference” from the menu bar to permanently save the spectrum to disk for later reuse).

4. Block any light coming to the USB2000. Then, take a dark spectrum by clicking the "Store Dark Spectrum" icon on the toolbar or by selecting “Spectrum > Store Dark” from the menu bar.

5. Click on "Spectrum > Reference Color Temperature" and enter 3100 into the box (note 3100 is the temperature of the black body light source LS-1).

6. Click on the "Irradiance" mode icon on the toolbar or select "Spectrum > Relative Irradiance Mode" from the menu bar.

7. Make the monitor to display a desired color in large enough area. Then, place the CC-3-DA in front of this color (let the CC3 touch the monitor screen gently to reduce the flare effect) and wait for about 12 seconds to let the signal stabilize.

8. Save the spectrum to hard disk by clicking the "save" icon on the toolbar or select "File > Save > Processed" from the menu bar (please refer to Appendix C in the reference [31, pg.69] for an example of the saved file format).

9. Interpolate the saved data into the designed wavelength range (e.g. in the range of 400 nm - 700 nm with the interval of 2nm for this research) (in MATLAB, the function interp1 can be used).

10. Finally, normalize the interpolated spectrum by scaling down the whole spectrum by the value of the luminance of the brightest point generate by the monitor (Section 2.2.3). This brightest point is the monitor white.
A.5  Step for measuring reflecting light PDS from a paper

Apparatuses used to measure the reflecting light from a paper consists of: spectrometer USB2000, configured OOIBase32 software, LS-1 light source, Ocean Optics R200-7-VIS-NIR reflection probe 200 micron light sampling accessory, RPH-1 probe holder, and illuminant light source (in this study we used the commercial 60W incandescent light bulb). Figure A.3 illustrates the set up. The R200-7-VIS-NIR has three legs. The illumination leg, which has the SMA 905 connector and big fiber diameter, is used to connect to the light source such as LS-1. The read leg, which has the SMA 905 connector and small fiber diameter if compared with the illumination leg, is used to connect to the USB2000. And the probe leg, that has no connector, is used to collect the reflecting light. Basically, the illumination leg will transmit the light from the light source to the probe to illuminate the object through the illumination fiber. The reflecting light is then collected by the probe and is transmitted to the read leg through the read fiber and then to the USB2000.

Let $I_{\text{Measured}}(\lambda)$ and $S_{\text{Measured}}(\lambda)$ be the measured raw voltage signal of the illuminant light and the reflecting light, respectively. Let $\gamma_{\text{ReadFiber}}(\lambda)$ and $\gamma_{\text{IlluminationFiber}}(\lambda)$ be the atten-
uation functions of the read and illumination fibers, respectively. We have

\[ I_{\text{Measured}}(\lambda) = I(\lambda) \cdot \Upsilon_{\text{ReadFiber}}(\lambda), \]  
(A.1)

\[ S_{\text{Measured}}(\lambda) = I(\lambda) \cdot \Upsilon_{\text{IlluminationFiber}}(\lambda) \cdot \text{Ref}(\lambda) \cdot \Upsilon_{\text{ReadFiber}}(\lambda). \]  
(A.2)

where \( I(\lambda) \) is the PDS of the illuminant light and \( \text{Ref}(\lambda) \) is the spectral reflectance of a colorant mixture. From Equations A.1 and A.2, we can find \( \text{Ref}(\lambda) \) as

\[ \text{Ref}(\lambda) = \frac{S_{\text{Measured}}(\lambda)}{I_{\text{Measured}}(\lambda) \cdot \Upsilon_{\text{IlluminationFiber}}(\lambda)}. \]  
(A.3)

Therefore, we need to obtain the function \( \Upsilon_{\text{IlluminationFiber}}(\lambda) \). This function was extracted from the R200-7-VIS-NIR’s specifications. Once \( \text{Ref}(\lambda) \) is obtained, a reflecting light PDS \( S(\lambda) \) can be calculated as

\[ S(\lambda) = \frac{I'(\lambda) \cdot \text{Ref}(\lambda)}{k}, \]  
(A.4)

where \( I'(\lambda) \) is the PDS of an arbitrary illuminant light and \( k \) is the luminance value of the color \( S_{\text{White}}(\lambda) = I'(\lambda) \cdot \text{Ref}_{\text{White}}(\lambda) \), with \( \text{Ref}_{\text{White}}(\lambda) \) is the spectral reflectance of the plain paper. The PDS \( I'(\lambda) \) can be measured by following the steps in Section A.4 except that, we place the CC-3-DA in front of the light source in the step #5 and skip the step #10.

Before starting to measure \( S_{\text{Measured}}(\lambda) \), the OOBases32 is need to be configured as follows: set the value in the “Integ. Time” box to 200, the value in the “Average” box to 3, and the value in the “Boxcar” box to 5. The following are the steps for measuring \( S_{\text{Measured}}(\lambda) \):

1. Attach the read leg of the R200-7-VIS-NIR to the USB2000 and the illumination leg of R200-7-VIS-NIR to the LS-1.

2. Set OOBase32 in scope mode by clicking the "Scope Mode" button on the tool bar, or by selecting “Spectrum > Scope” Mode from the menu bar.

3. Block any light coming into the illumination and read legs. Then, take a dark spectrum by clicking the "Store Dark Spectrum" icon on the toolbar or by selecting “Spectrum > Store Dark” from the menu bar.

4. Place the read leg 45 degree with the printed colorant mixture and about to touch the paper using the RPH-1 probe holder. Wait for about 5 seconds to let the signal stabilize.

5. Save the spectrum to hard disk by clicking the "save" icon on the toolbar or select
"File > Save > Processed" from the menu bar (please refer to Appendix C in the reference [31, pg.69] for an example of the saved file format).

6. Interpolate the saved data into the designed wavelength range (e.g. in the range of 400 nm - 700 nm with the interval of 2nm for this research) (in MATLAB, the function “interp1” can be used).

The following are the steps for measuring $I_{\text{Measured}}(\lambda)$:

1. Attach the read leg of the R200-7-VIS-NIR to the USB2000. Cover the illumination leg of the R200-7-VIS-NIR so that there is no light to get into it.

2. Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar, or by selecting “Spectrum > Scope” Mode from the menu bar.

3. Block any light coming into the read leg. Then, take a dark spectrum by clicking the "Store Dark Spectrum" icon on the toolbar or by selecting “Spectrum > Store Dark” from the menu bar.

4. Turn on the LS-1 Light source and let it warms up for about 10 minutes. Now place the read leg in front of the LS-1 to measure the spectrum of light source. Adjust the distance between the read leg and the light source to have the intensity signal of light source about 3000 counts. Click the "Store Reference" spectrum icon on the toolbar or select “Spectrum > Store Reference” from the menu bar to store the reference. (Note we can save this reference spectrum for future use by select “File > Save > Reference” from the menu bar to permanently save the spectrum to disk for later reuse).

5. Interpolate the saved data into the designed wavelength range (e.g. in the range of 400 nm-700 nm with the interval of 2nm for this research) (in MATLAB, the function “interp1” can be used).
B.1 Test stereo image pairs

Three stereo image pairs (REDCAR, ICIP, and BEAR) have been used to test to the quality of an anaglyph algorithm. REDCAR (Figure B.1) was acquired by an IMAX stereoscopic film camera and the output was scanned at high-resolution and downsampled to size $720 \times 576$. ICIP (Figure B.2) represents the logo of the International Conference on Image Processing. It has the size of $1024 \times 1024$. The stereo image pair was generated from a 3D model created with Maya by Eric Wellman. BEAR (Figure B.3) is cropped from one stereo frame of the 2002 3D computer graphics movie SOS Planet produced by NWave picture. It has the size of $401 \times 401$. The electronic versions of these images are in Appendix C.1.
Figure B.1 REDCAR stereo image pair (electronic versions in Appendix C.1).

Figure B.2 ICIP stereo image pair (electronic versions in Appendix C.1).
B.2 Interesting regions

From Section 3.2.1.3, an anaglyph algorithm can be judged through three quality factors: ghosting effect, color stability, and color fidelity. Each of those three stereo images pairs has some interesting regions which we would like to pay particular attention to. These interesting regions exhibit the color stability and ghosting effect quality factors of an anaglyph algorithm. The interesting regions REDCAR3 and ICIP1 allow us to examine the ghosting effect of an anaglyph algorithm. The interesting regions REDCAR1 and REDCAR2 give us the judgment about the color stability. However, the overall quality of the rendered anaglyph images allows us to judge the color fidelity as well as the color stability of an anaglyph algorithm.
Figure B.4 REDCAR interesting regions.

Figure B.5 (a) The ICIP1 interesting region and (b) the BEAR1 interesting region.
APPENDIX

C

Electronic Appendix

A CD is included with the thesis. This CD is used to store the anaglyph images that are rendered by different anaglyph methods, the transmission absorption curves of some selected colored-filter glasses, the white point normalized PDS of the EIZO CRT monitor’s primaries, and the reflectance curves of colorant mixtures printed by the EPSON printer. This appendix explains the structure of the CD. Each file in the CD has a companion text file that explains its intention.

C.1 “Test stereo image pairs” folder

This folder contains the ICIP, BEAR, and REDCAR stereo image pairs.

C.2 “EIZO CRT Spectra” folder

This folder contains the spectra of the primaries emitted from the EIZO CRT monitor.

C.3 “EPSON Printer Spectra” folder

This folder contains the reflectance curves of colorant mixtures printed by the EPSON printer.

C.4 “Glass Transmission Absorption Curves” folder

This folder contains the transmission absorption curves of different colored-filter glasses.
C.5 “Photoshop Anaglyph Images” folder

This folder contains the anaglyph images rendered by the Photoshop method for the EIZO CRT monitor.

C.6 “Midpoint Anaglyph Images” folder

This folder contains the anaglyph images rendered by the Midpoint method for the EIZO CRT monitor.

C.7 “LP Anaglyph Images” folder

This folder contains the anaglyph images rendered by the LP method for the EIZO CRT monitor.

C.8 “LRM-1 Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-1 based on the LP method for the EIZO CRT monitor.

C.9 “LRM-2 Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-2 based on the LP method for the EIZO CRT monitor.

C.10 “Preprocessing Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-1 based on the LP method with the Preprocessing process for the EIZO CRT monitor.
Anaglyph images rendered on the EPSON printer

This appendix contains three anaglyph images that are rendered from three test stereo image pairs by using the novel algorithm proposed in Chapter 6 for the EPSON printer whose $\gamma_{SFCF,Printer}(\cdot)$ has been established in Chapter 4. Figure D.1 (whose softcopy is in Appendix C.10) is the printed version of the REDCAR anaglyph image that is optimized for the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. Figure D.2 is the printed version of the REDCAR anaglyph image that is optimized for the EPSON printer. Figure D.3 (whose softcopy is in Appendix C.10) is the printed version of the ICIP anaglyph image that is optimized for the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. Figure D.4 is the printed version of the ICIP anaglyph image that is optimized for the EPSON printer. Figure D.5 (whose softcopy is in Appendix C.10) is the printed version of the BEAR anaglyph image that is optimized for the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. Figure D.6 is the printed version of the BEAR anaglyph image that is optimized for the EPSON printer. We can see that the ghosting effect is significantly reduced in all these images with the algorithm optimized for the printer.